AUTOCAD® 2014 AND
AUTOCAD LT® 2014

ESSENTIALS
Dear Reader,

Thank you for choosing *AutoCAD 2014 and AutoCAD LT 2014 Essentials*. This book is part of a family of premium-quality Sybex books, all of which are written by outstanding authors who combine practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to producing consistently exceptional books. With each of our titles, we’re working hard to set a new standard for the industry. From the paper we print on, to the authors we work with, our goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments and get your feedback on how we’re doing. Feel free to let me know what you think about this or any other Sybex book by sending me an email at nedde@wiley.com. If you think you’ve found a technical error in this book, please visit http://sybex.custhelp.com. Customer feedback is critical to our efforts at Sybex.

Best regards,

Neil Edde
Vice President and Publisher
Sybex, an Imprint of Wiley
to Jenn and Merlin
ACKNOWLEDGMENTS

A team of people has been instrumental in making this book you are holding in your hands or reading onscreen a reality. I would like to express my sincere gratitude to the professional team at Sybex (an imprint of Wiley) for all their hard work.

It has been a pleasure working with my acquisitions editor, Willem Knibbe; developmental editor, Kathryn Duggan; technical editor, Ian le Cemiant; and members of the editorial staff, including Pete Gaughan, Connor O’Brien, and Jenni Housh.
**About the Author**

*Scott Onstott has published* nine books with Sybex prior to the present title: AutoCAD® 2013 and AutoCAD LT® 2013 Essentials, AutoCAD® 2012 and AutoCAD LT® 2012 Essentials, Adobe® Photoshop® CS6 Essentials, Enhancing Architectural Drawings and Models with Photoshop, AutoCAD®: Professional Tips and Techniques (with Lynn Allen), Enhancing CAD Drawings with Photoshop, Mastering Autodesk® VIZ 2007 (with George Omura and Jon McFarland), Mastering Autodesk® Architectural Desktop 2006, and Autodesk® VIZ 2005 (with George Omura). Scott has worked on some 20 other technical books as contributing author, reviser, compilation editor, and/or technical editor.

Scott has also written, narrated, and produced the *Secrets In Plain Sight* film series (Volumes 1 and 2); written *Taking Measure: Explorations in Number, Architecture, and Consciousness*; and contributed a chapter to *The Sync Book 2* (edited by Alan Abbadessa-Green).

Scott has a bachelor’s degree in architecture from University of California, Berkeley, and is a former university instructor who now serves as a consultant and independent video producer. Scott has written a column in *Photoshop User Magazine* since 2007. You can contact the author through his website at [www.scottonstott.com](http://www.scottonstott.com).
## Contents at a Glance

*Introduction*  
xvii

**CHAPTER 1**  
Getting Started  
1

**CHAPTER 2**  
Basic Drawing Skills  
15

**CHAPTER 3**  
Using Drawing Aids  
41

**CHAPTER 4**  
Editing Entities  
57

**CHAPTER 5**  
Shaping Curves  
85

**CHAPTER 6**  
Controlling Object Visibility and Appearance  
105

**CHAPTER 7**  
Organizing Objects  
129

**CHAPTER 8**  
Hatching and Gradients  
153

**CHAPTER 9**  
Working with Blocks and Xrefs  
171

**CHAPTER 10**  
Creating and Editing Text  
193

**CHAPTER 11**  
Dimensioning  
207

**CHAPTER 12**  
Keeping In Control with Constraints  
227

**CHAPTER 13**  
Working with Layouts and Annotative Objects  
241

**CHAPTER 14**  
Printing and Plotting  
263

**CHAPTER 15**  
Working with Data  
289

**CHAPTER 16**  
Navigating 3D Models  
317

**CHAPTER 17**  
Modeling in 3D  
337

**CHAPTER 18**  
Presenting and Documenting 3D Design  
365

**APPENDIX**  
Autodesk AutoCAD 2014 Certification  
389

*Index*  
397
## Contents

*Introduction*  
xvii

### Chapter 1  
**Getting Started**  
1  
- Exploring the AutoCAD 2014 for Windows User Interface  
  1  
- Exploring the Graphical User Interface  
  1  
- Exploring Workspaces  
  6  
- The AutoCAD Ribbon  
  7  
- Setting Drawing Units  
  11

### Chapter 2  
**Basic Drawing Skills**  
15  
- Navigating 2D Drawings  
  15  
- Drawing Lines and Rectangles  
  19  
  - Drawing Lines  
    19  
  - Drawing Rectangles  
    22  
- Canceling, Erasing, and Undoing  
  23  
- Using Coordinate Systems  
  25  
  - Using Absolute Coordinates  
    25  
  - Using Relative Coordinates  
    26  
  - Using Polar Coordinates  
    27  
- Drawing Circles, Arcs, and Polygons  
  31  
  - Creating Circles  
    31  
  - Creating Arcs  
    35  
  - Drawing Polygons  
    36  
- Filleting and Chamfering Lines  
  37  
  - Joining Nonparallel Lines  
    38  
  - Joining Crossed Lines  
    39

### Chapter 3  
**Using Drawing Aids**  
41  
- Grid and Snap  
  41  
- Ortho and Polar Tracking  
  44  
- PolarSnap  
  46  
- Running Object Snaps  
  48  
- From Snap  
  51  
- Object Snap Tracking  
  52
### Chapter 4: Editing Entities

- Creating Selection Sets .................................................. 57
- Creating a Selection Set at the **Select Objects:** Prompt .................. 58
- Creating a Selection Set Before Deciding on a Command ............... 61
- Move and Copy ................................................................. 64
- Rotate and Scale .................................................................. 68
- Working with Arrays ............................................................. 72
  - Rectangular Arrays ............................................................ 72
  - Polar Arrays .................................................................... 73
- Trim and Extend ................................................................. 76
- Lengthen and Stretch .......................................................... 77
- Offset and Mirror ............................................................... 79
- Grip Editing .......................................................................... 82

### Chapter 5: Shaping Curves

- Drawing and Editing Curved Polylines .................................. 85
- Drawing Ellipses .................................................................... 91
- Drawing and Editing Splines ................................................ 94
  - Working with Control Vertices ........................................... 94
  - Working with Fit Points ...................................................... 98
- Blending Between Objects with Splines ................................. 101

### Chapter 6: Controlling Object Visibility and Appearance

- Changing Object Properties ............................................... 105
- Setting the Current Layer ..................................................... 109
- Altering the Layer Assignments of Objects ......................... 112
- Controlling Layer Visibility ............................................... 114
  - Toggling Layer Status ....................................................... 114
  - Isolating Layers ............................................................... 117
  - Saving Layer States .......................................................... 119
- Applying Linetype .............................................................. 120
- Assigning Properties by Object or by Layer .......................... 123
- Managing Layer Properties ............................................... 125

### Chapter 7: Organizing Objects

- Defining Blocks ..................................................................... 129
  - Drawing a Chair and Defining It as a Block ......................... 130
  - Drawing a Door and Defining It as a Block .......................... 133
## Contents

<table>
<thead>
<tr>
<th>Chapter 8</th>
<th><strong>Hatching and Gradients</strong></th>
<th>153</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inserting Blocks</strong></td>
<td>134</td>
<td></td>
</tr>
<tr>
<td><strong>Editing Blocks</strong></td>
<td>139</td>
<td></td>
</tr>
<tr>
<td><strong>Editing Block Definition Geometry</strong></td>
<td>139</td>
<td></td>
</tr>
<tr>
<td><strong>Assigning Floating Properties</strong></td>
<td>140</td>
<td></td>
</tr>
<tr>
<td><strong>Nesting Blocks</strong></td>
<td>143</td>
<td></td>
</tr>
<tr>
<td><strong>Exploding Blocks</strong></td>
<td>144</td>
<td></td>
</tr>
<tr>
<td><strong>Redefining Blocks</strong></td>
<td>146</td>
<td></td>
</tr>
<tr>
<td><strong>Working with Groups</strong></td>
<td>149</td>
<td></td>
</tr>
<tr>
<td><strong>Specifying Hatch Areas</strong></td>
<td>153</td>
<td></td>
</tr>
<tr>
<td><strong>Picking Points to Determine Boundaries</strong></td>
<td>153</td>
<td></td>
</tr>
<tr>
<td><strong>Selecting Objects to Define Boundaries</strong></td>
<td>158</td>
<td></td>
</tr>
<tr>
<td><strong>Associating Hatches with Boundaries</strong></td>
<td>159</td>
<td></td>
</tr>
<tr>
<td><strong>Hatching with Patterns</strong></td>
<td>162</td>
<td></td>
</tr>
<tr>
<td><strong>Specifying Properties</strong></td>
<td>163</td>
<td></td>
</tr>
<tr>
<td><strong>Separating Hatch Areas</strong></td>
<td>164</td>
<td></td>
</tr>
<tr>
<td><strong>Hatching with Gradients</strong></td>
<td>166</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th><strong>Working with Blocks and Xrefs</strong></th>
<th>171</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Working with Global Blocks</strong></td>
<td>171</td>
<td></td>
</tr>
<tr>
<td><strong>Writing a Local Block Definition to a File</strong></td>
<td>171</td>
<td></td>
</tr>
<tr>
<td><strong>Inserting a Drawing as a Local Block</strong></td>
<td>175</td>
<td></td>
</tr>
<tr>
<td><strong>Redefining Local Blocks with Global Blocks</strong></td>
<td>177</td>
<td></td>
</tr>
<tr>
<td><strong>Accessing Content Globally</strong></td>
<td>179</td>
<td></td>
</tr>
<tr>
<td><strong>Storing Content on Tool Palettes</strong></td>
<td>183</td>
<td></td>
</tr>
<tr>
<td><strong>Referencing External Drawings and Images</strong></td>
<td>186</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10</th>
<th><strong>Creating and Editing Text</strong></th>
<th>193</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creating Text Styles</strong></td>
<td>193</td>
<td></td>
</tr>
<tr>
<td><strong>Writing Lines of Text</strong></td>
<td>195</td>
<td></td>
</tr>
<tr>
<td><strong>Creating Text to Fit</strong></td>
<td>195</td>
<td></td>
</tr>
<tr>
<td><strong>Justifying Text</strong></td>
<td>197</td>
<td></td>
</tr>
<tr>
<td><strong>Transforming and Creating Text</strong></td>
<td>198</td>
<td></td>
</tr>
<tr>
<td><strong>Writing and Formatting Paragraphs of Text Using MTEXT</strong></td>
<td>200</td>
<td></td>
</tr>
<tr>
<td><strong>Editing Text</strong></td>
<td>203</td>
<td></td>
</tr>
<tr>
<td><strong>Editing Content and Properties</strong></td>
<td>203</td>
<td></td>
</tr>
<tr>
<td><strong>Working with Columns</strong></td>
<td>204</td>
<td></td>
</tr>
</tbody>
</table>
## Chapter 11  Dimensioning  207

- Styling Dimensions .................................. 207
- Adding Dimensions .................................. 213
  - Using Inquiry Commands ............................. 214
  - Adding Dimension Objects ......................... 216
  - Adding and Styling Multileaders ................. 220
- Editing Dimensions .................................. 222

## Chapter 12  Keeping In Control with Constraints  227

- Working with Geometric Constraints ............ 227
- Applying Dimensional Constraints and Creating User Parameters ............... 231
- Constraining Objects Simultaneously with Geometry and Dimensions .......... 234
- Making Parametric Changes to Constrained Objects ......................... 237

## Chapter 13  Working with Layouts and Annotative Objects  241

- Creating Annotative Styles and Objects ........ 241
  - Working with Annotative Text .................... 242
  - Working with Annotative Dimensions .......... 245
- Creating Layouts .................................... 247
- Adjusting Floating Viewports ..................... 251
  - Working on Layout1 ................................ 251
  - Working on Layout2 ................................ 254
- Overriding Layer Properties in Layout Viewports .......................... 256
- Drawing on Layouts ................................ 258

## Chapter 14  Printing and Plotting  263

- Configuring Output Devices ....................... 263
  - Setting Up a System Printer ...................... 264
  - Setting Up an AutoCAD Plotter ................. 264
- Creating Plot Style Tables ....................... 268
- Using Plot Style Tables ............................ 271
  - Configuring New Drawings for Named Plot Style Tables .................. 271
  - Assigning Plot Styles by Layer or by Object ...................... 275
- Plotting in Modelspace ............................. 278
- Plotting Layouts in Paperspace ................... 281
- Exporting to an Electronic Format ............... 285
<table>
<thead>
<tr>
<th><strong>Chapter 15</strong></th>
<th><strong>Working with Data</strong></th>
<th>289</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geolocating Projects</td>
<td></td>
<td>289</td>
</tr>
<tr>
<td>Importing SketchUp Models</td>
<td></td>
<td>293</td>
</tr>
<tr>
<td>Defining Attributes and Blocks</td>
<td></td>
<td>295</td>
</tr>
<tr>
<td>Inserting Attributed Blocks</td>
<td></td>
<td>299</td>
</tr>
<tr>
<td>Editing Table Styles and Creating Tables</td>
<td></td>
<td>301</td>
</tr>
<tr>
<td>Using Fields in Table Cells</td>
<td></td>
<td>306</td>
</tr>
<tr>
<td>Editing Table Data</td>
<td></td>
<td>309</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Chapter 16</strong></th>
<th><strong>Navigating 3D Models</strong></th>
<th>317</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Visual Styles</td>
<td></td>
<td>317</td>
</tr>
<tr>
<td>Working with Tiled Viewports</td>
<td></td>
<td>322</td>
</tr>
<tr>
<td>Navigating with the ViewCube</td>
<td></td>
<td>323</td>
</tr>
<tr>
<td>Orbiting in 3D</td>
<td></td>
<td>326</td>
</tr>
<tr>
<td>Using Cameras</td>
<td></td>
<td>327</td>
</tr>
<tr>
<td>Navigating with SteeringWheels</td>
<td></td>
<td>330</td>
</tr>
<tr>
<td>Saving Views</td>
<td></td>
<td>332</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Chapter 17</strong></th>
<th><strong>Modeling in 3D</strong></th>
<th>337</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Surface Models</td>
<td></td>
<td>337</td>
</tr>
<tr>
<td>Making Planar Surfaces</td>
<td></td>
<td>338</td>
</tr>
<tr>
<td>Revolving a 2D Profile to Create a 3D Model</td>
<td></td>
<td>339</td>
</tr>
<tr>
<td>Sweeping Out 3D Geometry</td>
<td></td>
<td>340</td>
</tr>
<tr>
<td>Extruding 2D Geometry into 3D</td>
<td></td>
<td>342</td>
</tr>
<tr>
<td>Editing Surface Models</td>
<td></td>
<td>344</td>
</tr>
<tr>
<td>Trimming Surfaces with Other Surfaces</td>
<td></td>
<td>344</td>
</tr>
<tr>
<td>Projecting Edges on Surfaces</td>
<td></td>
<td>345</td>
</tr>
<tr>
<td>Trimming Surfaces with Edges</td>
<td></td>
<td>348</td>
</tr>
<tr>
<td>Creating Solid Models</td>
<td></td>
<td>350</td>
</tr>
<tr>
<td>Extruding Solid Objects</td>
<td></td>
<td>350</td>
</tr>
<tr>
<td>Lofting Solid Objects</td>
<td></td>
<td>354</td>
</tr>
<tr>
<td>Editing Solid Models</td>
<td></td>
<td>356</td>
</tr>
<tr>
<td>Performing Boolean Operations</td>
<td></td>
<td>356</td>
</tr>
<tr>
<td>Editing Solids</td>
<td></td>
<td>359</td>
</tr>
<tr>
<td>Smoothing Meshes</td>
<td></td>
<td>362</td>
</tr>
</tbody>
</table>
**Introduction**

*The staying power of* AutoCAD® is legendary in the ever-changing software industry, having been around for 32 years by 2014. You can rest assured that spending your time learning AutoCAD will be a wise investment, and the skills you obtain in this book will be useful for years to come.

I wish to welcome you in beginning the process of learning AutoCAD. It will give you great satisfaction to learn such a complex program and use it to design and document whatever you dream up. You'll find step-by-step tutorials that reveal a wide variety of techniques built on many years of real-world experience.

The first 14 chapters apply to both AutoCAD® 2014 and AutoCAD LT® 2014. AutoCAD LT is Autodesk’s lower-cost version of AutoCAD, and it has reduced capabilities. Chapters 15 through 18 are for full AutoCAD users only as they cover advanced tools not available in AutoCAD LT, including attributes, 3D navigation, 3D modeling, and rendering.

**Who Should Read This Book**

This book is for students, hobbyists, professional architects, industrial designers, engineers, builders, landscape architects, or anyone who communicates through technical drawings as part of their work.

If you're interested in certification for AutoCAD 2014, this book can be a great resource to help you prepare. See [www.autodesk.com/certification](http://www.autodesk.com/certification) for more certification information and resources. This book also features an appendix that can help you focus your studies on the skills you will need for the certification exams.

**What You Will Learn**

You'll gain a solid understanding of the features of AutoCAD in this book. Each chapter features multiple exercises that take you step by step through the many complex procedures of AutoCAD. The goal of performing these steps on your own is to develop skills that you can apply to many different real-world situations.

Although each project presents different obstacles and opportunities, I urge you to focus on the concepts and techniques presented rather than memorizing the specific steps used to achieve the desired result. The actual steps performed may vary in each geometric situation.
The best way to build skills is to perform the steps on your computer exactly as they are presented in the book during your first reading. After you achieve the desired result, start over and experiment using the same techniques on your own project (whether invented or real). After you have practiced, think about how you have achieved the desired result and you will get the most out of this book.

**Reader Requirements**

You don't need any previous experience with AutoCAD to use this book. However, you’ll need familiarity with either the Windows or Mac operating system and have the basic skills necessary to use a graphical user interface successfully and to operate a computer confidently.

**AutoCAD 2014 or AutoCAD LT 2014 System Requirements**

The book is written for both AutoCAD 2014 and AutoCAD LT 2014. The following are system requirements for running either version on the different operating systems in which they are offered. See [www.autodesk.com](http://www.autodesk.com) for the most up-to-date requirements.

**General Windows System Requirements**

- Microsoft Windows 8, Pro, or Enterprise
- Microsoft Windows 7 (SP1 or later) Enterprise, Ultimate, Professional, or Home Premium
- Microsoft Windows XP (SP2 or later) Home or Windows XP Professional
- 2 GB of RAM
- 2 GB of free space for installation
- $1,280 \times 1,024$ true color video display adapter 128 MB or greater, Microsoft® Direct3D®-capable workstation-class graphics card; Pixel Shader 3.0 or greater required for 3D modeling
- Internet Explorer 7.0 or later
32-Bit AutoCAD 2014 for Windows

- Windows® 8 Standard, Enterprise, or Professional edition, Windows® 7 Enterprise, Ultimate, Professional, or Home Premium edition (compare Windows versions), or Windows XP® Professional or Home edition (SP3 or later) operating system
- For Windows 8 and Windows 7: Intel® Pentium® 4 or AMD Athlon™ dual-core processor, 3.0 GHz or higher with SSE2 technology
- For Windows XP: Pentium 4 or Athlon dual-core processor, 1.6 GHz or higher with SSE2 technology
- 2 GB RAM (4 GB recommended)
- 6 GB free disk space for installation
- 1,024 x 768 display resolution with true color (1,600 x 1,050 recommended)
- Microsoft® Internet Explorer® 7 or later web browser
- Install from download or DVD

64-Bit AutoCAD 2014 for Windows

- Windows 8 Standard, Enterprise, or Professional edition, Windows 7 Enterprise, Ultimate, Professional, or Home Premium edition (compare Windows versions), or Windows XP Professional (SP2 or later)
- Athlon 64 with SSE2 technology, AMD Opteron™ processor with SSE2 technology, Intel® Xeon® processor with Intel EM64T support and SSE2 technology, or Pentium 4 with Intel EM64T support and SSE2 technology
- 2 GB RAM (4 GB recommended)
- 6 GB free space for installation
- 1,024 x 768 display resolution with true color (1,600 x 1,050 recommended)
- Internet Explorer 7 or later
- Install from download or DVD
64-Bit AutoCAD 2014 for Mac

- Apple® Mac OS® X v10.8.0 or later (Mountain Lion),
- OS X v10.7.2 or later (Lion), or OS X v10.6.8 or later (Snow Leopard) with 64-bit Intel processor
- Apple® Mac® Pro 4.1 or later; MacBook® Pro 5.1 or later (MacBook Pro 6.1 or later recommended); iMac® 8.1 or later (iMac 11.1 or later recommended); Mac® mini 3.1 or later (Mac mini 4.1 or later recommended); MacBook Air® 2.1 or later; MacBook® 5.1 or later (MacBook 7.1 or later recommended)
- 3 GB of RAM (4 GB recommended)
- 2.5 GB free disk space for download and installation (3 GB recommended)
- All graphics cards on supported hardware
- 1,280 × 800 display with true color (1,600 × 1,200 recommended)
- All Mac OS X supported language operating systems
- Apple® Mouse, Apple Magic Mouse, Magic Trackpad, MacBook® Pro trackpad, or Microsoft-compliant mouse.
- Mac OS X-compliant printer

Additional Requirements for Large Datasets, Point Clouds, and 3D Modeling (all Windows configurations)

- Pentium 4 or Athlon processor, 3 GHz or greater, or Intel or AMD dual-core processor, 2 GHz or greater
- 4 GB RAM or more
- 6 GB hard disk space available in addition to free space required for installation
- 1,280 × 1,024 true color video display adapter 128 MB or greater, Pixel Shader 3.0 or greater, Microsoft® Direct3D®-capable workstation-class graphics card
**FREE AUTODESK SOFTWARE FOR STUDENTS AND EDUCATORS**

The Autodesk Education Community is an online resource with more than five million members that enables educators and students to download—for free (see website for terms and conditions)—the same software used by professionals worldwide. You can also access additional tools and materials to help you design, visualize, and simulate ideas. Connect with other learners to stay current with the latest industry trends and get the most out of your designs. Get started today at [www.autodesk.com/joinedu](http://www.autodesk.com/joinedu).

---

**What Is Covered in This Book**

*AutoCAD 2014 and AutoCAD LT 2014 Essentials* is organized to provide you with the knowledge needed to master the basics of computer-aided design. The book’s web page is located at [www.sybex.com/go/autocad2014essentials](http://www.sybex.com/go/autocad2014essentials), where you can download the sample files used in each chapter.

**Chapter 1: Getting Started**

You’ll take a tour of the user interface and learn to identify each of its parts by name. Chapter 1 is essential reading as you’ll need to know the difference between workspaces, ribbon tabs, toolbars, panels, palettes, status toggles, and so on to understand the terminology used by your colleagues and in the rest of this book. In addition, you’ll learn about how to match your industry’s standard units to the drawings you’ll be creating.

**Chapter 2: Basic Drawing Skills**

Learn how to navigate a 2D drawing with Zoom and Pan so that you can zero in on areas of interest. You’ll learn how to draw lines, rectangles, circles, arcs, and polygons; how to cancel, erase, and undo; and how to fillet and chamfer lines. In addition, you’ll use two coordinate systems to specify the exact sizes of objects you are drawing.

**Chapter 3: Using Drawing Aids**

Drawing aids are something you’ll want to learn how to use to create measured drawings with ease. The drawing aids covered with step-by-step exercises in this chapter include grid and snap, ortho and polar tracking, PolarSnap, running object snaps, the From snap, and object snap tracking.

**Chapter 4: Editing Entities**

This chapter teaches what you’ll probably be doing most of the time in AutoCAD: editing the basic entities that you’ve drawn to make them conform with your design intent. Editing commands covered include Move,
Copy, Rotate, Scale, Array, Trim, Extend, Lengthen, Stretch, Offset, and Mirror. In addition to these commands, you’ll learn an alternative method for editing entities called grip editing.

**Chapter 5: Shaping Curves**  The landscape exercise in this chapter teaches you how to create complex curves with NURBS-based splines, curved polylines, and ellipses. By the end, you’ll be able to shape curves to create almost any curvilinear form imaginable.

**Chapter 6: Controlling Object Visibility and Appearance**  You’ll learn how to hide and reveal objects with properties and layers. Layers are essential to managing the complexity of design, and you’ll use many different layer tools in this chapter’s step-by-step exercises.

**Chapter 7: Organizing Objects**  By combining entities such as lines, polylines, circles, arcs, and text into blocks and/or groups, you can more efficiently manipulate more complex objects such as chairs, mechanical assemblies, trees, or any other organizational designation appropriate to your industry. You’ll learn how to create and work with blocks and groups in this chapter.

**Chapter 8: Hatching and Gradients**  In this chapter, you’ll flood bounded areas with solid fill, hatch patterns, and/or gradients to indicate transitions between materials and to improve the readability of drawings in general.

**Chapter 9: Working with Blocks and Xrefs**  You’ll learn how to access content from other files in the current drawing in this chapter. You’ll also understand the important distinction between inserting and externally referencing content. In addition, you’ll store saved content on tool palettes for simplified reuse.

**Chapter 10: Creating and Editing Text**  The written word is undeniably a part of every drawing. This chapter teaches you how to create both single- and multiline text, how to edit any text, and how to control its appearance through text styles and object properties.

**Chapter 11: Dimensioning**  You’ll learn how to annotate drawings with specific measurements known as dimensions in this chapter. In addition to learning how to control measurements’ appearance with dimension styles, you’ll create linear, aligned, angular, and radius dimension objects.

**Chapter 12: Keeping In Control with Constraints**  This chapter teaches you how to add geometric and dimensional constraints to objects so that their ultimate form is controlled by mathematical formulas. The formulas in the examples are as simple as adding two dimensions or calculating the diameter of a circle from its radius.
Chapter 13: Working with Layouts and Annotative Objects  AutoCAD has two environments, which you’ll learn about in this chapter on layouts: model-space and paperspace. You’ll create floating viewports to display the contents of modelspace in the paperspace of a layout. In addition, you’ll create annotative styles and objects that always display the proper height no matter which viewport or annotation scale is selected.

Chapter 14: Printing and Plotting  From plotter drivers to plot style tables and page setups, you’ll learn the intricacies of creating printed output to scale in AutoCAD. You’ll plot in both modelspace and paperspace, and you will even create electronic output that can be shared on the Internet.

Chapter 15: Working with Data  Attributes, fields, and tables are the subjects of this chapter on managing data. You’ll learn how to embed nongraphical data in blocks, how to link to that data dynamically in text fields, and finally how to display and format this same data in an organized fashion in spreadsheet-like tables.

Chapter 16: Navigating 3D Models  In this chapter, you’ll learn how to change your point of view while working on 3D models using the ViewCube®, the Orbit tool, and SteeringWheel® technology. In addition, you’ll compose and save perspective views with cameras to help you visualize 3D models with added realism.

Chapter 17: Modeling in 3D  You’ll learn the basics of surface, solid, and mesh modeling in this chapter by building the 3D geometry you navigated in the previous chapter. Each 3D toolset has its strengths and limitations, and you’ll learn to use tools in each category to get the job done.

Chapter 18: Presenting and Documenting 3D Design  By assigning realistic materials, inserting artificial and natural light sources, and rendering the scene, you’ll create realistic computer-generated imagery in this chapter. By approaching the final render in a series of ever more realistic test renders, you’ll hone in on photorealistic output in stages. You’ll also learn how to project 2D plans, sections, and detail drawings from a model so that you can dimension and document 3D designs.

Appendix: Autodesk AutoCAD 2014 Certification  The appendix contains information about how to prepare for Autodesk certification exams using this book. The tables point you to the chapters where you’ll find specific examples giving you practical experience with the topics covered in the exams.
The Essentials Series

The Essentials series from Sybex provides outstanding instruction for readers who are just beginning to develop their professional skills. Every Essentials book includes these features:

- Skill-based instruction with chapters organized around projects rather than abstract concepts or subjects.
- Suggestions for additional exercises at the end of each chapter, where you can practice and extend your skills.
- Digital files (via download) so that you can work through the project tutorials yourself. Please check the book’s web page at www.sybex.com/go/autocad2014essentials for these companion downloads.

The certification margin icon will alert you to passages that are especially relevant to AutoCAD 2014 certification. See the certification appendix and www.autodesk.com/certification for more information and resources.
GETTING STARTED

As you begin this book on the AutoCAD® program, I’m reminded of a quote by Chinese philosopher Lao-Tzu: “A journey of a thousand miles begins with a single step.” In much the same way, learning AutoCAD is something anyone can do by taking it one step at a time. And I promise that AutoCAD is much easier than walking a thousand miles!

By buying this book, you have already taken the first step in this journey. When you finish, you will have a solid understanding of AutoCAD.

- Exploring the AutoCAD 2014 for Windows user interface
- Setting drawing units

EXPLORING THE AUTOCAD 2014 FOR WINDOWS USER INTERFACE

Autodesk has recently released new versions of AutoCAD, including AutoCAD® 2014 and AutoCAD LT® 2014. The two Windows versions look nearly identical and function in almost the same way. The main difference between them is that AutoCAD LT doesn’t support automation and some of the advanced 3D functions. The Mac version looks a bit different than its Windows cousins, but it functions nearly identically to AutoCAD for Windows, albeit with a slightly reduced set of features. Although this book was written using AutoCAD 2014 running on Windows XP Professional, you can use it to learn any of the current versions of AutoCAD.

EXPLORING THE GRAPHICAL USER INTERFACE

Before you can use AutoCAD, you’ll need to familiarize yourself thoroughly with its graphical user interface (GUI). The AutoCAD 2014 (for Windows) user interface is shown in Figure 1.1.
Let’s now step through the basic user interface for AutoCAD:

1. Click the Application menu. Type *polygon*, and observe that the text appears in the search box at the top of the Application menu. The search results (see Figure 1.2) list many related AutoCAD commands. Search is useful when you’re not sure how to access a command in the interface or what its exact name is.

2. Click the red X at the extreme right edge of the search box to make the initial Application menu interface reappear. Here you can create new or open existing drawings, export or print drawings, and more. Hover the cursor over Open, and then click Drawing (Figure 1.3).

3. Select the following sample file, and click Open in the Select File dialog box:

   ```
   C:\Program Files\Autodesk\AutoCAD 2014\Sample\Sheet Sets\Manufacturing\VW252-02-0142.dwg
   ```

   If you are using AutoCAD LT, open any of the sample files located under `C:\Program Files\Autodesk\AutoCAD LT 2014\Sample`. The Sheet Set Manager palette appears when the sample file is opened (see Figure 1.4). This palette automatically appears when you open any drawing that’s a part of a sheet set. AutoCAD has many palettes to organize tools and reusable drawing content.
Exploring the AutoCAD 2014 for Windows User Interface

**FIGURE 1.2** Searching for commands in the Application menu

**FIGURE 1.3** Opening a drawing from the Application menu
Chapter 1 • Getting Started

4. Click the Sheet Views tab along the right edge of the Sheet Set Manager, and observe that tabs provide a means of accessing additional interface content. In its present state, the Sheet Set Manager is a floating palette. Drag its palette bar, and relocate it on screen.

5. Click the Auto-hide toggle, and watch the palette collapse to its vertical palette bar; this saves space on screen. Hover the cursor over the palette bar, and watch the whole palette reappear so that you can access its content. Now toggle Auto-hide off.

6. Click the Palette-properties menu and select Anchor Left. The Sheet Set Manager palette is docked along the left edge of the user interface. There are many options you can use to organize the user interface to match the way you work.

7. Double-click Detail-B under 04 – Brush Roller Sub Assy in the Manufacturing sheet set (see Figure 1.5). A new drawing appears in the drawing window.

8. Click the Open button in the Quick Access toolbar. Select any drawing in the Manufacturing folder and click Open. If you are using AutoCAD LT, open any other sample file.

9. Click the Quick View Drawings button in the application status bar (see Figure 1.6). Move the cursor over the first drawing, and observe that two smaller views appear above it. These are the highlighted drawing’s spaces. Move the cursor over Model, and its view will enlarge. Click the model view icon to go there immediately. Use Quick View to navigate through open drawings and their spaces.
FIGURE 1.5 Docking a palette

FIGURE 1.6 Accessing open drawings and their spaces with Quick View
AutoCAD Drawing Spaces

AutoCAD has two types of drawing spaces: paper and model. Paperspace is a two-dimensional area analogous to, and having the dimensions of, a sheet of paper. Various sizes of “paper” can be created in individual layouts (see Chapter 13, “Working with Layouts and Annotative Objects”). Modelspace, on the other hand, is a single three-dimensional volume where everything is drawn in actual size. Modelspace is typically scaled down in viewports and displayed in paperspace. Most of the drawing you will do in AutoCAD will be in modelspace. Both paper- and modelspaces are saved in the same drawing file.

Exploring Workspaces

AutoCAD workspaces (not to be confused with drawing spaces) are stored sets of user interface controls, which include menus, toolbars, palettes, and the ribbon. People use workspaces to configure the interface quickly for the task at hand. Let’s take a brief look at the workspaces in AutoCAD:

1. Select the AutoCAD Classic workspace from the drop-down menu on the Quick Access toolbar. The user interface changes dramatically (see Figure 1.7). The AutoCAD Classic workspace makes AutoCAD look similar to how it did in 2008 and earlier.

Although longtime users might feel more comfortable with the AutoCAD Classic interface, there are many advantages to using all the workspaces.
2. Drag a docked toolbar out from the edge of the screen and convert it into a floating toolbar. Select Tools ➔ Toolbars ➔ AutoCAD ➔ Dimension from the Classic menu bar. Drag the Dimension floating toolbar to any edge of the screen and dock it.

3. Position the cursor over a docked toolbar button and right-click; a toolbar context menu appears. Select Object Snap from this menu (Figure 1.8).

4. Right-click in the drawing window, and you’ll see a different context menu. Right-clicking over most items, from the tool palettes to the status bar buttons, brings up other unique context menus. In the Classic workspace, right-clicking is the means for accessing numerous context-sensitive menus throughout the user interface.

**The AutoCAD Ribbon**

AutoCAD has so many toolbars, palettes, and menus that finding the right tool for the job can seem like a job in itself. The ribbon is therefore an important feature that was introduced to AutoCAD 2010. Autodesk adopted Microsoft’s ribbon standard to organize the ever-increasing number of toolbars in a single palette,
making tools much easier to find. Now let’s explore the various ribbon modes and identify the user interface elements of each mode.

1. Choose the 3D Basics workspace from the drop-down menu in the Quick Access toolbar. The ribbon replaces all the Classic menus and toolbars (see Figure 1.9). Close the Tool Palettes and the Online floating toolbar.

![Figure 1.9 The full ribbon interface](image)

2. Click the Minimize Ribbon button, and observe that the full ribbon changes to display tabs and panel buttons (see Figure 1.10). Hover the cursor over the panel buttons. The buttons expand to reveal all the tools shown on the full ribbon.

![Figure 1.10 Ribbon modes](image)

3. Click the Minimize Ribbon button again. The panel buttons change into panel titles. Hover the cursor again over the titles to reveal each panel’s tools.

4. Click the Minimize Ribbon button once again. Hovering the cursor over the tabs doesn’t have any effect. Click the Home tab to reveal the full panel temporarily. It disappears after you move the cursor away.

5. Click the Minimize Ribbon button one last time. The full ribbon interface is restored.
6. Click the Edit button at the bottom of the Edit panel to reveal additional tools. Hover the mouse over one of the tools to display a tooltip that identifies the tool and describes its function. Holding the cursor still a while longer reveals either a drawing or a video (without audio) that visually demonstrates what the tool does (see Figure 1.11).

![Figure 1.11 Tooltips and illustrations](image)

7. Observe that the bottom of the tooltip shown in Figure 1.11 reveals the command name (SOLIDEEDIT in this case). The ribbon, menus, toolbars, and palettes are all graphical alternatives to typing commands.

8. Press and release the Alt key. Keytips appear on the ribbon (see Figure 1.12). Pressing any of the letter combinations activates that part of the GUI. Type IN, and observe that the Insert tab is selected without moving the cursor.

![Figure 1.12 Keytips allow you to press keys to manipulate the ribbon with the keyboard.](image)

AutoCAD is based on commands. If you know the name of a command, you can type it instead of finding it in the GUI.
9. Press the F2 key to open the AutoCAD Text window. The bottom line, Command: , is called the command line. It is the active line where commands appear, regardless of whether they are typed or triggered from the GUI. The complete history of commands scrolls upward as new commands are entered. Close the AutoCAD Text window. Three lines of this command history appear at the bottom of the user interface, just above the application status bar.

10. The application status bar contains a coordinate readout on the left, a number of status toggle buttons, and various items, as shown in Figure 1.13. Toggle off all the status bar toggles so that none of their icons are highlighted in blue. Click the application status bar menu, and deselect Clean Screen; its button disappears. You can control which buttons appear using this menu.

11. Type POL, and observe how the command line’s AutoComplete feature highlights commands in alphabetical order as you type (see Figure 1.14). Use the arrow keys to move up or down through the list, and press Enter when you find the command for which you are looking, or click its name in the list, instead of typing the entire word. (Note: Some commands and system variables can be quite lengthy.) In AutoCAD 2014, there are buttons on each command in the AutoComplete list to look up additional information in the Help system and/or on the Internet with a single click. Hovering the mouse over any one of the commands in the list brings up a drawing illustrating the use of the command.

12. Take a look at the InfoCenter at the top right of the screen (see Figure 1.15). This is where you sign in to Autodesk 360 and the larger user community. Click in the search field and type solid.
Setting Drawing Units

Before you start drawing, it’s important to decide what one drawing unit represents in the real world. Architects in the United States typically equate one drawing unit with one inch in AutoCAD. You need to choose a unit type that matches your country’s industry standard.

Architectural  As the name suggests, most American architects will choose this type, which displays units in feet and inches. For example, 12 feet, 6½
inches is typed as **12′ 6-1/2″**. The hyphen is used to separate inches from fractions of an inch rather than feet from inches.

**Decimal**  Metric users should select this type. One decimal unit can be equal to one millimeter, one centimeter, or any metric unit.

**Engineering**  Like the architectural type, engineering units feature feet and inches, but the inches are represented in decimal form—for example, 126.500.

**Fractional**  American woodworkers often prefer to set AutoCAD drawings in fractional units of inches because that is how their work is normally reckoned. For example, 12 feet, 6½ inches reads 150-½″ in fractional units.

**Scientific**  For example, 12 million parsecs reads 12.000E+06 in scientific units, where 12.000 indicates 12 accurate to a precision of three decimal places and E+06 indicates the exponential function to the sixth power, or one million.

Let’s set the AutoCAD drawing units:

1. Click the New button on the Quick Access toolbar. Click the arrow button next to the Open button in the Select Template dialog box, and choose Open With No Template – Imperial (see Figure 1.16).

![Select Template Dialog Box](image)

**FIGURE 1.16** Opening a drawing with no template
2. Type **UN**, and press Enter to bring up the Drawing Units dialog box (see Figure 1.17). **UN** is the command alias (abbreviation) of the **UNITS** command. Most commands have aliases that minimize typing.

![Drawing Units dialog box](image)

**FIGURE 1.17** Setting drawing units

3. Select Architectural from the Type drop-down menu. We’re using Architectural in this book, but you should select the unit type that fits your industry when working professionally. Metric users should select Decimal length units.

4. Click the Length Precision drop-down menu, and select 1/8” (or 0 for metric). Set Angle Type to Decimal Degrees and Angle Precision to 0.00 (two decimal places).

5. Click the Insertion Scale drop-down menu, and select Inches (or Centimeters for metric). Click OK to close the Drawing Units dialog box.
You have had a brief overview of the user interface and learned how to control the look and feel of AutoCAD to suit your working style and needs. In addition, you’ve learned how to create a new drawing and set the drawing units, and you’re ready to get started on the business of drawing.

**Additional Exercises**

- **Drawing templates** are drawing files that store styles, layers (which you will learn about in Chapter 6, “Controlling Object Visibility and Appearance”), and settings that you want to keep consistent in every drawing you create. Set up the drawing units according to the way you work, and save a new template file (.dwt). Then create a new drawing file (.dwg) based on your template, and verify that the units are as expected. As you learn more about styles, layers, and settings later in this book, you can add your preferences to this template file. Be aware that templates do not affect preexisting drawings.
Basic Drawing Skills

_This chapter teaches you_ how to draw basic shapes, such as lines, rectangles, circles, arcs, and polygons. You will learn how to correct mistakes, navigate two-dimensional space, and use coordinate systems to draw accurately. In addition, you'll perform your first editing tasks by joining existing lines in straight, rounded, or angled intersections.

- Navigating 2D drawings
- Drawing lines and rectangles
- Canceling, erasing, and undoing
- Using coordinate systems
- Drawing circles, arcs, and polygons
- Filleting and chamfering lines

Navigating 2D Drawings

Unlike image-editing programs where zooming in results in blurry, pixilated images, you can zoom in forever in the AutoCAD® program without suffering any loss in quality. However, to avoid getting lost in space, you’ll need to learn how to navigate with a variety of pan and zoom tools that you’ll explore here.

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, and browse to Chapter 2. Get the file Ch2-A.dwg or Ch2-A-metric.dwg, and open it in AutoCAD (see Figure 2.1).

2. Click the arrow under the Zoom Extents button on the Navigation bar to open the Zoom flyout menu, and select Zoom In. The Zoom In button replaces the original button (which was Zoom Extents) on the Navigation bar. The last used tool appears on top. Click the Zoom In icon again, and the view is magnified by another factor of 2.
3. Click Pan in the Navigation bar, drag the mouse from left to right, and then press Enter to end the command.

4. For an alternative method, press and hold the mouse wheel and pan the drawing to center the refrigerator on the canvas (as shown in Figure 2.2).
5. Select the Drafting & Annotation workspace if it is not already selected, and then select the View tab in the ribbon. Click the bottom menu arrow in the Navigate 2D panel, and select Zoom Realtime (see Figure 2.3). Drag up in the document window to zoom in until the refrigerator fills the screen, and then press Esc.

![Zoom tools on the Navigate 2D panel of the View tab of the ribbon](image)

**Figure 2.3** Zoom tools on the Navigate 2D panel of the View tab of the ribbon

6. Pan to the lower-left corner of the refrigerator using the scroll bars at the edges of the document window. If your scroll bars are not visible, drag the mouse wheel to pan. (You can turn on the scroll bars with the OPTIONS command.)

7. Select Zoom Window from the Navigate panel on the View tab. Click points A and B, as shown in Figure 2.4. The area of the rectangle you draw is magnified to fill the canvas.

8. Roll the mouse wheel forward to zoom in further, and drag the mouse wheel if necessary to reveal the object in the lower-left corner of the refrigerator (see Figure 2.5).
9. Type \texttt{Z}, and press the spacebar (\texttt{Z} is the command alias for the \texttt{ZOOM} command). Read the prompt in the Command window or press the down-arrow key to see the menu in the drawing area:

\begin{verbatim}
ZOOM
Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>:
\end{verbatim}

You are looking at the roots of AutoCAD in the form of command-line options. This interface was invented before the rest of the GUI, and remarkably it not only still functions but is also a very efficient means of working with AutoCAD. Execute any of the options shown in square brackets by typing the capitalized letter. The option in angled brackets (\texttt{real time} in this case) executes by default if you press Enter without typing anything.

10. Type \texttt{P}, and press Enter to execute Zoom Previous. Press Enter again to repeat the previous command (\texttt{ZOOM}), type \texttt{P}, and press Enter again. Repeat this process until you can see the entire refrigerator again.

11. To see everything that has been drawn, you use Zoom Extents. Double-click the mouse wheel to use Zoom Extents.
12. Position the cursor over the bathroom sink, and roll the mouse wheel forward to zoom in. Notice that the view stays centered on the sink without having to pan (see Figure 2.6). Drag the mouse wheel to make slight panning adjustments if necessary to center the target object on the screen.

![Figure 2.6 Directing navigation by positioning the cursor over the bathroom sink while zooming](image)

13. Practice zooming into the kitchen sink, the stove, and the bathtub using the various methods shown in this section. Leave the drawing file open for work in the next section.

**Drawing Lines and Rectangles**

The drawing commands you’ll probably use the most in AutoCAD are **LINE** and **RECTANGLE**. You will begin by drawing some lines and rectangles without worrying yet about entering measurements.

**Drawing Lines**

Lines are the backbone of AutoCAD. Let’s begin drawing lines.

1. In Ch2-A.dwg or Ch2-A-metric.dwg, zoom into the living room at the lower right of the floor plan so that empty space fills the canvas.

2. Turn off all status toggles in the application status bar. Status toggles are highlighted in blue when they are on and appear in gray when they are off (see Figure 2.7).
3. Type L, and press Enter. Click two arbitrary points to define a line object. Observe the flexible segment (called a rubberband) connecting the cursor with the second point you clicked (see Figure 2.8).

4. Click another point to draw your second segment. The prompt in the Command window reads:

   Specify next point or [Close/Undo]:

   Type U, and press Enter. The last point you clicked is undone, but the rubberband continues to be connected to the cursor, indicating that you can keep drawing lines.

5. Click two more points, and then type C and press Enter to create a closing segment between the first and last points. The close option automatically terminates the line command.

6. Press the spacebar (or Enter) to repeat the last command. Click two arbitrary points to create a single line segment. Right-click to open the context menu, and then select Enter with a left-click to complete the Line command.

7. Open the Application menu and click the Options button at the bottom. Click the User Preferences tab in the Options dialog box that appears. Under the Windows Standard Behavior section, select Right-Click Customization and then, in the new dialog box, select Turn On Time-Sensitive Right-Click (see Figure 2.9). Click Apply & Close, and then click OK in the Options dialog box.

Time-Sensitive Right-Click is just that: an option. Try it out to see if you find drawing lines in this way more efficient.
8. Select the Home tab in the ribbon, and click the Line tool in the Draw panel. Click two points, and draw another line. This time, right-click quickly to terminate the Line command.

9. Right-click again to repeat the last command, and then click two points on the canvas. Next, slowly right-click (holding down the right mouse button for longer than 250 milliseconds, to be precise), and you’ll see the context menu shown in Figure 2.10. Left-click on the word Enter from this menu to complete the Line command.
Drawing Rectangles

Line segments are treated as individual objects, whereas the four line segments comprising a rectangle are treated as a single entity. Although rectangles can obviously be drawn with the Line command, specialized commands such as RECTANGLE are more efficient for constructing specific shapes, and they offer more options. Let’s experiment now with this feature.

1. Click the Rectangle tool in the Draw panel, and then click two opposite corner points on the canvas. The command automatically terminates when the rectangle is drawn.

2. Press Enter to repeat the last command. This time pay attention to the prompts in the Command window:

   Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:

   You have the opportunity to use any of the options listed in the square brackets before you even begin drawing the rectangle. However, in this case, you will use the default option, which comes before the word or.

3. Click the first corner point in the document window. A new prompt appears:

   Specify other corner point or [Area/Dimensions/Rotation]:

   At this point a new command prompt shows another default option before the word or as well as a few options in square brackets. You will again take the default option in this prompt, which is to specify the other corner point.

4. Click the other corner point, and the rectangle is drawn. In addition, the command is automatically terminated.

5. Type RECTANG (the command alias for the RECTANGLE command), and press the spacebar. Type F, and press Enter to execute the Fillet option. The command prompt reads as follows:

   Specify fillet radius for rectangles <0.0000>:

6. Type 2” (or 5 for metric), and press Enter. Units are drawing-specific, so you must use the UNITS command and select Architectural to input feet or inches if you are using a generic or metric template.
7. Click two points to draw the rectangle. The result has filleted corners (see Figure 2.11).

![Rectangle drawn using its Fillet option](image)

**Figure 2.11** Rectangle drawn using its Fillet option

8. Draw another rectangle, and observe that it also has rounded corners. Some options such as the fillet radius are sticky; they stay the same until you change them. Zero out the Fillet option by pressing the spacebar, typing `F`, pressing Enter, typing `0`, and pressing Enter again. Click two points to draw a sharp-edged rectangle.

9. Save Ch2-A.dwg or Ch2-A-metric.dwg by clicking the Save button in the Quick Access toolbar.

---

**Drawing Recovery Manager**

Occasionally something goes wrong with AutoCAD and it crashes. The next time you launch AutoCAD, the Drawing Recovery Manager will automatically appear, allowing you to recover damaged drawings that were open (and possibly corrupted) when the program unexpectedly came to a halt.

---

**Canceling, Erasing, and Undoing**

Making mistakes in AutoCAD is entirely acceptable if you know how to cancel, erase, and/or undo what you’ve done wrong. The following exercise will show you how to do all three:

1. Type `L`, and press Enter. Click two points on the canvas, and then press the Esc key; the LINE command is terminated but the single segment you just created remains. The Esc key will get you out of any running command or dialog box.
2. Type E, and press the spacebar. Click the line created in step 1, and then right-click; the segment is erased.

3. Click the Line tool in the Draw panel, click four points on the canvas (making three segments), and then right-click to finish the LINE command.

4. Click each of the segments, one at a time. Blue grips appear on the lines’ endpoints and midpoints (see Figure 2.12). Grips are used for editing, and you’ll learn more about them in Chapter 4, “Editing Entities.” In the meantime, it’s helpful to know that if you press the Delete key, the lines are gone.

![Figure 2.12 Selecting lines before deleting them](image)

5. Click the Undo arrow on the Quick Access toolbar (see Figure 2.13). The lines you deleted in step 4 reappear.

![Figure 2.13 Undo and Redo](image)

6. Click the Redo button, and the lines disappear again.

7. Undo again and, without issuing any command, click two points around the same three lines to create a selection window completely surrounding them. Press the Delete key to erase the selected objects.

8. Click the Undo button’s menu arrow. A list of all the commands you’ve issued in this session appears. Select the bottom item in the list to undo all the way back to the moment when you opened Ch2-A.dwg or Ch2-A-metric.dwg.
Using Coordinate Systems

AutoCAD uses the same Euclidean space you learned about in Geometry class—but don’t panic, I don’t expect you to remember any theorems! You can draw objects in Euclidean space using the following coordinate systems: Cartesian, polar, cylindrical, and spherical. (The last two are rarely used, so they won’t be covered in this book.)

Cartesian coordinates are useful for drawing rectangles with specific length and width measurements. Polar coordinates are used most often for drawing lines with specific lengths and angles, with respect to horizontal. Once you learn coordinate system syntax, you can use the systems interchangeably to draw accurately in any context.

In the Cartesian system, every point is defined by three values, expressed in terms of distances along the x-, y-, and z-axes. In two-dimensional drawings, the z-coordinate value of all objects is 0, so objects are expressed solely in terms of x- and y-coordinates (see Figure 2.14).

![Figure 2.14 Cartesian two-dimensional coordinates](image)

Using Absolute Coordinates

Coordinates can be absolute or relative, no matter which coordinate system is used. Let’s first focus on drawing a line using absolute coordinates.

1. If it’s not already open, open Ch2-A.dwg or Ch2-A-metric.dwg.
2. Click the Line tool on the Draw panel. The prompt in the Command window reads:

Specify first point:

Type 0,0 and press Enter. The origin point of Euclidean space has coordinates 0 in x and 0 in y, which is written as 0,0.

3. Now the prompt in the Command window reads:

Specify next point or [Undo]:

Type 3’,0 (or 90,0 in metric), and press Enter. Right-click to finish the LINE command. You drew a line measuring 3’ (or 90 for metric) horizontally along the x-axis.

Using Relative Coordinates

Calculating where every object is in relation to the origin point (which is what absolute coordinates require) would be far too cumbersome in practice. Therefore, relative coordinates are used more frequently. Let’s explore how to use them:

1. Click the Line tool on the Draw panel. Click an arbitrary point in the middle of the living room. The coordinates of the point you clicked are unknown; thankfully, you won’t ever need to find out what they are.

2. Type @3’,0 (or @90,0 in metric), and press Enter twice. Another 3’ (or 90 for metric) line has now been drawn horizontally. The @ symbol tells AutoCAD to consider the previous point as the origin point, relatively speaking.

3. Press Enter to repeat the last command. You’ll see this prompt:

Specify first point:

4. Right-click in the drawing canvas, and hold (for longer than 250 milliseconds) to open the context menu. Select the first coordinate value from the Recent Input menu (see Figure 2.15). You will use the last point entered as the first point in a new line. A rubberband connects the right end of the horizontal line to the cursor.

5. Type @0,6’ (or @0,180 in metric), and press Enter. A line measuring 6’ (or 1.8m) is drawn vertically along the y-axis.

6. Type @-3’,0 (or @-90,0 in metric), and press Enter. Type @0,-6’ (or @0,-180 in metric), and press Enter twice to complete a rectangle.
Using Coordinate Systems

**FIGURE 2.15** Drawing a new line from the end of the previous line

7. Click the Erase tool on the Modify panel (of the Home tab); select all four lines you just drew and right-click.

8. It’s very efficient to use RECTANGLE with Cartesian coordinates. Click the Rectangle tool on the Draw panel, and then click an arbitrary point at the bottom of the living room. The prompt reads:

   Specify other corner point or [Area/Dimensions/Rotation]:

9. Type @3’,6’ (or @90,180 in metric), and press Enter. The same rectangle that you more laboriously drew with lines is already done.

Using Polar Coordinates

Polar coordinates are another useful way of measuring Euclidean space. In polar coordinates, points are located using two measurements: the distance from the origin point and the angle from zero degrees (see Figure 2.16). East is the default direction of zero degrees.

By default, zero degrees is toward the East, or right side of the canvas. In addition, positive angles are typically measured counterclockwise from East. These defaults can be set in the UNITS command.

**FIGURE 2.16** Polar coordinates
Let’s explore how to use polar coordinates:

1. Click the Line tool on the Draw panel. Click an arbitrary first point in the living room, and then type $@3^\circ<45^\circ$ (or $@90^\circ<45^\circ$ in metric) and press Enter to end the LINE command. You have drawn another 3’ (or 90 for metric) line using relative polar coordinates.

2. Press Enter to repeat the last command. Click an arbitrary first point, move the cursor up and to the left, type 3 (or 90 for metric), and press Enter twice. A 3’ (or 90 for metric) line is drawn at an arbitrary angle.

### Specifying Angles with the Cursor

*Direct distance entry* is the relative method of using the cursor to determine an angle, rather than typing in a specific number of degrees following the $<$ symbol. Direct distance entry is most efficiently used with Ortho and/or Polar modes, which you’ll learn about in Chapter 3.

3. Press L, and then press the spacebar. Click an arbitrary first point, type $@4^\circ<180^\circ$ (or $@120^\circ<180^\circ$ in metric), and press Enter. The line is drawn to the left from the first point because 180 degrees is the same direction as angle zero but leads in the opposite direction.

4. Type $@3^\circ<-90^\circ$ (or $@90^\circ<-90^\circ$ in metric), and press Enter. Negative angles are measured clockwise from angle zero by default. Press C and then Enter to close the 3:4:5 triangle you’ve just drawn.

5. Type UCSICON, and press Enter. *UCS* stands for *user coordinate system*. You, the user, can change the coordinate system’s orientation. Type on, and press Enter. An icon indicating the directions of the positive x- and y-axes is displayed in the lower-left corner of the canvas (see Figure 2.17).

![Figure 2.17](image-url)
6. Type **UCS**, and press Enter. The prompt in the Command window reads as follows:

```
Specify origin of UCS or [Face/NAmed/Object/Previous/View/World/X/Y/Z/ZAxis] <World>:
```

There is much you can do with the UCS, but here you will simply rotate the UCS about its z-axis (the axis coming out of the screen). Type **Z**, and press Enter.

7. Type **90**, and press Enter to rotate the coordinate system. Observe that the UCS icon has changed to reflect the new orientation (see Figure 2.18).

![FIGURE 2.18](image)

**FIGURE 2.18**
Rotating the UCS about its z-axis

8. Type **PLAN**, and press Enter. The prompt in the Command window reads:

```
Enter an option [Current ucs/Ucs/World] <Current>:
```

The option in the angled brackets, `<Current>`, is what you want, so press Enter to make this selection. The house is reoriented with respect to the current UCS (see Figure 2.19). Notice that the ViewCube’s compass directions are rotated (North is now to the right).

---

**Rotating the Plan to Match the UCS**

User coordinate systems are usually associated with 3D modeling, but there is one transformation especially useful for 2D drafting: rotation about the z-axis. If you are drawing a building wing or mechanical part that is at an angle with respect to horizontal (especially when the angle isn’t an increment of 90 degrees), try rotating the UCS’s z-axis and then use the **PLAN** command to reorient the drawing to the new horizontal.
9. Click the Line tool on the Draw panel. Click an arbitrary first point in the living room, and then type $@3^\circ<45$ (or $@90^\circ<45$ in metric), and press Enter to end the LINE command. You have drawn another 3’ (or 90 for metric) line using relative polar coordinates (the same as step 1). However, this time the new line has a different orientation with respect to the original line and the rest of the house (see Figure 2.20).
10. To restore the current coordinate system to its original state, called the world coordinate system (WCS), type `UCS` and press Enter twice. Then type `PLAN`, and press Enter twice more. The plan is oriented to the WCS as it was initially. Observe that North is up again in the ViewCube.

## Drawing Circles, Arcs, and Polygons

Arcs are sections of circles. Polygons are regular figures made of straight segments such as a triangle, square, pentagon, or hexagon. A polygon with a large number of segments may look like a circle but is fundamentally different.

There are many options for creating circles, arcs, and polygons. AutoCAD provides these options to make it easier to create accurate shapes based on all the types of geometric situations that typically arise in drawings.

### Creating Circles

Let’s draw some circles on the kitchen stove to represent the burners:

1. Zoom into the stove in the kitchen. Two of the burner circles are missing, and you will draw them.

2. On the Home tab, take a look at the Layer drop-down menu in the Layers panel, and observe that Furniture is the current layer (because you see its name without having to open the drop-down). Open the Layer drop-down menu, and select Equipment as the current layer (see Figure 2.21).

3. You will use preexisting points as guides in drawing the burners. However, the points are difficult to see right now because they are represented as single pixels. Expand the Utilities panel on the Home tab, and select Point Style. In the Point Style dialog box, select the X icon and click OK (see Figure 2.22).

4. Click the Circle tool on the Draw panel. Before you click a center point, hold down Shift and right-click to open the Object Snap context menu (see Figure 2.23).
FIGURE 2.21  Making the Equipment layer current

FIGURE 2.22  Changing the point style so that points are more visible
5. Select Node from the context menu, and then click point A, as shown in Figure 2.24. The prompt in the Command window reads:

Specify radius of circle or [Diameter] <0'-0'":

![Figure 2.23: Object Snap context menu](image)

![Figure 2.24: Drawing a circle by locating its center using node snap](image)
Type 3” (or 8 in metric), and press Enter to create a circle with a radius of 3” (or 8 for metric). Note that typing the inch symbol is not necessary. Never type m, cm, or mm to represent metric units.

6. Right-click to repeat the last command. The prompt in the Command window reads:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

Type 2P to indicate the two-point option, and press Enter. Hold down Shift, and right-click to open the Object Snap context menu. Select Node, and then click point B, as shown in Figure 2.24.

7. Hold Shift again, right-click, and choose Node. Click point C, as shown in Figure 2.24, and the CIRCLE command is completed.

8. Click the arrow under the Circle tool in the Draw panel, and select 3-Point. Shift+right-click, and select Tangent. Click the circle you drew in the previous step.

9. Hold Shift, right-click again, and type G. Notice that this letter is underlined in the word Tangent in the context menu (refer to Figure 2.23). Click the circle on the bottom left.

10. Type TAN, press Enter to invoke the Tangent object snap, and click the circle on the lower right. You can type the first three letters of any object snap as an alternative to using the context menu. AutoCAD draws a circle precisely tangent to the three others (see Figure 2.25).
11. Erase the three-point objects and the last circle you drew to leave the four burners of the stove.

Creating Arcs

Arcs have more options than circles because of the complexities of the geometric situations in which arcs can be drawn. In the next set of steps, you will use one such arc option to draw a door swing:

1. Zoom into the bathroom. The bathroom door needs an arc to represent the way it swings.

2. Select Doors from the Layer drop-down menu in the Layers panel.

3. Click the Arc tool’s drop-down flyout menu in the Draw panel, which is indicated by the arrow under the word Arc. Select Center, Start, End. This is the sequence in which information must be entered.

4. Type INT, press Enter to invoke the Intersection object snap, and click the center point A shown in Figure 2.26.

![Figure 2.26](image)
5. Hold Shift and right-click. Select Endpoint from the context menu, and click the start point B (shown in Figure 2.26).

6. Hold Shift and right-click, type **END**, and click the arc endpoint C (shown in Figure 2.26). The arc appears, and the command is completed.

## Controlling Arc and Circle Smoothness

Arcs and circles are defined with perfect curvature in AutoCAD, but sometimes they appear blocky on screen. The system variable **VIEWRES** controls how smoothly arcs and circles are drawn on screen. Adjust this on the View tab under the Visual Style panel’s expansion menu. Set the resolution to the maximum **VIEWRES** value by typing **VIEWRES**, pressing Enter twice, typing **20000**, and pressing Enter again. Type **REGEN**, and press Enter to make this change take effect on screen.

## Drawing Polygons

When you want to draw triangles, squares, pentagons, or any figure having equally sized edges, use the **POLYGON** command. You can draw these shapes inside or outside a circle, or specify the edge length, as shown in the following steps:

1. Select the Home tab if it’s not already active. Make the Furniture layer current by selecting it from the Layer drop-down menu in the Layers panel.

2. Zoom into the living room.

3. Click the Rectangle tool’s drop-down flyout, and select the Polygon tool. The prompt in the Command window reads:

   ![Prompt](image)

   Enter number of sides <5>:

4. Type **4**, and press Enter to draw a square.

5. The command prompt now reads:

   Specify center of polygon or [Edge]:

   ![Prompt](image)
Type `E`, and press Enter to specify an edge length and direction. Click a point somewhere in the living room as the first endpoint of the edge, and type `@2<0` (or `@60<0` in metric) to specify the second endpoint of the edge relative to the first one, using polar coordinates in this case. A `2'` (or 60 for metric) square appears.

6. Type `POL`, and observe that, as you type, the AutoComplete menu appears above the command line suggesting commands and system variables (see Figure 2.27). Press the down-arrow key until POLYGON is highlighted, and then press Enter.

7. Type `6`, and press Enter to draw a hexagon. Click a point in the living room where you want to center the hexagon. The prompt now reads:

   Enter an option [Inscribed in circle/ Circumscribed about circle] <I>:

8. Press Enter to accept the default Inscribed In Circle option.

9. Type `1'` (or `30` in metric) as the radius of the circle and press Enter. A hexagon fitting inside a `1'` (or `30` for metric) radius circle appears.

**Certification Objective**

AutoComplete has been enhanced in AutoCAD 2014 with mid-string search functionality so you see all terms containing the string of letters you type.

---

**Filleting and Chamfering Lines**

Fillet and Chamfer are tools that create transitions between objects. *Fillet* creates arcs and *Chamfer* creates lines. Fillet is most commonly used for a purpose for which it probably wasn't designed—joining separate lines so that they intersect at their endpoints, without creating arcs at all.
Joining Nonparallel Lines

Fillet and Chamfer can be used to join lines that are crossing as well as lines that don’t meet. Chamfer doesn’t work on parallel lines at all, but Fillet will create a half circle connecting the endpoints of parallel lines, regardless of the fillet radius. Let’s explore the FILLET and CHAMFER commands:

1. Draw two lines. It doesn’t matter what size they are or what angle is between them, as long as the lines aren’t parallel.

2. Press the F12 key to toggle dynamic input on, an optional mode that displays command-line options on the canvas. Position the cursor on the canvas, and type CHA, the command alias for the CHAMFER command, and the AutoComplete window appears on the canvas rather than in the Command window.

3. Press Enter, and then press the down-arrow key to expand the command’s options on screen.

4. Press the down-arrow key three more times, and press Enter to select the Distance option in the Dynamic Input display (see Figure 2.28). Type 1’ (or 30 for metric), and press Enter twice to input equal first and second distances which are 1’ (or 30 for metric) each.

5. Click one line and then hover the cursor over the second line; you’ll see a preview of the chamfer that will be created. Click the second line to perform the chamfer and complete the command. (The chamfer is shown in the middle of Figure 2.29.)
6. Draw two more noncrossing and nonparallel lines.

7. Type **F**, and press Enter to execute the FILLET command. Press the down-arrow key, and choose Radius from the Dynamic Input display. Type **1** (or **30** for metric), and press Enter.

8. Click the first line, and then hover the cursor over the second line; the fillet preview shows on screen. Click the second line to commit to that particular radius. (This fillet is shown at the right of Figure 2.29.)

**Joining Crossed Lines**

When lines cross, there are multiple fillet and chamfer possibilities on different sides of the intersection. In the case of crossing lines, you must select the lines on the portions that you want to keep, as shown in these steps:

1. Draw two lines that cross.

2. Type **F**, and press Enter. Press the down arrow to access the Dynamic Input display, and select Radius. Type **0**, and press Enter. Now Fillet will not create an arc at all.

3. Click the points A and B, as shown in Figure 2.30. The lines are joined at their endpoints, and the remaining portions of the lines beyond their intersection point are trimmed away.
The Essentials and Beyond

This chapter covered the mechanics of drawing many basic object types, including lines, circles, arcs, and polygons. You learned how to navigate 2D drawings in a variety of ways. By learning how to cancel, erase, and undo, you won’t be afraid to make mistakes in AutoCAD. In addition, you explored how coordinate systems make accurate drawing possible. Finally, you altered existing lines with Fillet and Chamfer, and learned how to join lines by using a zero fillet radius.

Additional Exercise

- Explore the Donut and Solid tools on your own. Unlike most AutoCAD drawing tools, these older commands produce objects that have twodimensional solidity. Refer to Help in AutoCAD if you need further information.
CHAPTER 3

Using Drawing Aids

The drawing aids in the AutoCAD® program are like the triangles, compasses, and engineering scales of traditional drafting. Drawing aids are essential modes and methods of entering data that, once mastered, allow you to create measured drawings with ease. I highly recommend learning all of the drawing aids, because they will make you a more productive draftsper- son. Most drawing aids can be toggled on or off from the application status bar. Additional settings and dialog boxes are accessible by right-clicking the individual status bar toggles.

- Grid and Snap
- Ortho and Polar Tracking
- PolarSnap
- Running object snaps
- From snap
- Object snap tracking

Grid and Snap

The most basic drawing aid, Grid, makes the canvas in AutoCAD look like graph paper. You can adjust the grid's measured size and the spacing of its major lines to simulate many types of graph paper.

Snap constrains your ability to draw objects so that they automatically start and end precisely at grid intersections. Grid and Snap are most helpful when used together so that you can draw objects that snap to the grid. Figure 3.1 shows some of the status bar toggles that you’ll be learning about in this chapter.
In the following steps, you will experiment with Grid and Snap by drawing lines using these aids:

1. Click the New button on the Quick Access toolbar.

2. Choose the acad.dwt Imperial template (or acadiso.dwt metric template) from the Select Template dialog box and click Open.

3. Right-click the Grid Display toggle on the status bar, and choose Settings from the context menu. Change Grid X spacing to 1” (or 10 mm), and press Tab; Grid Y spacing updates with the same value. Set Major Line Every to 12 for Imperial (or 10 for metric) so that you’ll see darker grid lines every foot. Notice that Snap spacing is set to 1/2” (or 10 mm) by default. Select Snap On, and verify that the Grid Snap radio button is selected in the Snap Type area (see Figure 3.2). Click OK.
4. Click the Line tool in the Draw panel on the ribbon’s Home tab. Click the first point near the lower-left corner of the canvas at the intersection of major grid lines (darker lines). Click the second point 2’ (or 609 mm) above the first point by clicking the second intersection (or sixth intersection in metric) of major grid lines. Right-click to end the LINE command. It’s very difficult to see the line because the grid obscures it.

5. Click the Show/Hide Lineweight icon in the status bar so that the button is highlighted in blue. It’s difficult to see the line because the default lineweight display is too thin.

6. Right-click the Show/Hide Lineweight icon, and choose Settings from the context menu. Open the Default drop-down list, select 0.016” (or 0.40 mm) (see Figure 3.3), and click OK. The line you drew in step 4 is displayed thicker so that it’s more visible against the grid.

7. Type L, and press Enter twice to continue drawing from the last point clicked. Toggle Grid Display off and Dynamic Input on in the status bar. Move the cursor horizontally to the right from the point at which the rubberband is anchored. Notice that 1/2” (or 10 mm) increments are all that show up on screen; this is due to Snap. Snap can be used independently of the grid; the grid is merely a visual drawing aid. Click on the drawing canvas when the dynamic input value reads 2’-0” (or 600 mm), as shown in Figure 3.4. Leave the file open for work in the next section.

F I G U R E  3 . 3  Adjusting the default lineweight settings

You’ll learn how to control lineweight with layers in Chapter 6, “Controlling Object Visibility and Appearance.”
FIGURE 3.4 Using Snap with Dynamic Input to gauge distances without typing

**Transparent Commands**

Status bar buttons can be toggled on or off and their settings adjusted while another command is running. Commands that operate while another command is running are called *transparent commands*. Typing a single quote before a command forces it to be run transparently. For example, while drawing a line, type ‘z and press Enter. The ZOOM command is run transparently and, when it is done, the LINE command resumes. The following transcript shows this command sequence:

```
Command: l
LINE Specify first point: ’z
’ZOOM
>>Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: >>>Specify opposite corner:
Resuming LINE command.
Specify first point:
```

**Ortho and Polar Tracking**

Ortho mode aids in drawing *orthogonal* (horizontal or vertical) lines. Polar Tracking is more flexible than Ortho mode, with the ability to constrain lines to increments of a set angle. A list of common angles is included on Polar
Ortho and Polar Tracking

Tracking’s context menu, such as 45°, 30°, 22.5°, 10°, and so on. The traditional square and a set of triangles from traditional drafting are analogues to Ortho and Polar Tracking modes in AutoCAD.

Let’s try Ortho and Polar Tracking modes by drawing a series of line segments. You’ll use Ortho when the segments are 90° apart and Polar Tracking when the segments are drawn at other angles.

1. Type L, and press Enter twice to continue drawing from the last point.

2. Toggle off Snap mode by pressing the F9 key.

3. Toggle on Ortho mode by pressing the F8 key.

4. Move the cursor down from the last point, type 10–3/4” (or 240 in metric), and press Enter. Ortho mode constrains the line vertically and typing in an explicit value obviates the need for Snap (see Figure 3.5). You don’t have to use the comma from Cartesian coordinates or the angle symbol from polar coordinates with direct distance entry.

5. Toggle off Ortho mode by clicking its status bar button. Toggle on Polar Tracking by clicking the adjacent button on the right. Right-click the Polar Tracking button, and choose 45.00 from the context menu.

6. Move the cursor around, and observe that green dashed lines appear in eight locations around a circle (in 45° increments). Move the cursor to the right relative to the last point, type 2’ (or 600 in metric), and press Enter (see Figure 3.6). Press Esc to terminate the LINE command without deleting the last segment drawn.

When Polar Tracking is set to 90, it functions identically to Ortho mode.

The dash is a necessary separator between whole and fractional inches.
FIGURE 3.6 Drawing another line with Ortho mode and direct distance entry

7. Save your work as Ch3-B.dwg (or Ch3-B-metric.dwg).

Just like Ortho mode, Polar Tracking guarantees that the last line drawn was perfectly aligned to the set increment; you merely had to move the cursor in the general direction you wanted to direct the new line. Ortho and Polar Tracking save you from having to type in angles or coordinate values explicitly, or to even think about coordinate systems.

PolarSnap

*PolarSnap* includes a kind of snap that is customized for Polar Tracking. Instead of being tied to a spatial grid (as with Snap), PolarSnap is appropriately based on relative polar coordinates. As you’ll see in the steps that follow, PolarSnap is useful for drawing measured lines on angles other than horizontal or vertical.

1. If the file is not already open from the previous step, go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 3, download the file Ch3-B.dwg (or Ch3-B-metric.dwg), and open it.

2. Toggle on Snap by clicking its icon on the status bar. Right-click the same button, and choose Settings from the context menu.

3. Select the PolarSnap radio button in the Drafting Settings dialog box. Type 1” (or 10 in metric) in the Polar Distance text box (this dialog was shown back in Figure 3.2). Click OK.

4. Type L, and press Enter twice to continue drawing from the last point.

5. Move the cursor down at a 45° angle from East, and observe the Snap values that appear with Dynamic Input on screen. Click when the
value is 6” (or 150 mm) (see Figure 3.7). You avoided having to type anything with Polar Tracking and PolarSnap.

**FIGURE 3.7** Drawing a line using Polar Tracking and PolarSnap

6. Move the cursor down, and click to draw a line when the value reads 1’ (or 300 mm). Right-click to end the LINE command.

7. Press the spacebar to repeat the LINE command. Hold down Shift, and right-click to access the Snap context menu. Select Endpoint in the menu, and click the lower endpoint of the first line you drew in this exercise.

8. Toggle off Snap mode by clicking its icon on the status bar, thus disabling PolarSnap.

9. Move the cursor horizontally to the right until it overshoots the last line drawn in step 5. Click to draw the line without worrying about its length (see Figure 3.8). Right-click to complete the command.

**FIGURE 3.8** Drawing a horizontal line that overshoots the vertical line
10. Type F (for Fillet), and press Enter. Verify that Radius is set to 0 in the Command window, and then click the vertical and horizontal lines on the portions of the lines that you want to keep (marked A and B in Figure 3.9). The drawn shape forms a closed loop.

![Figure 3.9 Filleting with a zero radius to form a corner](image)

11. Save as Ch3-C.dwg (or Ch3-C-metric.dwg), which is available for download among the files at the book's web page.

**Running Object Snaps**

The lines you have drawn thus far are all precisely connected because they were chained together as they were drawn. In other words, the last point of one segment was reused as the first point of the next segment. Aside from this special circumstance, lines must be connected using object snaps to ensure accuracy.

You learned to use the Object Snap context menu in Chapter 2, “Basic Drawing Skills,” and now you will use that as a jumping-off point to learn a far more efficient method called **running object snap**. As you will see in the steps that follow, with running object snaps, frequently used object snaps can be turned on continuously. That way, you don’t have to invoke them explicitly every time you want to use object snaps.

1. If the file is not already open from performing the previous step, go to the book’s download page at [www.sybex.com/go/autocad2014essentials](http://www.sybex.com/go/autocad2014essentials), browse to Chapter 3, download the file Ch3-C.dwg (or Ch3-C-metric.dwg), and open it.

2. Using Polar Tracking, but without invoking Object Snap, draw a line using points A to B in Figure 3.10 as a guide. Click each point as
accurately as you can because I want you to see that you can’t make it perfect without using Object Snap.

3. Press Z and then Enter. Click two points to define a tightly cropped zoom window around point A. Zoom in again if necessary until you can see that the endpoint of the line you just drew is not on the horizontal line (see Figure 3.11). No matter how carefully you clicked point A in the previous step, the line you drew will not be on the edge (it will either fall short of it or overshoot it).

4. Select Zoom Previous from the Navigation bar’s Zoom menu. Click Zoom Previous again if necessary to return to the original view.

5. Click the line drawn in step 3, and press the Delete key.
6. Toggle on Object Snap on the status bar. Right-click the same icon, and choose Settings from the context menu. Click the Clear All button, and then select Endpoint, Midpoint, and Perpendicular (see Figure 3.12). Click OK.

7. Toggle off Polar Tracking and Dynamic Input modes on the status bar. Click the Line tool on the Draw panel. Move the cursor close to point A in Figure 3.13, and wait for the green endpoint marker to appear. When it does, click to snap the first point of your line precisely to this point.
8. Move the cursor down to point B, and wait until the green perpendicular marker appears. When it does, click the drawing canvas to select the second point. Press Esc to end the command. This line is connected precisely at both ends because Object Snap was used.

9. Zoom into point A or B in Figure 3.14, and verify that the lines are connected perfectly. Click Zoom Previous in the Navigation bar to return to the initial overall view.

10. Type L, and press Enter. Hold Shift down, right-click to open the Object Snap context menu, and choose Nearest. Object snaps invoked from the context menu override any running object snaps. Click point A, shown in Figure 3.14. Nearest ensures that the new line is attached somewhere along the edge of the horizontal line.

11. Move the cursor close to point B, as shown in Figure 3.14, and click when the perpendicular marker appears. Press Esc to end the LINE command.

12. Save your work as Ch3-D.dwg (or Ch3-D-metric.dwg).

---

**From Snap**

Rather than snapping to an existing geometrical feature (such as an endpoint, midpoint, intersection, and so on), how do you snap a set distance and direction from one? Answer: Use the From snap, as shown in the following steps:

1. If Ch3-D.dwg (or Ch3-D-metric.dwg) is not still open from the previous section, go to the book’s web page and open the document from the Chapter 3 file.
2. Type L and press Enter. Hold Shift and right-click to open the Object Snap context menu. Select From in the context menu.

3. Click point A shown in Figure 3.15. This is the point from which you will specify a displacement. Type @6"<0 (or @150<0 for metric) to specify the displacement to the first point of the line and press Enter.

4. Move the cursor to point B, and wait for the running perpendicular snap marker to appear. When it does, click to specify the second point of the line. Press Esc to end the **LINE** command. You’ve drawn a line exactly 6” (or 150 mm) over from the corner.

5. Select the line you just drew, and press the Delete key.

6. Save your work as Ch3-E.dwg (or Ch3-E-metric.dwg).

**Object Snap Tracking**

Object snap tracking is for situations where you want to snap to a point that has a geometric relationship with two or more snap points. As you’ll see in the following steps, using object snap tracking saves time when compared with drawing temporary construction lines that must later be deleted.

1. If Ch3-E.dwg (or Ch3-E-metric.dwg) is no longer open from the previous section, go to the book’s web page and open the document from the Chapter 3 folder.
2. Click the Circle tool on the Draw panel.

3. Toggle on Object Snap Tracking by clicking its icon on the status bar. Verify that Ortho mode is on by looking at the status bar. (If it isn’t, press F8.)

4. Move the cursor over point A, as shown in Figure 3.16. When the running midpoint snap marker appears, move the cursor horizontally to the right to establish the first tracking line. Do not click yet.

5. Move the cursor over point B in Figure 3.16, and wait for the Midpoint marker to appear. Move the cursor down vertically to establish the second tracking line. Again, do not click yet.

6. Move the cursor down until both tracking lines intersect. When they do, click to set the center point of the circle. Type 9 (or 220 for metric), and press Enter to create a circle with a radius of 9 in. (or 220 mm).

7. Click the Rectangle tool on the Draw panel. Move the cursor over the endpoint marked A in Figure 3.17 and, without clicking, move the cursor down to establish the first tracking line.

8. Move the cursor to point B in Figure 3.17 to track another endpoint. Move the cursor horizontally back to the intersection with the first tracking line, and click to establish the first corner of the rectangle (point C).

9. Type @1', -6 (or @288', -160 for metric), and press Enter. The rectangle and drawing is complete (see Figure 3.18).
10. Toggle off Show/Hide Lineweight.

11. Your drawing should now resemble Ch3-F.dwg (or Ch3-F-metric.dwg), which is available for download among the book’s companion files at www.sybex.com/go/autocad2014essentials.
THE ESSENTIALS AND BEYOND

You have learned how to draw accurately using a variety of drawing aids, including Grid and Snap, Ortho mode and Polar Tracking, PolarSnap, running object snaps, From snap, and object snap tracking. Each of these aids will become second nature to you as you continue practicing drawing in AutoCAD. In time, you will know which drawing aid most efficiently fits each geometric situation you encounter.

ADDITIONAL EXERCISE

- Draw the following diagram to the given dimensions. You will need to employ a variety of drawing aids learned in this chapter to draw the figure accurately.
CHAPTER 4

Editing Entities

*Drawing in the AutoCAD®* program is not just about creating lines, rectangles, circles, and other shapes. Most of your time will be spent editing entities. Although AutoCAD provides the basic tools for transforming shapes, such as Move, Copy, Rotate, and Scale, more complex editing tools are also available, such as Array, Trim, Extend, Lengthen, Stretch, Offset, Mirror, Break, Join, and Overkill.

- Creating selection sets
- Move and Copy
- Rotate and Scale
- Working with arrays
- Trim and Extend
- Lengthen and Stretch
- Offset and Mirror
- Grip editing

**Creating Selection Sets**

All editing commands operate on one or more drawing entities. In complex drawings you have to plan how you will select only those entities you want to edit while leaving all other entities unaffected. You will learn a number of techniques for adding and removing entities from the *selection set*, which is the collection of entities your chosen editing command acts upon.
Creating a Selection Set at the Select Objects: Prompt

To edit objects, you must first select them. In complex drawings, selecting would be tedious if you had to click one object at a time. In the following steps, you will learn several efficient selection methods that you can use at any Select objects: prompt, which appears in every editing command.

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 4, get the file Ch4-A.dwg (or Ch4-A-metric.dwg)—a fictitious office building—and open it (see Figure 4.1).

2. Zoom into Stair A in the building core.
3. Click the Erase tool in the Modify panel on the Home tab of the ribbon. The prompt in the Command window reads as follows:

Select objects:

This is the same way almost every command begins—with the opportunity to create a selection set.

4. Click point A and then B, as shown in Figure 4.2. Observe that a transparent implied window appears between these points. The objects that are selected are only those completely contained within the borders of the blue window. This particular selection includes the stair arrows, handrails, and three lines representing stair treads near the break lines.

5. Type R (for Remove), and press Enter. The command prompt reads as follows:

Remove objects:

6. Click point A and then B, as shown in Figure 4.3. When you click the first point on the right (A) and move the cursor to the left (at B), a transparent green crossing window appears between the points. Whatever the green window crosses is selected. The crossing selection removes the handrail and two of the stair treads because the selection was made at the Remove objects: prompt.
7. Click point A and then B, as shown in Figure 4.4. This implied window selects the short line segment trapped in the break line and removes it from the selection set.

8. Type A (for Add), and press Enter. The command prompt again reads as follows:

   Select objects:

9. Click each of the break lines to add them to the selection set. All of the break line segments are selected in two clicks because the break lines are polylines.
10. Hold Shift, and click the break lines again. They are removed from the selection set without being at the Remove objects: prompt.

11. Press Esc to cancel the ERASE command.

Creating a Selection Set Before Deciding on a Command

In addition to creating a selection set at any Select objects: prompt, you can create a selection set first and then decide which command to use afterward. (Additional dynamic input prompts are available on screen when you select objects first.) Let’s explore these additional selection methods:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-A.dwg (or Ch4-A-metric.dwg), and open it.

2. Toggle on Dynamic Input mode in the status bar.

3. Click point A, as shown in Figure 4.5. Press the down-arrow key to expand the dynamic input menu on screen. Select WPolygon.

4. Click points B through H, as shown in Figure 4.6. The transparent blue polygon you are drawing functions the same as an implied rectangular window; the difference is the polygonal window offers more flexibility because you can shape it. Only those objects completely contained within the borders of the blue window will be selected.

FIGURE 4.5 Selecting WPolygon selection mode from the dynamic input menu

The related CPolygon option creates a polygonal crossing window, shown in transparent green. The Fence option allows you to draw a multisegmented line that selects whatever it crosses.
5. Press Enter to make the selection. Square blue dots appear on the selected objects—these are called grips, and you will learn to use them later in this chapter. Press Esc to deselect.

6. Toggle on Ortho mode in the status bar. Without being concerned with measurements or accuracy, draw a line under the word Stair, a circle around the letter A, and a rectangle around the entire section, in that order (see Figure 4.7).

7. Type SELECT, and press Enter. Select the circle and the line and press Enter. The SELECT command is used merely to make a selection. The grips for the circle and line appear; press Esc to deselect.

8. Click the Erase icon on the Modify panel. At the Select objects: prompt, type P (for Previous) and press Enter. The circle and line are selected because they comprise the set of objects that was selected previously. Press Enter again to delete these objects.
9. Press the spacebar to repeat the last command (ERASE). Type L (for Last), and press Enter. The rectangle is selected because it was the last object you created. There can only be one last object. Press Enter again to delete the rectangle.

10. Toggle on Selection Cycling in the status bar.

11. Click the dot at the end of the stair direction line (shown in Figure 4.8). This dot is at the confluence of the horizontal stair direction line and the vertical tread line. When Selection Cycling is on, you are presented with the Selection dialog box whenever your selection is ambiguous. Hover the cursor over the items in the list and each one’s grips are highlighted on the drawing canvas. Select the line in the list that highlights grips on the stair direction line as shown in Figure 4.8 and then press Esc.

12. Press Ctrl+W to toggle selection cycling off.

13. Select one of the vertical tread lines in Stair A by clicking on it. Right-click, and choose Select Similar from the context menu that appears. All lines on the same layer are selected; you might have to zoom out to see both stairs (see Figure 4.9). Other object types on the same layer remain unselected because they were not similar enough. Press Esc.
FIGURE 4.9 Selecting similar objects en masse

SELECTING SIMILAR OBJECTS

Type SELECTSIMILAR, press Enter, type SE, and press Enter again to open this command’s Settings dialog box. Here you can choose criteria to determine which object properties must match in order to be selected by this useful command: Color, Layer, Linetype, Linetype scale, Lineweight, Plot style, Object style, or Name.

Move and Copy

MOVE and COPY are the most commonly used commands in AutoCAD. As you’ll see in the following steps, they are very similar in that they both require a distance and a direction to indicate where you plan to displace the selected objects.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-A.dwg (or Ch4-A-metric.dwg), and open it.

2. Pan to the upper-right quadrant of the building, and zoom into the furniture grouping that needs to be filled in.

3. Click the chair that is not in front of a desk to select it. Position the cursor over the selected chair, but not over its grip. Drag the chair to move it closer to the upper desk, as shown in Figure 4.10.

4. To position the chair more precisely, click the Move tool in the Modify panel. Select the chair you just moved in the previous step and press Enter. The command prompt reads as follows:

Specify base point or [Displacement] <Displacement>: The disadvantage to moving by dragging is that the displacement is unmeasured, and you can’t use Object Snap to maintain accuracy.
5. Right-click the Object Snap toggle in the status bar, and choose Midpoint from the context menu if it is not already selected. Click the base point at the midpoint of the front of the chair (point A in Figure 4.11).

6. Click the second point, (B in Figure 4.11). The chair is moved precisely to the midpoint of the desk edge.

7. Press the spacebar to repeat MOVE. Type P, and press Enter twice to select the same chair again. Press Enter once more to accept the default option <Displacement>. In Displacement mode, the first point
is the origin point. Any coordinates you enter are relative to the origin, so typing the @ symbol is unnecessary. Type \textbf{4<180} (or \textbf{10<180} in metric) and press Enter.

8. Click the Copy tool in the Modify panel. Select the chair you just moved and press Enter. Select the midpoint of the desk (point B in Figure 4.11) as the base point, and then click the midpoint of the corresponding mirror image desk below in the same furniture group as the second point. Press Enter to end the \texttt{COPY} command.

9. Press the spacebar to repeat the previous command, select both desks and chairs with crossing windows, and press Enter. Select point A in Figure 4.12 as the base point and point B as the second point. Press Esc to end the command.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{figure4_12.png}
\caption{Copying multiple items}
\end{figure}

10. Pan over to the Conference room. To copy an array of chairs along the left wall, you will rotate the user coordinate system (UCS) to match the orientation of the wall. Type \texttt{UCS}, and press Enter. Select the Object option by typing \texttt{OB} and press Enter. Select the inner left wall line and watch as the crosshair cursor changes to match the angle of the wall (see Figure 4.13).

11. Type \texttt{CO} (for Copy), and press Enter. Select the chair that is against the left wall of the Conference room and press Enter. Click an arbitrary
base point by clicking in the empty space of the Conference room.
Toggle on Polar Tracking on the status bar if it is not already on.

**FIGURE 4.13**  Reorienting the UCS to an object

12. Move the cursor down along the direction of the wall, type **A** (for Array), and press Enter. The command prompt reads as follows:

   Enter number of items to array:

   Type **5**, and press Enter. Type **F** (for Fit), and press Enter. Move the cursor downward, and observe that five ghosted chairs appear. When the spacing looks right, click in the document window to complete the array and press Enter. Figure 4.14 shows the result.

13. Type **UCS**, and press Enter twice to accept the default option of World. The crosshair cursor returns to its default orientation.

14. Save your work as Ch4-B.dwg (or Ch4-B-metric.dwg).
FIGURE 4.14  Copying chairs in an array

**Rotate and Scale**

The **ROTATE** and **SCALE** commands are obviously essential to drawing; each requires a base point to indicate the center from which objects are transformed. Numerically speaking, you typically rotate by degrees or scale by percentages about base points. On the other hand, you can avoid using numbers entirely by choosing the Reference options, which let you rotate or scale selection sets in relation to other objects. Let’s rotate and scale objects.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-B.dwg (or Ch4-B-metric.dwg), and open it.

2. Navigate to Reception at the bottom of the floor plan. Click the Rotate button in the Modify panel, select the upper chair, and press Enter. The command line reads as follows:

   Specify base point:
Click a point in the center of the chair; you don’t need to snap this point because an approximation is good enough at this point.

3. Toggle off Polar Tracking (and Ortho if it is on) in the status bar. Move the cursor around the point, and observe that a rubberband line connects the base point to your cursor and a ghosted image of the chair is superimposed over the original chair representation. Move the cursor until the rubberband aligns more or less perpendicularly to the wall behind the chair (see Figure 4.15) and click.

![Figure 4.15 Rotating a chair by visually estimating the angle](image)

4. Click the chair that you just rotated to select it without issuing an explicit command. Hold the Ctrl key, and repeatedly press the arrow keys to nudge the selected object a few pixels at a time. Nudge the chair so that it is a similar distance from the wall and the round table as compared to the other armchair in Reception. Press Esc to deselect all.

5. Zoom out and focus on the upper-left quadrant of the building. Type `CO` (for Copy), and press Enter. Select the furniture group shown in Figure 4.16, and press Enter. Select midpoint A as the base point, and select midpoint B as the second point. Press Esc to end the command.

6. Type `RO` (for Rotate), and press Enter. Select the furniture group you just copied and press Enter. Select the same midpoint where the furniture group was attached to the midpoint of the shell window wall as the base point of the rotation. The command line reads as follows:

   Specify rotation angle or [Copy Reference] <0.00>:
Type R (for Reference), and press Enter. Instead of specifying the reference angle with a number, you will determine the angle interactively. Type @ and press Enter to input the base point of the rotation as the base point of the reference angle.

7. Click endpoints A and B as shown in Figure 4.17 to specify the second point of the reference angle and the new angle. The furniture group rotates so that it is parallel and centered on the window wall.

8. Pan over to the upper-right quadrant of the building, and zoom in on the oversized round table. Click the Scale icon on the Modify panel, select the circle representing the table, and press Enter. The command line reads as follows:

   Specify base point:
Snap to the center of the circle. Type .5, and press Enter to scale the circle down to 50 percent of its original size (see Figure 4.18).

**Figure 4.17** Rotating with the Reference option

**Figure 4.18** Scaling a circle from its center
9. Toggle on Polar Tracking on the status bar, and move the chairs closer to the table, both horizontally and vertically.

10. Save your work as Ch4-C.dwg (or Ch4-C-metric.dwg).

**Working with Arrays**

*Arrays* produce single associative objects, which you can edit at any time to alter the parameters of the array. You will learn how to create two types of associative arrays: rectangular and polar.

**Rectangular Arrays**

*Rectangular arrays* are arranged in a grid of rows (running horizontally) and columns (running vertically). Let’s create a rectangular array:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-C.dwg (or Ch4-C-metric.dwg), and open it.

2. Instead of trying to make a rectangular array at an oblique angle, it is easier to first rotate the user coordinate system. Type `UCS`, and press Enter. Type `OB` (for Object), and press Enter. Select the bottom-left edge of the table in the Small Conference room. The crosshair cursor rotates to match the orientation of the conference table.

3. Click the Rectangular Array tool on the Modify panel. Select both chairs on the sides of the conference table and press Enter.

4. Change Columns to 5 and Rows to 1 on the temporary Array Creation tab that appears on the ribbon. Type `2'-4”` in the Between text box in the Columns panel (see Figure 4.19). Depending on which side of the line you selected in the previous step, you might have to enter 1 Column and 5 Rows if the UCS is 180 degrees out of phase.

5. Select the Associative toggle in the Properties panel if it is not already blue. Click Close Array on the ribbon.

6. Select one of the new chairs, and observe that all the arrayed chairs are selected as a unit. Change the number of Columns to 4 and Between to `3'-6” (90 for metric) and the five chairs along each side of the table are replaced by four.
7. Type **UCS**, and press Enter twice to return to the world coordinate system.

8. Save your work as Ch4-D.dwg (or Ch4-D-metric.dwg).

**Polar Arrays**

*Polar arrays* are used for rotating and copying objects around a common central point. Let’s create a polar array:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-D.dwg (or Ch4-D-metric.dwg), and open it.

2. Navigate to the Conference room at the top of the plan (see Figure 4.20).
3. Type AR (for Array), and press Enter. Select the chair at the top of the round table, and press Enter.

4. The command prompt reads as follows:

   Enter array type [Rectangular Path Polar] <Rectangular>:

5. Type PO (for Polar), and press Enter.

6. Hold down Shift, and right-click to open the Object Snap context menu. Choose Center, and click the table’s center to set the center point of the array.

7. Type 12 in the Items text box on the ribbon. Toggle on Associative, Rotate Items, and Direction if they are not already on in the Properties panel (see Figure 4.21). Click Close Array.

8. The table is a bit too large. Click the circle to select the table. Click the circle’s top blue quadrant grip, and move the cursor down. Type 4’6” (or 146 in metric) to set a new radius. Press Enter and then Esc.
9. Click any one of the chairs to select the polar array. Hover the cursor over the base point grip, and choose Stretch Radius (see Figure 4.22). Type 5'9" (or 175 in metric); then press Enter and Esc. The chairs more closely wrap around the smaller table.

10. Save your work as Ch4-E.dwg (or Ch4-E-metric.dwg).

FIGURE 4.21 Creating a polar array

FIGURE 4.22 Editing a polar array with its grips
**DIVIDE and MEASURE**

The DIVIDE and MEASURE commands do not copy objects in a rectangular grid or around a center point as does the ARRAY command. Instead, these commands are used for arraying points. DIVIDE splits up a path into any number of evenly spaced points. MEASURE lays out points at a set distance, often leaving a remainder at the end of a path. You’ll use DIVIDE in Chapter 5, “Shaping Curves.”

---

**Trim and Extend**

The TRIM and EXTEND commands are opposites. You can invoke the opposite command while running either by holding down Shift. This method is especially helpful because TRIM and EXTEND are often used together, as you’ll see in this procedure:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-E.dwg (or Ch4-E-metric.dwg), and open it.

2. Navigate to Stair B in the building’s core.

3. Click the Extend tool on the Modify panel (it is nested under Trim). Select the inner line of the bottom core wall and press Enter. This line will be the boundary edge that you will extend the stair treads to meet.

4. Create a crossing window by clicking points A and B as shown in Figure 4.23. Four tread lines are extended. Click each remaining tread line, one at a time, to extend all the stair treads to the core wall. Press Enter to end the command.

5. Type TR (for Trim), and press Enter. Select the upper and lower handrail lines to act as cutting edges and press Enter. Make a crossing window in the center of the handrail to trim away all the treads that pass through the handrails, and press Enter.

6. Press Enter twice more to repeat the TRIM command, and select all edges as potential cutting edges. Then click the single tread line that
extends below the break line and press Enter. Stair B should now be the mirror image of Stair A.

7. Save your work as Ch4-F.dwg (or Ch4-F-metric.dwg).

---

![Figure 4.23](image)

**Lengthen and Stretch**

The *Lengthen* and *Stretch* commands are similar in how they can increase the length of objects. However, *Stretch* is the more flexible of the two, allowing you to reposition interconnected objects. Let’s lengthen a line and stretch a door within a wall:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-F.dwg (or Ch4-F-metric.dwg), and open it.

2. Navigate to the Copy Room. Notice that there is a problem with the copy machine by the door; the bottom line is drawn only halfway. Although you could use *Fillet* or *Extend* to fix it, type **LEN** (for Lengthen) and press Enter. The command prompt reads as follows:

   - Select an object or [DELta/Percent/Total/DYnamic]:
   - Type **P** (for Percent), and press Enter.
3. Type 200, and press Enter. Click the line segment on the right side to lengthen it toward the right. The copy machine is fixed!

4. Type S (for Stretch). The command prompt reads as follows:

Select objects to stretch by crossing-window or crossing-polygon...
Select objects:

Implied windows won’t work for STRETCH; only crossing windows or crossing polygons are acceptable. Click points A and B as shown in Figure 4.24 to select the objects to stretch and press Enter.

5. Using either Polar Tracking or Ortho mode, move the cursor down vertically, type 2’6” (or 75 for metric), and press Enter to specify the second point. The wall, door, and swing end up more or less centered on the wall.

6. Save your work as Ch4-G.dwg (or Ch4-G-metric.dwg).
Offset and Mirror

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-G.dwg (or Ch4-G-metric.dwg), and open it.

2. Click the Offset tool in the Modify panel. The command line reads as follows:

   Specify offset distance or [Through Erase Layer] <Through>:

   Type 4, and press Enter. Select the elliptical arc at the bottom edge of the Copy Room.

3. The command line asks you to specify a point to determine on which side of the selection to offset the new object. In this case, click anywhere above the elliptical arc and a new ellipse is created such that its curvature matches the original but is spaced 4 units away. Press Enter to exit the command.

4. Type F (for Fillet), press Enter, and click the new elliptical arc and the inner line of the adjacent vertical wall on the right. Press the space-bar to repeat the FILLET command, and click the elliptical arc and inner line of the adjacent vertical wall on the left. The intersections between the wall objects are cleaned up (see Figure 4.25).

5. Zoom into the furniture system that is missing two desks in the upper-right quadrant of the building. Click the Mirror tool in the Modify panel. Make crossing and individual line selections to select the desks and chairs shown in Figure 4.26, and press Enter. The command line reads as follows:

   Specify first point of mirror line:
Click point A, and then move the cursor up and click point B to draw the mirror line. Press Enter to end the command.
6. Press Enter to repeat the MIRROR command. Double-click the mouse wheel to zoom to the drawing extents. Select the furniture system you rotated with the Reference option in the upper-right building quadrant and press Enter. For the first point of the mirror line, type 0,0 and press Enter.

7. Toggle on Polar Tracking, move the cursor horizontally to the left—beyond the building—and click to specify a horizontal mirror line. Press Enter to complete the command, and decline to erase the source object. A copy of the furniture system appears symmetrically in the lower-left building quadrant (see Figure 4.27).

![Figure 4.27 Mirroring a furniture grouping](image)

8. Save your work as Ch4-H.dwg (or Ch4-H-metric.dwg).
Grip Editing

All objects have grips, the square blue symbols that appear in AutoCAD at significant points when objects are selected without issuing any command. Grips provide an alternative means of accessing a number of editing commands, including STRETCH, MOVE, ROTATE, SCALE, and MIRROR. Let’s explore grip editing:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 4, download the file Ch4-H.dwg (or Ch4-H-metric.dwg), and open it.

   In Reception, the sofa seating group is oriented horizontally, but this doesn’t respond to the geometry of the space.

2. Select the inner line of the window wall directly below the sofas, right-click, and choose Properties from the context menu. Make a note that the angle of this line is 173.77 degrees. Press Esc to deselect.

3. Click both sofas and the coffee table in between them to select all three. Single blue grips appear on the sofas because they are blocks (see Chapter 7, “Organizing Objects,” for more on blocks).

4. Click this grip in the center of the coffee table to activate it. The command prompt reads as follows:

   \texttt{ff STRETCH ff}
   \texttt{GRIP_STRETCH Specify stretch point or [Base point Copy Undo eXit]:}

   Press the spacebar. The command prompt changes to:

   \texttt{ff MOVE ff}
   \texttt{GRIP_MOVE Specify move point or [Base point Copy Undo eXit]}:

5. Press the spacebar again. The command prompt now says:

   \texttt{ff ROTATE ff}
   \texttt{GRIP_ROTATE Specify rotation angle or [Base point/Copy/Undo/Reference/eXit]}:
6. Type 'CAL to invoke the command-line calculator transparently. Type **173.77-180**, and press Enter to have AutoCAD calculate the negative rotation angle for you (-6.23 degrees in this case). Remember that negative angles rotate objects clockwise by default. The seating group rotates to match the orientation of the window wall that it is in front of.

7. Press Esc to deselect all. Figure 4.28 shows the final result.

8. Your drawing should now resemble Ch4-Final.dwg (or Ch4-Final-metric.dwg), which is available among the book’s companion download files at www.sybex.com/go/autocad2014essentials.

**Using an apostrophe before a command issues it transparently so that it works on top of another command without canceling it.**
In this chapter, you learned how to edit drawings first by making selections, and then by moving, copying, rotating, and scaling objects. You created individual and associative rectangular and polar arrays; used the Trim, Extend, Lengthen, Stretch, Offset, and Mirror tools; and edited with grips. In short, you learned how to draw in AutoCAD. Congratulations are in order!

**Additional Exercise**

- Explore the **BREAK**, **JOIN**, and **OVERKILL** commands on your own. As the name suggests, the Break tool is used to interrupt an object at one or two points (leaving a gap). Join is used to connect two or more collinear lines into single segments. Overkill eliminates coincident lines. All three are used to clean up drawings.
For many years, the AutoCAD® program wasn’t very sophisticated when it came to shaping curves. Sure, you could create circles, arcs, and ellipses, but shaping complex curves wasn’t accurate compared to the capabilities of programs such as Autodesk® Maya® or Autodesk® 3ds Max®. In AutoCAD 2011, all this changed with the introduction of an all-new SPLINE command that offered much more flexibility in shaping true NURBS (nonuniform rational B-spline) curves using fit points or control vertices. AutoCAD 2014 expands on this by giving you the ability to shape curves in any way you can imagine and even use them to model surfaces, which you’ll learn more about in Chapter 17, “Modeling in 3D.”

- Drawing and editing curved polylines
- Drawing ellipses
- Drawing and editing splines
- Blending between objects with splines

**Drawing and Editing Curved Polylines**

The simplest curved objects are circles and arcs (which are just parts of circles), because they curve with a constant radius from a center point. In the following steps, you will chain a series of arcs and/or lines together in a single polyline object, which not only streamlines editing and selection but also ensures smooth curvature between adjacent arcs.

1. Go to the book’s web page at [www.sybex.com/go/autocad2014essentials](http://www.sybex.com/go/autocad2014essentials), and browse to Chapter 5 to get the files Ch5-A.dwg (or Ch5-A-metric.dwg) and Pond.jpg. Place them in the same folder on your hard drive, and open the drawing file in AutoCAD (see Figure 5.1).
2. You will begin by drawing curved pathways surrounding the lake. Click the Polyline tool on the Draw panel of the ribbon. Click the first point at point A as shown in Figure 5.1. Type A (for Arc), and press Enter.

3. Toggle off Ortho mode if it is on. Observe that the arc you are drawing may curve the wrong way, against the curvature of the lake (see Figure 5.2). The command prompt reads:

\[
\text{Specify endpoint of arc or} \\
\text{[Angle Center Direction Halfwidth Line} \\
\text{Radius Second pt Undo Width]}:
\]

4. Type S (for Second Point), shown as B in Figure 5.2, and press Enter. Normally, polyline arcs are defined by two points, and by using the second point option, you are choosing the arc to be formed by three points so that you can determine its direction of curvature.
5. Right-click the Object Snap toggle in the status bar and select Node. By turning on Node running object snap, you will be able to snap arcs to all the point objects surrounding the lake. Turn on Endpoint running object snap if it is not already on. Click B as shown in Figure 5.2.

6. Click each subsequent node around the left half of the lake until you reach point C in Figure 5.3. Press Enter to end the `PLINE` command.

7. Press the spacebar to repeat the last command. Click point D shown in Figure 5.4, type A (for Arc), and press Enter.
8. Type `S` (for Second Point), press Enter, and snap to the node adjacent to point D.

9. Click each subsequent node around the right side of the lake until you reach point E in Figure 5.4. Press Enter.

10. Type `O` (for Offset), and press Enter. Type `6` (or `2` m), and press Enter. Click the left polyline you drew around the lake in steps 1–6, and then click a point on the side of the polyline away from the lake. Click the right polyline, and click outside the lake. Click the outer arc surrounding the pentagonal structure, and then click outside the lake.

11. Click the Trim tool in the Modify panel. Press Enter to select all objects as potential cutting edges, and click the portions of the arcs that overlap in the top highlighted area in Figure 5.5. Zoom into the lower highlighted area, and trim the arcs so that they meet at their endpoints. Press Esc to end the `TRIM` command.
12. Pan over to the building at the bottom of the lake. We’d like the ends of the paths to open up to the building. Click the lower-left polyline to select it. Click the endpoint grip, move it down a short distance, and click again (see Figure 5.6). You can’t get the end of the path to open up without distorting the path farther up because it’s all part of the same arc segment.
13. Press Esc, and then click the Undo button in the Quick Access toolbar.

14. Click the Arc tool in the Draw panel, hold Shift down and right-click, and choose Nearest from the context menu. Click points A, B, and C in Figure 5.7 to shape the arc as shown.

![Figure 5.7](image.png)

**Figure 5.7** Drawing new short-radius arcs and snapping them along the longer existing arcs

15. Press Enter twice to end, and restart the `ARC` command. Type `NEA` (for Nearest), press Enter, and click points D, E, and F in Figure 5.7.

16. Zoom in and trim away the portions of the original polylines that extend beyond the new arcs you’ve just drawn.

17. Type `J` (for `JOIN`), and press Enter. Select all five objects that comprise the outer path (three arcs and two polylines). Press Enter, and the command line reads:

   13 segments joined into 1 polyline

   There are 13 segments if you include all the arcs that make up the two polylines. You are left with a single polyline marking the outer edge of the path.

18. Press the spacebar to repeat the `JOIN` command. Select the three objects along the inner edge of the path, which include two polylines and the arc above the pentagon. Press Enter, and multiple segments are joined into one polyline (see Figure 5.8).
FIGURE 5.8 The curving path around the lake joined into two objects

**Should You Use JOIN or PEDIT?**

In previous versions of AutoCAD, objects first had to be converted into polylines and then joined using the polyline editing command called PEDIT. The streamlined JOIN command makes the older workflow unnecessary. Use it on lines, 2D and 3D polylines, arcs, elliptical arcs (sections of ellipses), and/or helices. Multiple object types can be joined at once. The resulting object type depends on what was selected.

**Drawing Ellipses**

AutoCAD can draw perfect ovals, which are mathematically known as *ellipses*. Instead of stretching a cord from two pins to a moving pencil point (which is how you draw an ellipse by hand), in AutoCAD you specify the lengths of its major and minor axes (see Figure 5.9).
In this exercise, you will draw an ellipse and distribute shrubs along its edge:

1. Zoom into the area in the lower left where the remaining point objects are located.

2. Type **REGEN** (for Regenerate), and press Enter. The size of point objects is recalculated when the drawing is regenerated.

3. Open the Ellipse menu in the Draw panel, and choose the Center method. Click the center point, the end of the major axis, and the end of the minor axis, as shown in Figure 5.10.

4. Type **BR** (for Break), press Enter, and select the ellipse. The command prompt reads:

   Specify second break point or [First point]:

   Type **F** (for First Point), and press Enter.
5. Right-click the Object Snap toggle in the status bar, and select Quadrant from the context menu. Click the quadrant point (north, south, east, or west points of any circle) opposite the point object marking the end of the major axis (see Figure 5.10), and then click the aforementioned point object itself to break the ellipse in half. The lower half of the ellipse remains, leaving an **elliptical arc**.

6. Type **DIV** (for Divide), and press Enter. Select the elliptical arc, and press Enter. The command prompt reads:

   Enter the number of segments or [Block]:

   Type **B** (for Block), and press Enter. You’ll learn more about blocks in Chapter 7, “Organizing Objects.”

7. A block called Shrub is predefined, so at the next command prompt:

   Enter name of block to insert:

   type **Shrub**, and press Enter.

8. Press Enter to accept the default when asked if you want to align the block with the selected object. (It doesn’t matter in this case because the Shrub block is a circle.)

9. Type **13** (for the number of segments), and press Enter. The **DIVIDE** command always creates one less point or block than the number of segments into which the object is divided. Twelve “shrubs” appear along the elliptical arc (see Figure 5.11).

10. Delete the three points used in drawing the ellipse, the elliptical arc itself, and the black circle, which is the original Shrub block. You deleted the layout geometry and are now left with precisely positioned shrubs.

**FIGURE 5.11** Dividing an elliptical arc with blocks
Drawing and Editing Splines

Splines are the equivalent of a French curve in traditional drafting, used for making curves of constantly changing radii. Splines have been part of AutoCAD for many releases, but the SPLINE command was completely overhauled in AutoCAD 2011. The new splines in AutoCAD are NURBS-based curves (the same type used in Autodesk® Alias® Design Surface, Maya, 3ds Max, and many other high-end 3D programs). There are two types of NURBS curves:

- Those defined by control vertices (CVs), which don’t lie on the curve except at its start and endpoints
- Those defined by fit points, which lie on the curve itself

You have more control over shaping curves with CVs, but if you want the curve to pass through specific points, or want the curve to have sharp kinks, then Fit Points mode is preferable. Fortunately, it is easy to switch between CVs and Fit Points editing modes, so you can make up your mind about which method to use to suit the situation.

Working with Control Vertices

CVs offer the most flexibility in terms of precisely shaping NURBS curves. A control frame connects CVs and represents the maximum possible curvature between adjacent CVs. You will now draw a CV spline around the lake:

1. Toggle off Object Snap, Ortho, and Polar Tracking modes on the status bar if any of them are on. Type SPL (for Spline), and press Enter. The command prompt reads:
   
   Current settings: Method=Fit   Knots=Chord
   Specify first point or [Method Knots Object]:

   Type M (for Method), and press Enter.

2. The command prompt reads:
   
   Enter spline creation method [Fit CV] <Fit>:

   Type CV (for Control Vertices), and press Enter. Click the first point anywhere along the edge of the lake.

3. Continue clicking points all the way around the lake. When you get close to the first point, type C (for Close) and press Enter. Click the spline you just drew to reveal its CVs (see Figure 5.12).
4. Position the cursor over a CV, and observe the multifunction grip menu. Select Stretch Vertex, move the cursor, and click to relocate that particular CV.

5. Try adding and removing vertices using the corresponding choices on the multifunction grip menu (see Figure 5.13).

6. Refining a vertex transforms one vertex into two adjacent vertices. Try refining vertices in areas where the curvature is changing rapidly.

7. Another way to affect the shape of a spline is to adjust the weights of individual CVs. Double-click the spline itself (rather than a CV or the control frame) to invoke the SPLINEDIT command. The prompt reads:

   Enter an option [Open Fit data Edit vertex convert to Polyline]
Reverse Undo eXit] <eXit>:

Type **E** (for Edit Vertex), and press Enter.

8. The prompt now reads:

   Enter a vertex editing option [Add Delete Elevate order Move Weight eXit] <eXit>:

Type **W** (for Weight), and press Enter.

9. Before entering a weight value, you must select the vertex in which you're interested. Zoom out until you can see all the vertices, locate the red one, press Enter repeatedly to choose the default option (Next), and move the red CV one position at a time until your chosen CV turns red.

10. Type **2**, and press Enter (see Figure 5.14). The spline will get closer to the red CV and its control frame. Type **.5**, and press Enter again; the curve moves farther away from the control frame. Type a value appropriate to your particular situation, and press Enter. We set a weight of 0.75 for the CV shown in Figure 5.14 to push it away from the control frame and more closely match the shape of the lake. The weights you need to enter depend entirely on exactly where you placed the CVs when creating the curve in step 2.

---

**FIGURE 5.14 Adjusting the weight of a CV**

Vertices with higher weights pull the curve toward the control frame and vertices with weights below 1 (but above 0) push the spline farther away.
11. Type \texttt{X} (for Exit), and press Enter. Press \texttt{X} and Enter twice more to exit SPLINEDIT fully.

**Sketch and Rebuild CVs**

Instead of stretching, adding, removing, refining, and/or adjusting CVs, you can sketch spline curves freehand. The \texttt{SKETCH} command is admittedly difficult to use with a mouse, so if you have a stylus and a drawing tablet, try using them for a more natural drawing feel. Unfortunately, sketching splines usually results in an uneven distribution of CVs, but this can be rectified by using CVREBUILD. For an alternative natural drawing technique, draw splines on a tablet with \texttt{SKETCH} (using SPLINE in its type option) and then redistribute the resulting CVs with CVREBUILD. The CVREBUILD command's Rebuild Curve dialog box is shown here:

12. Continue adjusting the spline until it closely matches the outline of the lake.

13. Type \texttt{IM} (for Image), and press Enter. The External References palette appears. (You'll learn more about this palette in Chapter 9, “Working with Blocks and Xrefs.”) The lake that you have been tracing is an image that you will now detach.

14. Right-click Pond in the External References palette, and choose Detach Image. Close the External References palette. Select the pond spline, and change its color to Blue in the Properties panel (see Figure 5.15). The pond is now represented by a blue curve rather than a blue image.
Working with Fit Points

Fit point splines are straightforward in the sense that the fit points you click lie on (or very close to) the curve itself. Controlling the shape of a fit curve on the most basic level is a matter of adding more fit points in strategic locations. There are a few advanced options affecting the shape of a spline in between fit points (Tangent, Tolerance, Kink, and Knot Parameterization), and you will use Kink in this exercise to establish sharp points on the spline.

1. Zoom into the area at the bottom of the lake where you distributed the shrubs earlier in this chapter in an elliptical arc. More specifically, zoom into the grouping of five points. Type `REGEN`, and press Enter to regenerate the display and thus automatically resize the point objects.

2. Expand the Draw panel, and click the Spline Fit tool at the top left. Toggle on Object Snap mode in the status bar (with Node snap on), and click the top point, the point on the right, the bottom, and then the one on the left. Type `C` (for Close), and press Enter. The fit curve looks very much like a circle, although it is not perfectly round (see Figure 5.16). This will be the start of an abstract tree representation.
3. Toggle on Dynamic Input on the status bar. Select the spline you just drew, type `SPLINEDIT`, and press Enter. Choose Fit Data from the dynamic input menu. Then choose Add from the next dynamic input menu that appears.

4. The prompt reads:

   ```plaintext
   Specify existing fit point on spline <exit>:
   
   Click the top point.
   ```

5. The prompt now says:

   ```plaintext
   Specify new fit point to add <exit>:
   
   This particular command requires that you snap the new fit point, so type `NEA` (for Nearest) and press Enter. Click the curve in between the top and right points. Press Enter four times to exit `SPLINEDIT` fully.
   ```

6. Another way to add fit points is with the multifunction grips, although this method doesn’t work on the first point. To use this feature, click the spline to select it, hover the cursor over the right point, and choose Add Fit Point from the menu that appears. Hold Shift, right-click, and choose Nearest from the context menu. Click a point between the right and bottom points.

7. Repeat the previous step twice more, adding additional fit points between the bottom, left, and top points (see Figure 5.17).
8. Double-click the spline itself to invoke the SPLINEDIT command without typing. Type F (for Fit Data), and press Enter. The prompt reads:

   Enter a fit data option
   [Add Open Delete Kink Move Purge Tangents toLerance eXit] <eXit>:

   Type K (for Kink), and click eight points in between all the existing fit points (see Figure 5.18). Press Enter three times to exit the command fully.

   ![FIGURE 5.18 Adding kinks to the fit points spline](image)

9. Click each kink grip, and move it in toward the center to create an abstract representation of a tree. Delete the five point objects that helped you lay out the tree (see Figure 5.19). If you have trouble selecting point objects, try changing their size with the DDPTYPE and REGEN commands.
Blending Between Objects with Splines

The **BLEND** command creates a CV spline in between two selected lines, circular or elliptical arcs, splines, or any combination of these object types. Blend curves join the endpoints of the two objects with a curve having either tangent or smooth continuity. There is a subtle difference between these types of blending.

A blend curve with tangent continuity has its control frame parallel to the control frame of the adjacent curve. A blend curve with curvature continuity not only has its control frame parallel to the control frame of the adjacent curve, but the control frames have equal lengths. In simpler terms, tangent continuity is smooth, and smooth continuity is “perfectly smooth.” In the following steps, you will create blend curves with two types of curvature:

1. Pan over to the other “tree” to the left of the tree you’ve drawn with kinks. Type **BLEND**, and press Enter.

2. The prompt reads:
   
   Continuity = Tangent
   Select first object or [CONTinuity]:

   Select a flat arc and a tight arc, and the command is finished. A CV spline with tangent continuity blends between the two arcs.
3. Press the spacebar to repeat BLEND, type **CON** (for Continuity), press Enter, type **S** (for Smooth), and press Enter again. Click two adjacent arcs to create another blend curve (see Figure 5.20).

![Figure 5.20: Blending between arcs with different types of continuity](image)

4. Continue blending all the adjacent curves in the tree. Delete the point object at the center. Figure 5.21 shows the completed drawing.

![Figure 5.21: Completed landscape plan](image)

5. Your drawing should now resemble `Ch5-B.dwg` (or `Ch5-B-metric.dwg`), which is available at this book's web page.
The Essentials and Beyond

You have learned how to shape many types of curvilinear objects in this chapter, including circular and elliptical arcs, polylines, ellipses, and CV and fit point NURBS-based splines. You’ve broken and joined objects, and blended smoothly between adjacent curves. In short, you now have the skills to shape just about any curve you can imagine with a fine degree of precision, which is what AutoCAD is all about.

Additional Exercise

- Explore the HELIX command on your own. The HELIX command creates spirals and helices. You are welcome to stick with two dimensions for now and create spirals with this command. When you learn how to navigate and model in 3D (in Chapters 16 and 17), you can use this command to create springs, screw threads, or even DNA.
CHAPTER 6

Controlling Object Visibility and Appearance

Layers control objects whether they are visible or hidden. All objects have properties that control their appearance—properties such as color, linetype, lineweight, and so on. The layers to which objects are assigned usually control general object properties, but these properties can be set on a per-object basis as well. This chapter explores the many AutoCAD® tools associated with layers that illustrate the importance of layers in managing the complexity of design.

- Changing object properties
- Setting the current layer
- Altering the layer assignments of objects
- Controlling layer visibility
- Applying linetype
- Assigning properties by object or by layer
- Managing layer properties

Changing Object Properties

All objects have properties controlling their appearance. When you draw a line, you are ultimately specifying its geometric properties (the start point and the endpoint). Likewise, when you draw a circle, you are just specifying its center point and radius properties. Geometric properties are the most important factor governing how objects look and in determining where the objects are in space.
In addition to geometric properties, all objects share a short list of general properties: layer, color, linetype, linetype scale, lineweight, transparency, and thickness. Although general properties are assigned on a per-object basis, they are usually controlled by using layers.

Let's explore object properties in an existing drawing and then learn how to change properties and merge the layers to which objects are assigned:

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 6, get the file Ch6-A.dwg (or Ch6-A-metric.dwg), and open it (see Figure 6.1). This is the architectural plan for a hypothetical small office.

2. Zoom into the reception desk at the center of the small office plan.

3. Toggle on the Quick Properties mode in the status bar.

4. Click on the line of the desk immediately adjacent to the Reception text object; the Quick Properties panel appears at the top right of the selected object on the drawing canvas. Click the Desk-High layer name to activate the Layer drop-down menu (see Figure 6.2).
5. Select the Desk layer in the drop-down (see Figure 6.3), and press the Esc key to exit Quick Properties mode. Observe that the line whose layer property you changed now appears violet, like the other objects on the Desk layer.

6. Expand the Layers panel on the Home tab of the ribbon.

7. Click the Merge tool. The command prompt reads:
   
   Select object on layer to merge or [Name]:

8. Click one of the brown lines in the upper portion of the reception desk and press Enter.
9. Click the violet line you changed to the Desk layer in step 5 and press Enter. The command prompt reads:

```
Select object on target layer or [Name]:
******** WARNING ********
You are about to merge layer "Desk-High" into layer "Desk".
Do you wish to continue? [Yes/No] <No>:
```

10. Press Y (for Yes), and then press Enter to continue. The Desk-High layer is deleted, and the objects that were on it have been reassigned to the Desk layer. The LAYMRG command is done.

11. Expand the Properties panel, and click the List tool. Pan over and select the Business Development text object by clicking on it and pressing Enter. The AutoCAD Text window appears, displaying the following property information:

```
TEXT      Layer: "Title"
Space: Model space
Handle = 71e
Style = "Standard"
Annotative: No
Typeface = Arial
mid point, X= 193.8805  Y= 132.8080  Z= 0.0000
height    7.5000
text Business Development
rotation angle   0
width scale factor  1.0000
obliquing angle   0
generation normal
```

This list might be helpful if you were looking for a particular piece of information, but you can't edit any of the properties directly. Close the AutoCAD Text window.

12. Select the View tab on the ribbon and, under Panels, click the Properties tool to open the Properties panel.

13. Select the Business Development text object you selected in step 11. Many of its properties appear in the panel (see Figure 6.4). Property values displayed on a white background are editable; those on a gray background are for your information only.
14. Select the words “Business Development” in the Contents property, type Marketing, and press Enter. Press Esc to deselect the text object. The department’s name has been changed. You can now close the Properties panel.

Setting the Current Layer

Objects are always drawn on the current layer, and there is only one current layer at any given time. Every drawing has at least one layer, layer 0 (zero), which is current by default when you create a new drawing.

AutoCAD has another special layer called Defpoints, which is automatically created when you add associative dimensions to a drawing (see Chapter 11, “Dimensioning”).

Let’s experiment with setting the current layer by drawing a few objects:

1. Using the Ch6-A.dwg (or Ch6-A-metric.dwg) file, zoom into the Manager’s office. If this file is not open, find it on the book’s web page.

2. Click the Rectangle tool on the Draw panel, and click a point a few inches (no need to measure) from the lower-left corner of the room.
Type @18,72 (or @45,180 for metric) and press Enter to create a credenza in the Manager’s office (see Figure 6.5).

![Credenza in Manager’s office](image)

**Figure 6.5** Drawing furniture on layer 0

3. Select the rectangle you drew in the previous step, and change its Layer assignment to Furniture in the Quick Properties window that appears. Press Esc to deselect.

4. If you plan on drawing more than one object, a more efficient approach is to set the current layer prior to drawing, so that the new object will have the proper layer assignment automatically. Open the Layer drop-down menu in the Layers panel, and click on or to the right of the word Furniture to set this layer as current. Notice that Furniture appears “on top” when the drop-down is closed (see Figure 6.6); Furniture is now the current layer.

![Layer settings](image)

**Figure 6.6** Setting Furniture as the current layer using the drop-down menu in the Layers panel

Press Shift, right-click, and choose the None object snap to override any running object snap modes whenever necessary.
5. Pan over to the Marketing space.

6. Click the Rectangle tool on the Draw panel, and click a point a few inches (without measuring) from the lower-right corner of the room. Type @-18,72 (or @-45,180 for metric), and press Enter to create a credenza in Marketing (see Figure 6.7).

7. Select the rectangle you drew in the previous step, and verify that it is on the Furniture layer in the Quick Properties window that appears. Press Esc.

8. Pan over to the closet in Marketing. One of the lines representing shelves is missing. You will draw the missing line on the same layer as the existing shelf line.

9. Rather than selecting the existing shelf line by learning its layer name and then setting that layer as current, there is a more efficient approach. In the Layers panel, click the Make Object’s Layer Current tool. Click the existing shelf line in Marketing’s closet. The layer appearing at the top of the Layer drop-down menu is Millwork, which shows that it’s now the current layer.

10. Toggle on Endpoint and Perpendicular running object snap modes on the status bar.

11. Click the Line tool on the Draw panel, and draw the line shown in Figure 6.8. Press Esc to end the LINE command.
Altering the Layer Assignments of Objects

Although you have already changed the layer assignments of objects using Quick Properties, there are more efficient methods of doing so, some of which do not require you to remember a layer name. Let’s explore several methods for changing the layer assignments of existing objects:

1. Using the Ch6-A.dwg (or Ch6-A-metric.dwg) file, zoom into the Marketing office. If this file is not open, find it on the book’s web page.

2. Toggle off Quick Properties mode on the status bar.

3. Select the coffee table. Notice that the entry in the Layer drop-down in the Layers panel changes to layer 0; this does not mean that layer 0 is current (Millwork is), only that the selected item is on layer 0.

4. Open the Layer drop-down menu, and click Furniture (see Figure 6.9) to change the layer assignment of the selected items. Press Esc to deselect.

5. Pan over to the Lounge.

6. Click the Match tool in the Layers panel, select the coffee table in the Lounge, and press Enter. The command prompt reads:

   Select object on destination layer or [Name]:

7. Click one of the sofas in the Lounge and press Enter; the LAYMCH command ends. The coffee table is now assigned to the same layer as the sofas (Furniture).
8. Pan to the Manager’s office.

9. Click the Match Properties tool in the Clipboard panel on the Home tab of the ribbon. Select the credenza in the Manager’s office and press Enter. The command prompt reads:

   Select destination object(s) or [Settings]:

10. Type S (for Settings), and press Enter; the Property Settings dialog box appears. You can match many properties in addition to layers with this tool (see Figure 6.10). Click OK.

   ![Property Settings dialog box](image)

   **Figure 6.10** The Property Settings dialog box allows you to match much more than layers.
11. Click the desk in the Manager’s office and press Enter; the desk turns green because it is now on the Furniture layer. Press Esc to exit the MATCHPROP command.

**Merging Layers**

In AutoCAD 2014, you can merge the contents of multiple layers into a single layer. First, select the layers you wish to merge in the Layer Properties Manager (using the Ctrl key to select multiple nonsequential layers), right-click, and select Merge Selected Layers To. You are then presented with a dialog box where you can select the single destination layer from a list. The source layers are automatically purged after their contents are merged into the destination layer.

**Controlling Layer Visibility**

In traditional drafting, separate drawings would have to be made for the floor plan and the reflected ceiling plan to represent the floor and ceiling of the same space. In AutoCAD, simply displaying some layers while hiding others allows you to create some of the drawings required to describe the space graphically.

To understand better how to do this, you need to learn how to toggle layer status, isolate layers to work without distraction, and save layer states to recall the layer status of multiple layers quickly.

**Toggling Layer Status**

In addition to having properties such as color, linetype, lineweight, and so on, layers have states that can be toggled, including On/Off, Thaw/Freeze, and Lock/Unlock. As you’ll see in the following steps, layer states control the visibility and editability of the objects assigned to layers:

1. Using the Ch6-A.dwg (or Ch6-A-metric.dwg) file, zoom out to show the entire office. If this file is not open, find it on the book’s web page.

2. Expand the Layers panel, and click the Turn All Layers On tool. You now see the switches ($ symbols), downlights, and header layers. Figure 6.11 shows the result.
3. Open the Layer drop-down menu in the Layers panel, and click the Appliance layer’s lightbulb icon to toggle it off. Toggle off the Desk layer as well. Click outside the Layer drop-down menu to close it.

4. Another approach to turning layers off doesn’t require that you know layer names. Click the Off tool in the Layers panel, and click the following objects: sink, door, chair, plant, stairs, low wall, low wall’s pattern fill, text, and the porch. Click a kitchen cabinet and the command prompt reads:

   Layer "Millwork" is current, do you want to turn it off? [Yes/No] <No>:

5. Type Y (for Yes), and press Enter. Press Esc to end the LAYOFF command. Figure 6.12 shows the result.

6. Open the Layer drop-down menu in the Layers panel, and set layer 0 as current.

7. Click Zoom Extents in the Navigation bar. Notice that there is a gap between the bottom wall of the building and the lower edge of the drawing canvas. Even though it is off, the Porch layer is still defining the extents of the drawing.
8. Open the Layer drop-down menu in the Layers panel, and freeze the Porch layer. Press Esc to close the drop-down menu.

9. Click Zoom Extents in the Navigation bar again. The gap disappears because the Porch layer is no longer calculated when it is frozen and therefore is no longer part of the drawing extents.

10. Expand the Layers panel, and click the Lock tool. Select one of the lights. The Lighting layer is now locked.

11. Type E (for Erase), and press Enter. Click on a different light, and observe a tiny padlock appear near the object (see Figure 6.13). You can’t select the object because it is locked. In order to see the padlock, you must select When A Command Is Active in the Selection Preview area on the Selection tab in the Options dialog box (OPTIONS command).

**Figure 6.12** Reflected ceiling plan created by toggling layers off

**Figure 6.13** Objects on locked layers cannot be selected.
Isolating Layers

You can quickly isolate one or more layers to work on them without the visual clutter of all the other layers. Let’s try out Isolation mode:

1. Use the Ch6-A.dwg (or Ch6-A-metric.dwg) file. If this file is not open, find it on the book’s web page.

2. Click the Isolate tool on the Layers panel, and then make a crossing selection through one of the windows. Press Enter and all the other layers disappear (see Figure 6.14).

3. Expand the Layers panel, and click the Copy Objects To New Layer tool. Select each one of the nine sill lines on the inside of the building and press Enter. The command prompt reads:

   Select object on destination layer or [Name] <Name>:
4. Type **N** (for Name), and press Enter. The Copy To Layer dialog box appears (see Figure 6.15). Select Header from the Destination Layer list, click OK, and press Enter. There are now nine lines on the Sill layer and nine duplicate lines on the Header layer.

![Copy To Layer dialog box](image)

**FIGURE 6.15** Selecting a layer in the Copy To Layer dialog box

5. Click the Unisolate tool on the Layers panel. The layers return to the way they were before you used the Isolate tool.

6. Type **LAYOFF**, and press Enter. Click one of the sills on the outside of the building to turn off the Sill layer and press Enter. Open the Layer drop-down menu, and toggle on the Header layer.

7. Zoom into one of the lower windows, and click the Distance tool in the Utilities panel. Click points A and B shown in Figure 6.16 to measure the wall thickness. The command prompt reads:

```
Distance = 5.0000, Angle in XY Plane = 270,
Angle from XY Plane = 0
Delta X = 0.0000, Delta Y = -5.0000, Delta Z = 0.0000
```

![Distance measurement](image)

**FIGURE 6.16** Measuring the wall thickness with DISTANCE
8. Press Esc to cancel the DISTANCE command.

9. Type 0 (for Offset), press Enter, type 5 (or 12.7 for metric), and press Enter again. Click the header line in the window opening, and then click below it to offset a line on the outer edge of the wall.

10. Continue clicking each header and a point outside the building to offset a second header line in each window opening. Press Enter to end the OFFSET command when done. The reflected ceiling plan is complete.

Saving Layer States

In this section, you will learn how to save collections of layer states for later recall. You have already created a reflected ceiling plan in this chapter, and you will now save it as a layer state so that you won’t have to repeat all the work of toggling layer states in the future.

1. Use the Ch6-A.dwg (or Ch6-A-metric.dwg) file. If this file is not open, find it on the book’s web page.

2. Open the drop-down menu directly above the Layer drop-down (it says Unsaved Layer State by default). Select New Layer State in the drop-down menu (see Figure 6.17).

3. Type Reflected Ceiling Plan in the New Layer State To Save dialog box and click OK. The closed drop-down now says Reflected Ceiling Plan.

4. Expand the Layers panel, and click the Turn All Layers On tool.

5. Expand the Layers panel again, and click the adjacent Thaw All Layers tool.
6. Click the Freeze tool in the Layers panel, and select the following objects: light, switch, header, and computer. The layers Lighting, Electrical, Header, and Equipment are frozen. Press Enter to end the LAYFRZ command.

7. Open the Layer State drop-down menu in the Layers panel, and click New Layer State. Type **Furniture Plan** in the New Layer State To Save dialog box and click OK.

8. Open the Layer State drop-down menu, and select Reflected Ceiling Plan (see Figure 6.18). All the layer states associated with the Reflected Ceiling Plan are immediately toggled. Switch back to the Furniture Plan state, and you’ll see the value in saving layer states (it saves lots of time).

![FIGURE 6.18](https://example.com/f6_18.png)

**FIGURE 6.18**
Accessing saved layer states from the drop-down in the Layers panel

---

**Applying Linetype**

In traditional drafting, you draw short, interrupted line segments when you want to indicate what is called a **hidden line**. Hidden lines represent objects that are above the section plane. For example, objects such as upper cabinets, high shelves, or a roof edge are shown as hidden because they are above an imaginary section line cutting the building horizontally.

In AutoCAD, lines are not interrupted (broken into multiple little pieces) to indicate hidden lines. Instead, continuous lines are assigned a **linetype**, and this style makes lines appear as if they are interrupted. One advantage to this is that
you can adjust the scale of the line breaks without having to redraw myriad little lines. Let’s explore linetype and linetype scale:

1. Using the Ch6-A.dwg (or Ch6-A-metric.dwg) file, zoom out to view the entire office. If this file is not open, find it on the book’s web page.

2. Open the Linetype drop-down menu in the Properties panel, and select Other at the bottom of the menu (see Figure 6.19).

3. In the Linetype Manager dialog box that appears, click the Load button. Scroll down in the Load Or Reload Linetypes dialog box that appears, and select Hidden in the list (see Figure 6.20); then click OK. Hidden now appears in the Linetype Manager dialog box because this particular linetype style has been loaded in the drawing file; click OK to close the Linetype Manager dialog box.

![Figure 6.19 Accessing other linetypes](image1)

![Figure 6.20 Loading the Hidden linetype](image2)
4. Zoom into the closet in the Marketing space, and select both lines on the Millwork layer, representing a high shelf.

5. Open the Linetype drop-down menu in the Properties panel, and select Hidden from the menu. Now the two selected lines have the Hidden linetype assigned.

6. You still don’t see breaks in the lines because the linetype scale is too small by default. Type `LTSCALE` (for Linetype Scale), and press Enter. The command prompt reads:

   `LTSCALE Enter new linetype scale factor <1.0000>:`

7. Type `48` (or `50` for metric), and press Enter. The lines appear with breaks indicating that the shelf is above the section plane (see Figure 6.21).

8. Select the horizontal shelf line, right-click, and choose Properties from the context menu.

9. Change Linetype Scale to `0.5` in the General section of the Properties panel (see Figure 6.22).
Assigning Properties by Object or by Layer

Properties such as color, linetype, and lineweight are typically assigned by layer rather than by object. There is a special property value called *ByLayer* that passes control over specific properties to the properties managed by the layer to...
which the objects are assigned. As you'll see in these steps, using the ByLayer property is a lot easier than it sounds:

1. Using the Ch6-A.dwg (or Ch6-A-metric.dwg) file. If this file is not open, find it on the book’s web page.

2. Open the Linetype drop-down menu on the Properties panel, and select Hidden (see Figure 6.24). Draw a line of arbitrary length anywhere on the canvas.

3. Open the Linetype drop-down menu on the Properties panel, and select ByLayer.

4. Draw another line, and observe that it has continuous linetype.

5. If you want to change the property of a specific object, use Quick Properties instead of the drop-down menus in the Properties panel. Toggle on Quick Properties mode on the status bar.

6. Select the continuous line drawn in step 2, and change its Linetype property to Hidden (see Figure 6.25).

7. Draw another line, and verify that it has continuous linetype.

8. Delete all three arbitrary lines you’ve just drawn.

Objects should be assigned specific colors, linetypes, or lineweights only in exceptional circumstances.
Managing Layer Properties

The Layer Properties Manager is where you create layers and manage the properties that are assigned to them. Let’s explore the Layer Properties Manager with a practical example:

1. Use the Ch6-A.dwg (or Ch6-A-metric.dwg) file. If this file is not open, find it on the book’s web page.

2. Click the Layer Properties tool in the Layers panel. The Layer Properties Manager appears (see Figure 6.26).

3. Click Collapse The Layer Filter Tree to save some space in the panel.

4. Click the New Layer button, type **Millwork-Upper** as the new layer’s name, and press Enter.

5. Double-click the blue parallelogram next to the new layer to set it as current. Now there is a green check mark next to the Millwork-Upper layer.

6. Right-click any one of the column headers to access a context menu. Choose Maximize All Columns from this menu. Figure 6.27 shows the result: The columns are all readable.
7. Click the Freeze column header to sort the column by that criterion (frozen state). Click the Freeze column header again to reverse the sort order. All columns are sortable.

8. Click the word Continuous in the Linetype column in the Millwork-Upper layer. In the Select Linetype dialog box that appears, choose Hidden and click OK.

9. Click Millwork-Upper’s color swatch to open the Select Color dialog box. Click the larger red swatch where indicated (see Figure 6.28) and click OK.
10. Zoom into the closet in the Marketing space, and select both shelf lines. Change Layer to Millwork-Upper and Linetype to ByLayer in the Quick Properties window (see Figure 6.29). The two lines appear red with Hidden linetype. Close the Layer Properties Manager.

![Figure 6.29](image_url) Changing layer assignment and setting linetype to ByLayer

11. Your drawing should now resemble Ch6-B.dwg (or Ch6-B-metric.dwg), which is available among the book’s download files.
In this chapter, you learned how to control object visibility and how to modify object appearance with layers and properties. You learned many ways to change object properties, set the current layer, alter the layer assignments of objects, control layer visibility, apply linetypes, use the ByLayer property, and manage properties with layers. You now have a greater ability to manage design complexity.

**Additional Exercise**

Explore layer property and group filters on your own by opening one of the sample files that ships with AutoCAD, such as:

```
C:\Program Files\Autodesk\AutoCAD 2014\Sample\Sheet Sets\Architectural\A-01.dwg
```

Layer filters are especially useful in complex drawings where you need to manage dozens, or even hundreds, of layers.
CHAPTER 7

Organizing Objects

*The fundamental entities in* the AutoCAD® program are lines, polylines, circles, arcs, ellipses, and text. By combining these entities into blocks and/or groups, you can manipulate more complex objects, such as chairs, mechanical assemblies, trees, or any other organizational designation appropriate to your industry.

Manipulating blocks is an efficient means of working not only because it reduces the number of items requiring selection, but also because blocks can potentially control numerous references from a single definition. In this chapter, you will learn how groups are a flexible means of organizing collections of objects, which often include blocks as members. You will also learn how to select and manipulate a group as a whole, or access the members of the group individually whenever needed.

- Defining blocks
- Inserting blocks
- Editing blocks
- Redefining blocks
- Working with groups

**Defining Blocks**

Before drawing and copying a series of repetitive elements, you should first define them as a block. This is because you have a higher level of organizational control over blocks than you do over individual entities. In this section, you will draw a chair and a door and then define them as blocks.
Drawing a Chair and Defining It as a Block

In the following steps, you will use the drawing skills that you’ve learned in previous chapters to draw a chair. Then you will convert the chair into a block definition.

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 7, get the file Ch7-A.dwg (or Ch7-A-metric.dwg), and open it (see Figure 7.1).

![Image of three rooms](image)

**FIGURE 7.1 Three rooms**

2. Zoom into the leftmost room above the desk.

3. Click the Rectangle tool on the Modify panel, and then click an arbitrary point above the desk (which is represented by the blue rectangle) as the first corner point. The command prompt reads:

   Specify other corner point or [Area Dimensions Rotation]:

   Type `@18,18` (or `@45,45` for metric), and press Enter.

4. Click the Explode tool on the Modify panel, select the rectangle you just drew, and press Enter. The single polyline is converted into four independent line objects.

5. Click the Fillet tool on the Modify panel, type `R` (for Radius), and press Enter. Type `3` (or `7` cm for metric), and press Enter to set the fillet radius; then click the left and bottom edges to create an arc.

6. Press the spacebar to repeat the FILLET command. Click the bottom and right edges to create another arc. Figure 7.2 shows the result.

7. Expand the Modify panel, click the Join tool, select all the objects making up the chair you are drawing, and press Enter. Four lines and two arcs have now been converted into a single polyline.
8. Toggle on Ortho mode on the status bar.

9. Select the polyline you joined in step 7. Hover the cursor over the top-middle grip, and select Convert To Arc from the multifunction grip menu that appears (see Figure 7.3).

10. Move the cursor upward, type 3" (or 7 cm), press Enter, and then press Esc to clear the selection. You've created the curve of the backrest.

11. Click the Explode tool on the Modify panel, press Enter, select the chair, and press Enter again. The polyline is converted into three lines and three arcs.
12. Click the Offset tool in the Modify panel, type 2” (or 5 cm for metric), and press Enter. Select the arc you created in step 9 and then click a point above it on the drawing canvas to offset a new arc 2” (or 5 cm) above. Press Enter to exit the OFFSET command.

13. Type BLEND, press Enter, and select the two arcs making up the backrest near their left endpoints. A spline object smoothly joins the arcs.

14. Press Enter to repeat the BLEND command, and select the two arcs near the right endpoints; another spline object is created (see Figure 7.4).

![Figure 7.4](image)

**Figure 7.4** Blending between concentric arcs

15. Click the Stretch tool in the Modify panel, click points A and B shown in Figure 7.4 to create a crossing window, and press Enter. Click an arbitrary point on the drawing canvas as the first point of the Stretch operation. Move the cursor downward on the drawing canvas, type 3” (or 7 cm for metric), and press Enter. The seat depth is reduced.

16. Select the entire chair with an implied window. Click the Create tool in the Block panel on the ribbon’s Home tab, and the Block Definition dialog box appears. Type Chair in the Name field. Every block must have a name.

17. Every block has a base point, which should be related to its geometry. Click the Pick Point button in the Base Point section; the Block Definition dialog box disappears. Hold Shift, and right-click to open the context menu; select Midpoint. Click the midpoint of the chair’s front edge. The Block Definition dialog box reappears, showing the coordinates of the point to which you snapped (see Figure 7.5).
18. Choose the Delete radio button in the Objects section of the Block Definition dialog box. Select Scale Uniformly and Allow Exploding. Deselect Annotative and Open In Block Editor. Set the Block Unit drop-down to Inches (or Centimeters) and click OK. The chair disappears; don’t worry, you will insert it later.

**Understanding the Block Table**

When the chair disappeared from the drawing canvas, it was defined in the drawing’s block table. Although every drawing has a block table, you can’t see it. Blocks defined there can be inserted into the drawing as block references. Changes made to block definitions (stored in the block table) affect all block references in the drawing.

**Drawing a Door and Defining It as a Block**

In the following steps, you will draw a door and the representation of its swing (an arc) and define it as a block:

1. If the file Ch7-A.dwg (or Ch7-A-metric.dwg) is not already open, go to the book’s web page, browse to Chapter 7, and open the file.
2. Pan over to the middle room. Zoom into the door opening along the bottom edge of this room.

3. Toggle on Running Object Snap mode on the status bar. Right-click this button, and turn on Endpoint snap if it’s not already highlighted in the context menu.

4. Click the Rectangle tool in the Draw panel. Snap the first corner at point A, as shown in Figure 7.6. Type \@1.5,2’6” (or @4,75 for metric), and press Enter to complete the door.

5. Click to open the Arc pull-down menu on the Draw panel, and select the Center, Start, End tool. Click points A, B, and C as shown in Figure 7.6 to create the swing.

6. Type B (for Block), and press Enter. The Block Definition dialog box appears.

7. Type Door in the Name field, and click the Select Objects button. Select the rectangle and the arc and press Enter. Select the Pick Point button, click the door hinge, and press Enter. Select the Convert To Block radio button and click OK.

8. Select the door, and observe that it has only one grip because it is now a block reference (see Figure 7.7). Press Esc to deselect.

9. Save your work as Ch7-B.dwg (or Ch7-B-metric.dwg).

Inserting Blocks

After you create a block definition, you can insert local block references (from the current drawing’s block table) into the drawing. In Chapter 9, “Working with Blocks and Xrefs,” you will learn how to create and insert global blocks, which...
are blocks that exist outside the current drawing file. In this section, however, you will simply focus on inserting the local chair and door blocks that you defined in the previous section.

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-B.dwg (or Ch7-A-metric.dwg), and open it.

2. Type UN (for Units), and press Enter. Open the Insertion Scale drop-down menu, and select Inches (or Centimeters) if it is not already selected (see Figure 7.8). Click OK to close the Drawing Units dialog box.

![Figure 7.7](image1.png)  
**Figure 7.7** The door has only one grip because it is a block reference.

![Figure 7.8](image2.png)  
**Figure 7.8** Setting Insertion Scale in the Drawing Units dialog box
3. Zoom into the room with the table on the left. Verify that Dynamic Input is off.

4. Right-click the object snap toggle on the status bar, and turn on Midpoint snap if it’s not already highlighted in the context menu.

5. Click the Insert tool on the Block panel on the ribbon’s Home tab. Open the Name drop-down list in the Insert dialog box and select Chair. If it’s not already selected, choose Specify On-Screen in the Insertion Point section of the Insert dialog box (see Figure 7.9). Click OK.

![Figure 7.9](image)

**FIGURE 7.9** Selecting the Chair block definition in the Insert dialog box

6. Hold Shift, right-click, and choose From in the context menu. Click the midpoint of the upper desk edge, type @0,3 (or @0,7 for metric), and press Enter. The Chair block reference appears 3” (or 7 cm) up from the center of the desk (see Figure 7.10).

![Figure 7.10](image)

**FIGURE 7.10** Chair block inserted 3” from the desk
7. Click the Move tool in the Modify panel, select the Chair block, and press Enter. Click an arbitrary point on the drawing canvas, type \( @1'3"<180 \) (or \( @40<180 \) for metric), and press Enter to move the chair to the left.

8. Click the Copy tool in the Modify panel, type \( L \) (for Last), and press Enter twice. Click an arbitrary point on the drawing canvas, type \( @2'6"<0 \) (or \( @80<0 \) for metric), and press Enter to copy a chair to the right (see Figure 7.11). Press Esc to end the COPY command.

![Figure 7.11 Copying a block reference](image)

9. Type \( I \) (for Insert), and press Enter. Type 180 in the Angle text box in the Rotation section of the Insert dialog box and click OK.

10. Hold Shift, right-click, and choose From in the context menu. Click the midpoint of the lower desk edge, and type \( @0,-3" \) (or \( @0,-7 \) for metric), and press Enter. The Chair block reference appears 3" (or 7 cm) down from the center of the desk.

11. Press Enter to repeat the last command (INSERT), and select Door from the Name drop-down list in the Insert dialog box. Select Specify On-Screen in the Rotation section and click OK.

12. Click point A in the leftmost room, as shown in Figure 7.12. Verify that Ortho mode is on in the status bar; if not, toggle it on. Move the cursor to the left to rotate the door into the proper orientation (see Figure 7.12). Click on the drawing canvas to insert the door.

13. Press the spacebar to repeat the INSERT command. Select Specify On-Screen in the Scale and Rotation sections of the Insert dialog box (see Figure 7.13) and click OK.
14. Click point B, as shown in Figure 7.12. The command prompt reads:

Specify insertion point or [Basepoint Scale Rotate]:

Type \(-1\) and press Enter.

15. The command prompt now says:

Specify rotation angle <0>: 180

Type \(180\) and press Enter. The door is inserted properly in the middle room.

16. Click the Copy tool in the Modify panel, select the door at the bottom of the middle room, and press Enter. Click points A and B shown in Figure 7.14 to copy a door block into the room on the right. Press Esc to end the COPY command.

Specifying a negative scale factor mirrors the block about its base point.

Copying a block has the same effect as inserting a block: a new block reference is added to the drawing.
Editing Blocks

You can edit blocks after they have been defined and inserted into the drawing as block references. In addition to editing geometry, you can assign floating properties to control property inheritance, nest blocks within blocks, or explode blocks entirely. We’ll explore each of these topics in this section.

Editing Block Definition Geometry

Block definitions are not frozen in stone; you can redraw them after block references have been inserted multiple times in a drawing. In fact, this is one of the reasons to use blocks: efficient control over multiple objects from a single editable definition. In the following steps, you will alter the door block and see all its references update automatically.

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-C.dwg (or Ch7-C-metric.dwg), and open it.

2. Zoom in on the lower door in the middle room.

17. Select the new door in the rightmost room. Click its single blue grip to activate Grip Editing mode. Press the spacebar twice so that the command prompt reads as follows:

** ROTATE **
Specify rotation angle or
[Base point Copy Undo Reference eXit]:

Type 90 and press Enter to rotate the door block around its base point.

18. Save your work as Ch7-C.dwg (or Ch7-C-metric.dwg).
3. Select the door, right-click, and choose Edit Block In-Place from the context menu. Click OK in the Reference Edit dialog box that appears (see Figure 7.15).

![Reference Edit dialog box](image)

**Figure 7.15** Editing a block reference in place

4. Click the Rotate tool on the Modify panel, select the door itself (not its swing), and press Enter. Click the hinge point and the command prompt reads:

   Specify rotation angle or [Copy Reference] <0>:

   Type `-45` and press Enter.

5. Click the Trim tool in the Modify panel and press Enter. Click the portion of the wing that extends beyond the door to trim it off, and press Esc to end the TRIM command.

6. Expand the temporary Edit Reference panel on the ribbon’s Home tab, and click the Save Changes button. Click OK in the AutoCAD warning dialog box that appears, which says, “All reference edits will be saved.” Figure 7.16 shows the result: All door references have been automatically updated with the new door geometry.

7. Save your work as Ch7-D.dwg (or Ch7-D-metric.dwg).

**Assigning Floating Properties**

When you set an object’s color, linetype, or lineweight to specific values such as Red, Hidden, or 0.5 mm, you are setting those properties explicitly. Explicit
object properties assigned to objects in block definitions are retained when those blocks are inserted onto different layers in the drawing.

It is often advantageous to assign floating properties—either *ByLayer* or *ByBlock*—to the objects in block definitions. Floating properties allow block references to inherit properties from the layer on which they are inserted. Alternatively, you can override these inherited properties with explicit properties by assigning them to the block reference.

The Door layer has been current throughout this chapter, so the objects you drew to define the chair and door blocks reside on this layer. In the following steps, you will assign floating properties to the chair and door blocks.

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-D.dwg (or Ch7-D-metric.dwg), and open it.

2. Click on each of the three chair block references to select them. Type `qp` (for Quick Properties), and press Enter. Select Furniture from the Layer drop-down menu (see Figure 7.17). Notice that the chairs are still green, even though the Furniture layer is blue. Click the Close box in the upper-right corner to close the Quick Properties palette, and press Esc to deselect.

You can use the QP command as an alternative to toggling on Quick Properties mode on the status bar.

---

**Figure 7.16** All doors have been updated by editing the door block in place.

**Figure 7.17** Assigning the Furniture layer to the chair block references
3. Select one of the chairs (it doesn’t matter which one), right-click, and choose Edit Block In-Place from the context menu. Click OK in the Reference Edit dialog box that appears.

4. Create an implied window to select all nine objects making up the chair.

5. Type `qp` (for Quick Properties), and press Enter. Open the Color drop-down menu, and select ByBlock. Click the Quick Properties palette’s close box, and press Esc to deselect.

6. Expand the Edit Reference panel, and click the Save Changes button. Click OK in the AutoCAD warning dialog box. The chairs turn blue because the ByBlock floating property allows them to inherit the Furniture layer’s blue color.

7. Select the lower chair by clicking on it. Open the Color drop-down menu in the Properties panel, select Magenta, and press Esc. The chair turns magenta because ByBlock allows explicit properties assigned to the block reference to override inherited layer properties.

8. Open the Layer drop-down menu in the Layers panel, and set Layer 0 as the current layer.

9. Open the Layer drop-down menu again, and toggle off the Door layer. All the chairs and doors disappear because the geometry in the chair and door block definitions is on the Door layer. Toggle on the Door layer, and click outside the Layer drop-down menu to close it.

10. Select the lower chair, right-click, and choose Edit Block In-Place from the context menu. Click OK in the Reference Edit dialog box that appears.

11. Create an implied window to select all nine objects making up the chair.

12. Open the Layer drop-down menu, and select layer 0 to assign this layer to the selection. Press Esc to deselect the layer.

13. Expand the Edit Reference panel, and click the Save Changes button. Click OK in the AutoCAD warning dialog box.

14. Open the Layer drop-down menu in the Layers panel, and toggle off the Door layer. The doors disappear but the chairs remain because the chair references have inherited the Furniture layer (see Figure 7.18).
**Blocks and Layer 0**

I recommend that you always draw objects within block definitions on layer 0 so that block references will inherit the layer on which they are inserted. Layer 0 is the only layer that works like this for block definitions. In addition, you should assign floating properties for the color, linetype, and/or lineweight of the objects in the block definition.

![Figure 7.18](image)

**FIGURE 7.18** Turning off the Door layer hides the doors but not the chairs when the chair block definition geometry is on layer 0.

15. Toggle on the Door layer.

16. Save your work as Ch7-E.dwg (or Ch7-E-metric.dwg).

**Nesting Blocks**

You can *nest* blocks within other blocks to simplify complex block definitions. However, you can’t create circular references where blocks reference themselves or you’d create an infinite loop. In the following steps, you’ll nest a phone block reference inside the desk block definition so that every desk you insert will have a phone on it.

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-E.dwg (or Ch7-E-metric.dwg), and open it.

2. Type `BEDIT` (for Block Editor), and press Enter. Select Desk in the Edit Block Definition dialog box that appears (see Figure 7.19). Click OK.

3. A temporary tab called Block Editor appears on the ribbon, and the selected block (desk) fills the drawing canvas. Click the Authoring Palettes tool on the Manage panel to toggle them off because they are not needed for this exercise (see Figure 7.20).

The Block Editor is an alternative to editing blocks in place.
1. Type I (for Insert), and press Enter. Select Phone in the Name drop-down list. Deselect Specify On-Screen in the Scale and Rotation sections of the Insert dialog box and click OK.

2. Click an arbitrary point on the right side of the desk to insert the phone block reference there.

3. Select the phone block, type qp (for Quick Properties), and press Enter. Change Layer Assignment to Equipment, click the close box to exit Quick Properties, and press Esc to deselect (see Figure 7.21).

4. Click the Close Block Editor button on the Close panel. Click Save Changes To Desk in the Block – Changes Not Saved dialog box that appears.

5. Save your work as Ch7-F.dwg (or Ch7-F-metric.dwg).

**Exploding Blocks**

There are two commands that blow away blocks, leaving you with only their defining geometry: EXPLODE and XPLODE. The former has no options whatsoever;
the latter offers many options dealing with what happens to object properties after the block is disassembled. Let’s explode a block using both methods:

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-F.dwg (or Ch7-F-metric.dwg), and open it.

2. Type X (for Explode), and press Enter. Select the magenta chair, and press Enter.

3. Select the parts of the chair, and observe in the Layers panel that the objects are on layer 0 and in the Properties panel that their color is set to ByBlock (see Figure 7.22). Press Esc to deselect.

**Figure 7.21** A phone nested within the desk block and surrounding chair blocks

**Figure 7.22** Investigating the layer assignment and object properties of an exploded block

*Use the PURGE command to delete unused block definitions to make the drawing file smaller.*
4. Click the Undo button on the Quick Access toolbar. The block is re-created.

5. Type *xp* (for Xplode), and press Enter. Select the magenta chair, and press Enter. The command prompt reads:

   [All Color Layer LType LWeight
   Inherit from parent block Explode]
   <Explode>:

   Type I (for Inherit from parent block), and press Enter.

6. Select all the parts of the chair, and observe that the objects are on the blue Furniture layer and their color is explicitly set to magenta. This time the disassembled objects received the layer assignment and object properties of the block reference.

7. Expand the Modify panel, and click the Set To ByLayer tool. The command prompt reads:

   Change ByBlock to ByLayer? [Yes No] <Yes>:

   Press Enter to accept the default Yes. Now the prompt says:

   Include blocks? [Yes No] <Yes>:

   Type N (for No), and press Enter. The SETBYLAYER command ends. The chair is now blue, because its color has been set to ByLayer.

8. Save your work as Ch7-G.dwg (or Ch7-G-metric.dwg).

Redefining Blocks

You already know that block definitions have names and that blocks are inserted by name. So what do you suppose happens if you define a new block using a name that has already been used in the drawing?

In the following steps, you are presented with just such a situation where you will have the opportunity to redefine a block definition. Any block references in the drawing will be automatically updated with the new definition.

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-G.dwg (or Ch7-G-metric.dwg), and open it.

2. Zoom into the lower chair you exploded in the previous section.
3. Click the Rectangle tool on the Draw panel. The command prompt reads:

Specify first corner point or [Chamfer Elevation Fillet Thickness Width]:

Type **F** (for Fillet), and press Enter. The prompt now says:

Specify fillet radius for rectangles <0’-0”>: 

Type **1”** (or **3 cm**), and press Enter. The rectangle will have rounded corners.

4. For the first corner, click point A, as shown in Figure 7.23. Then type **@3,-10** (or **@7,-25** for metric), and press Enter to complete the RECTANGLE command.

![Figure 7.23 Drawing an armrest](image)

5. Click the Mirror tool in the Modify panel. Type **L** (for Last), and press Enter twice. The command prompt reads:

Specify first point of mirror line:

Snap to the midpoint of the chair's front edge, toggle on Ortho on the status bar, move the cursor downward, and click on the drawing canvas to specify the second point of the mirror line. Press Enter to complete the MIRROR command (see Figure 7.24).

6. Select all objects in the chair and its armrests. Open the Layer drop-down menu, and select layer 0 to change the assignment of the selected objects.

7. Type **B** (for Block), and press Enter. Type **Chair** in the Name field in the Block Definition dialog box. Click the Pick Point button, and then snap to the midpoint of the chair's front edge.
8. Select the Convert To Block radio button in the Objects section of the Block Definition dialog box and click OK. Click Redefine Block in the Block – Redefine Block dialog box that appears. Figure 7.25 shows the result: All three chair block references are updated.

![Figure 7.24](image1.png) **Figure 7.24** Mirroring an armrest

![Figure 7.25](image2.png) **Figure 7.25** Redefining the chair block causes the chairs to lose their original orientation.

9. Unfortunately the redefined chair block references didn’t preserve their original orientations. No matter; click the Mirror tool on the Modify panel, select the top two chairs, and press Enter. Snap to the front edge of one of the seats, move the cursor to the right, and click on the drawing canvas. The command prompt reads:

    **Erase source objects? [Yes No] <N>:**

Type Y (for Yes), and press Enter. The chairs are now oriented correctly (see Figure 7.26).
Working with Groups

Groups are a means of organizing objects that is less formal than blocks. Groups don’t need to be named, nor do they require base points as do blocks. You can toggle group selection on and off so that you can manipulate the entire group as a unit or access individual members of the group at will. You can’t redefine the many with the few as you can with blocks, however. That said, it’s certainly convenient to be able to manipulate many blocks with a few groups. In the following steps, you will group the desk and chairs, copy this group into adjacent rooms, and make adjustments to various blocks within the groups.

1. If the file is not already open, go to the book’s web page, browse to Chapter 7, get the file Ch7-H.dwg (or Ch7-H-metric.dwg), and open it.

2. Click the Group tool on the Groups panel on the ribbon’s Home tab. Select the desk and the three chairs surrounding it, and then press Enter.

3. Click the Copy tool on the Modify panel, click the group to select it, and press Enter. Click an arbitrary point inside the desk, and then click in the middle and right rooms to copy the group twice. Press Esc to end the COPY command.

10. Save your work as Ch7-H.dwg (or Ch7-H-metric.dwg).
4. Click the Rotate tool on the Modify panel, select the group in the room on the right, and press Enter. Click an arbitrary point inside the desk, type \(-90\), and press Enter (see Figure 7.27).

5. Click the Group Selection On/Off toggle in the Groups panel (turning it off).

6. Select the lower chair in the middle room, and press the Delete key.

7. Click the Copy tool on the Modify panel, select the chair on the right in the middle room, and press Enter. Snap to the midpoints at points A and B shown in Figure 7.28 and press Enter. A third chair is copied so that all three are equidistant.

8. Click the Mirror tool on the Modify panel, select the three chairs in the middle room, and press Enter. Click point C shown in Figure 7.28, move the cursor to the right, and click in the drawing canvas to complete the mirror line. Press Enter to mirror three more chairs on the opposite side of the desk.
9. Type \texttt{xp} (for Xplode), and press Enter. Select the desk, and press Enter. Type \texttt{I} (for Inherit from parent block), and press Enter.

10. Click the Stretch tool on the Modify panel; select the right edge of the desk with a crossing window so that the top, bottom, and right edges are selected; and press Enter. Click an arbitrary point inside the desk, move the cursor to the right, type \texttt{2’6”} (or \texttt{80} for metric), and press Enter. The desk is enlarged.

11. Select the phone block on the desk, and press the Delete key.

12. Click the Group Edit tool on the Groups panel, select the upper-left chair in the middle room, and press Enter. The command prompt reads:

   \begin{center}
   Enter an option [Add objects Remove objects RENAME]:
   \end{center}

   Type \texttt{A} (for Add objects), and press Enter. Select all six chairs and the desk, and then press Enter.

13. Click the Group Selection On/Off toggle in the Groups panel (turning it on). Hover the cursor over the desk, and observe that the entire group is highlighted (see Figure 7.29).

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{figure729.png}
\caption{Reconstituted group after its constituent objects have been deleted, added, and stretched}
\end{figure}

14. Open the Layer drop-down menu, and toggle on the Door layer. Figure 7.30 shows the final result.
In this chapter, you learned how to organize objects into blocks and groups. More specifically, you defined, inserted, edited, nested, exploded, and redefined blocks. You saw how floating properties and layer 0 affect property inheritance when block references are inserted into a drawing. Finally, you worked with groups, manipulated them as whole units, accessed their individual members, and added objects to an existing group. In short, you now have the skills to organize objects for efficient drafting.

**Additional Exercise**

Explore the `BCONSTRUCTION` command on your own. It is used to convert geometry into construction geometry that is only visible within the Block Editor for layout purposes. For example, try drawing a mirror line down the center line of the chair block and converting it to construction geometry with the `BCONSTRUCTION` command. The mirror line serves as a helpful visual reference while in the Block Editor, but the construction geometry will not be displayed in the block reference.

Your drawing should now resemble `Ch7-Final.dwg` (or `Ch7-Final-metric.dwg`), which is available among the book’s download files at [www.sybex.com/go/autocad2014essentials](http://www.sybex.com/go/autocad2014essentials).
The term *hatching* refers to filling bounded areas with solids, patterns, and/or gradients. You create hatching in the AutoCAD® program to indicate transitions between materials and to improve the readability of drawings in general. Hatching with solid fill, patterns, and/or tonal gradients can transform staid line drawings into attractive illustrations. This chapter covers the basics of hatching so that you can use it in your own drawings.

- Specifying hatch areas
- Associating hatches with boundaries
- Hatching with patterns
- Hatching with gradients

**Specifying Hatch Areas**

Every hatch area is defined by a boundary containing the solid fill, pattern, or gradient. You can determine the boundary either by picking a point on the drawing canvas or by selecting an object or set of objects.

**Picking Points to Determine Boundaries**

When a boundary is picked, AutoCAD uses a raycasting algorithm to determine the precise extents of the area bounded by the objects on screen. In the following steps, you will pick points to determine the boundaries of multiple hatch objects:

1. Go to the book’s web page at [www.sybex.com/go/autocad2014 essentials](http://www.sybex.com/go/autocad2014 essentials), browse to Chapter 8, get the file Ch8-A.dwg, and open it. The drawing is based on a 100-year-old patent for fluid
propulsion (CA 135174) by Nikola Tesla (see Figure 8.1). Tesla is best known for inventing the alternating electrical current that powers the modern age.

**Figure 8.1** Initial line drawing based on Tesla’s patent for fluid propulsion

2. Zoom into the center of the rotor in the drawing on the left.

3. Click the Hatch tool in the Draw panel on the ribbon’s Home tab. Click point A in Figure 8.2.

**Figure 8.2** Picking a point to detect a boundary
Specifying Hatch Areas

4. A temporary contextual tab called Hatch Creation appears on the ribbon. This tab will remain active while you configure the hatch object that you are creating. Click Solid in the Pattern panel, and turn off Associative mode if it is on by clicking its button in the Options panel (see Figure 8.3). (You’ll learn about associative hatches in the next section.)

![Figure 8.3 Using ribbon controls when creating a hatch](image)

5. Expand the Options panel, open the Island Detection menu, and select Outer Island Detection. The thumbnails indicate different ways of treating nested boundaries, called **islands**. In this case, you want only the outer island filled with a solid hatch.

6. Open the Hatch Color drop-down in the Properties panel, and choose Select Colors at the bottom of the list of standard colors. Choose color 255 from the Select Color dialog box and click OK (see Figure 8.4).

![Figure 8.4 Selecting a color override for the hatch object](image)

7. Expand the Properties panel, open the Hatch Layer Override drop-down, and select the Solid layer (see Figure 8.5).

You can override a hatch object’s default color, transparency, and layer assignment on the Hatch Creation tab’s Properties panel.
8. Click the Close Hatch Creation icon in the Close panel at the extreme right edge of the ribbon’s Hatch Editor tab. The outer island is filled with a solid hatch object, and the HATCH command ends.

9. Type H (for Hatch), and press Enter. Click point B in Figure 8.2.

10. Open the Hatch Color drop-down in the Properties panel, and choose Select Colors at the bottom of the list of standard colors. Choose color 253 from the Select Color dialog box and click OK.

11. Click the Close Hatch Creation icon in the Close panel.

12. Press the spacebar to repeat the last command. Click point C in Figure 8.2.

13. Open the Hatch Color drop-down in the Properties panel, and choose Select Colors at the bottom of the list of standard colors. Choose color 250 from the Select Color dialog box and click OK.

14. Click the Close Hatch Creation icon in the Close panel. The Hatch Editor tab disappears.

15. Click the Isolate tool on the Layers panel of the ribbon’s Home tab, drag a crossing selection over the hub, and include the selection of at least one of the dashed blue lines defining the edge of a spoke. Press Enter, and all the other layers are hidden, leaving the entire rotor.

All the settings and overrides in the Hatch Creation tab are “sticky,” meaning that they remain the same the next time you create a hatch object.
16. Click the Hatch tool on the Draw panel, and then click point A in Figure 8.6.

![Figure 8.6: Picking points on the rotor](image)

17. Open the Hatch Color drop-down in the Properties panel, and choose Select Colors at the bottom of the list of standard colors. Choose color 255 from the Select Color dialog box and click OK.

18. Drag the Hatch Transparency slider to the right until the value is approximately 50 (see Figure 8.7).

![Figure 8.7: Overriding layer transparency within the HATCH command](image)

19. Toggle on the Show/Hide Transparency button on the status bar. The hatch pattern you just created appears partially transparent.

20. Type H (for Hatch), and press Enter. Click point B in Figure 8.6. The command prompt reads:

   Analyzing the selected data...
AutoCAD can’t find this particular area; press Esc before the program crashes.

21. Save your work as Ch8-B.dwg.

Selecting Objects to Define Boundaries

In complex drawings, picking points to determine boundaries sometimes doesn’t work. Fortunately, you can always define boundaries successfully using closed objects. In the following steps, you will select two closed objects to define a hatch boundary.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 8, get the file Ch8-B.dwg, and open it.

2. In the previous section, the raycasting algorithm probably had trouble with the inner part of the rotor where the arcs and splines meet. To simplify the boundary, you will draw a circle. Click the Circle tool on the Draw panel.

3. Shift+right-click, and choose Node from the context menu. Click point A, shown in Figure 8.8, as the center point. Type **QUA** (for Quadrant), and press Enter. Click point B, also shown in Figure 8.8, to set the inner circle’s radius. The CIRCLE command ends.

![Figure 8.8 Drawing a circle](image)
4. Type **H** (for Hatch), and press Enter. Click the Select Boundary Objects tool in the Boundaries panel of the ribbon’s Hatch Editor tab. Select the circle making up the inner circle of the rotor, and then select the single outer circle. Select Solid in the Pattern panel and press Enter. The hatch appears correctly (see Figure 8.9); click the Close Hatch Editor icon in the Close panel at the extreme right edge of the Hatch Editor tab.

5. Click the Erase tool on the Home tab’s Modify panel. Select the inner circle you drew in step 3 and press Enter.

6. Type **REGEN** and press Enter. The dashed arcs are again visible.

7. Save your work as Ch8-C.dwg.

**Associating Hatches with Boundaries**

When hatches are associated with their boundary objects, the boundary objects themselves define the extents of the hatch fill, pattern, or gradient. Altering the shape of any of the boundary objects necessarily changes the extents of an associated hatch object. For example, the rotor needs to have a larger diameter, and...
by associating the hatch with the outer circle, you will be able to get the hatch to expand to fill the larger rotor simply by changing the diameter of the circle. When hatches are not associated with their boundary objects, altering the boundary objects does not change the shape of the hatch.

In the following steps, you will re-create the boundary objects from the last hatch pattern created in the previous section. Then you will alter the shape of one of the boundary objects to change the extents of the solid hatch.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 8, get the file Ch8-C.dwg, and open it.

2. Click the outer portion of the rotor to select the hatch object; the Hatch Editor tab appears on the ribbon.

3. Click the Recreate Boundary tool on the Boundaries panel. The command prompt reads:

   Enter type of boundary object [Region Polyline] <Polyline>:

   Press Enter to accept Polyline as the default option. Now the prompt says:

   Associate hatch with new boundary? [Yes No] <Y>:

   Press Enter again to accept the default, Yes. Two new circles are created and associated with the hatch.

4. Click the Close Hatch Editor icon in the Close panel.

5. Toggle on Object Snap on the status bar. Right-click this toggle button, and turn on Center, Quadrant, and Endpoint running object snap modes in the context menu if they are not already on.

6. Toggle on Ortho mode on the status bar.

7. Toggle on Object Snap Tracking on the status bar.

8. Click the Scale tool on the Modify panel, select the rotor’s outer circle, and press Enter. Select the center of the rotor (point A in Figure 8.10) as the base point. The command prompt reads:

   Specify scale factor or [Copy Reference]:

   Type R (for Reference), and press Enter. Pick the reference length by clicking points A and B in Figure 8.10.

9. Hover the cursor over point C, as shown in Figure 8.10. Then bring the cursor back toward point D. When the tracking X appears on the
Associating Hatches with Boundaries

drawing canvas, click point D. When the SCALE command ends, the rotor matches its depiction in the drawing on the right and the solid associative hatch fills the new boundary.

**FIGURE 8.10** Scaling up the outer circle of the rotor enlarges its associative hatch.

10. Click the outer portion of the rotor to select the hatch object; the Hatch Editor tab appears on the ribbon.

11. Convert the object into a nonassociative hatch by clicking to toggle off the Associative button in the Options panel, and then click the Close Hatch Editor icon.

12. Click the Erase tool on the Modify panel, select the two re-created boundaries as shown in Figure 8.11, and press Enter.

**FIGURE 8.11** Deleting the re-created boundary objects
13. Click the Unisolate tool on the Layers panel.

14. Save your work as Ch8-D.dwg.

Accessing the Hatch Edit Dialog Box

You can access all the hatching tools that you see on the ribbon in a dialog box interface by selecting a hatch object using the HATCHEDIT command. You’ll see this dialog box when using the HATCH command if you are using a workspace that doesn’t have the ribbon (such as AutoCAD Classic).

Hatching with Patterns

Hatch patterns are repeating arrangements of lines and/or dots used to identify a material or a cutting plane, or to highlight an area visually. You’ll learn how to specify pattern properties, separate hatch areas, and set the origin point of the pattern.
Specifying Properties

Hatch patterns have a few additional properties as compared to solid hatch objects. In the following steps, you will select a pattern, set its scale, and adjust the pattern angle.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 8, get the file Ch8-D.dwg, and open it.

2. Pan over to the drawing on the right.

3. Click the Hatch tool on the Draw panel.

4. Click points A through F inside the red housing, as shown in Figure 8.12. A solid hatch appears within the red boundaries.

If AutoCAD says the boundary is not closed, try increasing the Gap Tolerance in the Options panel. For example, you might try a value of 0.1.
5. Select the pattern called ANSI31 in the Pattern panel if it is not already selected. Select Red in the Color drop-down in the Properties panel. Select Color 255 in the Background Color drop-down. Repeatedly click the Scale up arrow to increase the value to 2.0000. Expand the Properties panel, and select Pattern from the Hatch Layer Override drop-down (see Figure 8.13).

![Figure 8.13 Configuring hatch properties](image)

6. Click Close Hatch Editor in the Close panel.

7. Save your work as Ch8-E.dwg.

**Separating Hatch Areas**

When you picked points within multiple boundaries in the previous section, doing so formed a single hatch object. The properties you specified were assigned to this object. However, at this point we want to rotate the cross-sectional pattern 90° on the right side to illustrate the separate pieces of metal that are bolted together. In the following steps, you will separate the multiple bounded areas of a single object into individual hatch objects and then rotate patterns on half of them:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 8, get the file Ch8-E.dwg, and open it.

2. Select the hatch object you created in the previous section.

3. Expand the Options panel, and click Separate Hatches (see Figure 8.14).
4. Click Close Hatch Editor in the Close panel.

5. Select the upper-right hatch pattern, type 90 in the Angle text box, and press the Tab key. Click the Set Origin button, and then click point A shown in Figure 8.15. Press Esc to exit the ribbon’s Hatch Editor tab.

6. Select the hatch pattern on the left side, click the Set Origin button, click point A as shown in Figure 8.15, and press Esc. The outer patterns on the left and right both meet symmetrically at point A.

Exploding hatch patterns removes their associativity (if any). Exploding them again converts the hatch pattern into its constituent lines; background color fill is lost in the process.
7. Select the pattern in the lower right, click the Match Properties tool in the Options panel, and select the upper-right pattern. Press Esc to deselect; the lower pattern matches the upper pattern’s angle.

8. Select the inner pattern on the right. Click the Match Properties tool in the Options panel, and select the lower-right pattern.

9. Click the Set Origin button, and click point B in Figure 8.16. Press Esc to deselect.

10. Select the inner pattern on the left. Click the Set Origin button, and click point B in Figure 8.16. Press Esc to deselect. The inner patterns on the left and right both meet symmetrically at point B. Figure 8.17 shows the result.

11. Save your work as Ch8-F.dwg.

Hatching with Gradients

In addition to hatching with solid fill and line patterns, you can hatch with one- and two-color \textit{gradients} to vary tonality in a smooth fashion. Gradients can subtly hint at an extra dimension that helps make drawings more readable. In the following steps, you will create gradient hatches that give depth to metal parts in the drawings.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 8, get the file Ch8-F.dwg, and open it.
2. Open the flyout next to the Hatch tool on the Draw panel, and select Gradient from the menu. Click the Pick Points button in the Boundaries panel and then click points A through F shown in Figure 8.18.

3. Scroll down in the Pattern panel, and select the GR_CURVED gradient. In the left column of the Properties panel select Color 253 (see Figure 8.19) in the Gradient Color 1 drop-down. In the right column, click the Gradient Tint and Shade button to create a one-color gradient. At the top of the right column, drag the Hatch Transparency slider all the way to the left until its value reads 0. Expand the Properties panel and select Gradient in the Hatch Layer Override drop-down. Click the Close Hatch Creation icon at the right edge of the ribbon.
4. Zoom in on the rotor shaft.

5. Type **GRADIENT**, and press Enter. Click a point in the center of the shaft to determine the boundary for a new gradient hatch. Select the GR_CYLIN pattern, set Angle to 90, and select Color 250 in the Gradient Color 1 drop-down. Click the Close Hatch Creation icon. Figure 8.20 shows the result.
6. Objects typically overlap other objects that were drawn earlier. Type `HATCHTOBACK`, and press Enter. All hatch objects (solid fills, patterns, and/or gradients) are sent to the back of the draw order stack so that they don’t overlap any of the other objects in the drawing.

7. Your drawing should now resemble Ch8-G.dwg, which is available for download at the book’s web page.
The Essentials and Beyond

In this chapter, you have learned how to create hatch objects that are filled with solid color, line patterns, and/or gradients. You now have the tools to improve the readability of your drawings by graphically indicating transitions between materials and section cutting planes, and by adding depth to parts with variable shading.

Additional Exercise

Explore the WIPEOUT command on your own. Think of wipeouts as solid hatches that completely obscure what they cover with the current canvas background color. They can be useful in complex drawings when you want to wipe out areas to make room for notes. Try creating a wipeout object that obscures a portion of the upper rotor blades in the cross-sectional drawing on the right of Ch8-G.dwg.
Working with Blocks and Xrefs

In Chapter 7, “Organizing Objects,” you learned how to define and reference blocks within a single drawing in the AutoCAD® program. In this chapter, you will create and insert global blocks from outside the current drawing. Harnessing the power of a search engine, you’ll cast a net across multiple drawings to locate specific blocks and a variety of other content. Once key content is found, you will place it on tool palettes for quick access in the future. In addition, you will make external references (Xrefs) to drawings outside the current file.

- **Working with global blocks**
- **Accessing content globally**
- **Storing content on tool palettes**
- **Referencing external drawings and images**

### Working with Global Blocks

Global blocks are drawing files that you will later insert as blocks into another drawing. In this section, you will learn how to write local blocks to files, insert a drawing file as a local block, and redefine local blocks with global blocks.

### Writing a Local Block Definition to a File

In the following steps, you will export one of the current drawing’s block definitions to an individual drawing file. In addition, you will open the newly created file and alter its contents.

2. Type \textbf{W} (for Write block), and press Enter. Select the Block radio button in the Source area of the Write Block dialog box. Select Sofa from the Block drop-down. Select Inches from the Insert Units drop-down in the Destination area (see Figure 9.1). Click OK, and the geometry within the Sofa block definition is written to \texttt{Sofa.dwg}.

![Write Block Dialog Box](image)

\textbf{FIGURE 9.1} Writing a block to a file

The Sofa block that was written to \texttt{Sofa.dwg} does not itself have a Sofa block definition; only the geometry was transferred to the new file.

3. Click the Open tool on the Quick Access toolbar. Browse to the following folder:

\texttt{C:_documents and settings/your user name/my documents}

Open \texttt{Sofa.dwg} (see Figure 9.2).

![Open Sofa.dwg](image)

\textbf{FIGURE 9.2} Open the Sofa.dwg file.

4. Click Zoom Extents on the Navigation bar.

5. Click the Erase tool on the Modify panel, select the two arcs in the sofa's backrest, and press Enter.
6. Toggle on Ortho mode on the status bar.

7. Toggle on Object Snap on the status bar. Right-click the Object Snap toggle, and select Endpoint if it is not already selected.

8. Click the Line tool on the Draw panel. Snap the first point of the line to the endpoint shown in Figure 9.3. Move the cursor to the right, and click an arbitrary second point. Press Esc to end the LINE command.

9. Click the Fillet tool on the Modify panel. Press F2 to open the Command window, and verify that the command prompt says the following:

   Current settings: Mode = TRIM, Radius = 0'-0"

   If the radius is not 0, type R (for Radius), press Enter, type 0, and press Enter again. Select the line you just drew, and then click the inner line on the right arm of the sofa.

10. Press the spacebar to repeat the FILLET command. Click the inner line on the left arm of the sofa, and then click the back line. Figure 9.4 shows the result.

   FIGURE 9.3 Drawing a straight-backed sofa

   FIGURE 9.4 Filleting lines to meet at sharp corners
11. Click the Offset tool on the Modify panel. Click points A and B in Figure 9.5 to set the offset distance. Select the back line of the sofa, and then click above it to offset another line.

![Figure 9.5: Offsetting the back of the sofa a distance equal to the thickness of the armrests](image)

12. Click the Fillet tool on the Modify panel. Select the line you just offset, and then click the outer line on the right arm of the sofa.

13. Press the spacebar to repeat the FILLET command. Click the outer line on the left arm of the sofa, and then click the top back line. The sofa redesign is complete (see Figure 9.6).

![Figure 9.6: Redesigned sofa drawing](image)

14. Click the Save As tool on the Quick Access toolbar. Type *Sofa2.dwg* in the File Name text box, and then click the Save button.

15. Type **CLOSE**, and press Enter to close the file you just saved.
Inserting a Drawing as a Local Block

When you insert a DWG file that has global scope into the current drawing, it comes in as a block. In the following steps, you will insert the new sofa block twice into the same file in which you started this chapter:

1. If the file is not already open, go to the book’s web page, browse to Chapter 9, get the file Ch9-A.dwg, and open it.

2. Zoom into the upper-right building quadrant, select the two armchairs and round side table, and press the Delete key (see Figure 9.7).

3. Toggle off Object Snap on the status bar.

4. Click the Make Object’s Layer Current tool in the Layers panel. Click the Manager’s chair and A-furn becomes the current layer.

5. Click the Insert tool on the Block panel. The Sofa2 block is not yet defined in this drawing’s block table, so you won’t find it in the Name drop-down. Click the Browse button and locate the Sofa2.dwg file you saved in the previous exercise, or use the Sofa2.dwg file provided in the Samples folder for Chapter 9. Select Specify On-screen for both Insertion Point and Rotation in the Insert dialog box (see Figure 9.8) and click OK.
FIGURE 9.8 Configuring a global block in the Insert dialog box.

6. Click approximately where you deleted the armchairs and side table to insert a Sofa2 block reference in the drawing, and estimate the rotation angle so that the sofa is parallel to the exterior wall (see Figure 9.9).

7. Pan down to the lower-right building quadrant. Delete the two armchairs and side table there.

FIGURE 9.9 Inserting the new sofa
8. Type I (for Insert), and press Enter. Sofa2 is already selected in the Name drop-down. No path is listed in the Insert dialog box this time because Sofa2 was defined as a local block when you inserted it in step 5. Click OK.

9. Click approximately where you deleted the armchairs and side table to insert a Sofa2 block reference in the drawing, and rotate it so that the sofa is again parallel to the exterior wall (see Figure 9.10).

10. Save your work as Ch9-B.dwg.

**Figure 9.10** Inserting Sofa2 again as a local block

---

**Redefining Local Blocks with Global Blocks**

When you insert a global block with the same name as a local block, the local block is redefined. In the following steps, you will redefine the original sofa block with the new sofa design:

1. Click the Open tool on the Quick Access toolbar. Browse to the following folder:

   C:\Documents and Settings\<your user name>\My Documents

   Open Sofa2.dwg (see Figure 9.6).
2. Click the Save As tool on the Quick Access toolbar. Save the file as Sofa.dwg, and click Yes when prompted to replace the file.

3. Type CLOSE, and press Enter.

4. If the file is not already open from the previous section, go to the book’s web page, browse to Chapter 9, get the file Ch9-B.dwg, and open it. Pan over to Reception.

5. Click the Insert tool in the Block panel. Open the Name drop-down, and select Sofa in the list. The preview image in the upper right shows that the local block definition is based on the curved-back design (see Figure 9.11).

6. Click the Browse button in the Insert dialog box. Select the Sofa.dwg file you saved in step 2. Click OK in the Insert dialog box, and the Block – Redefine Block dialog box appears (see Figure 9.12). Notice that it says that there are two Sofa block references in the drawing. These are two sofas in Reception. Click Redefine Block.

FIGURE 9.11 Examining the preview of the local block definition in the Insert dialog box

FIGURE 9.12 You are asked whether you want to redefine a block before it is done.
7. The two sofas in Reception are redefined with the straight-back design (see Figure 9.13). Press Esc to cancel the INSERT command; you do not need to insert a new block reference.

8. Save your work as Ch9-C.dwg.

![Figure 9.13](image)

**Figure 9.13** Two local block references redefined with a global block

## Accessing Content Globally

The Content Explorer allows you to search for—and insert—content from **within** other drawings on your local area network (LAN) and on Autodesk Seek on the Web. Using the Content Explorer to locate and insert blocks is much more efficient than writing blocks to files and then inserting the resulting files into drawings, as you learned in the previous section.

There are two reasons for the increased efficiency of the Content Explorer:

- You can access all the blocks within every file in your search path.
- Harnessing the power of a search engine gets you to what you are looking for much faster than a manual search.

Any file that can be opened, imported, or attached is indexed in the Content Explorer. In the following steps, you will use the Content Explorer to search for blocks and other types of content:

1. If the file is not already open, go to the book’s web page, browse to Chapter 9, get the file Ch9-C.dwg, and open it.
2. Click the Plug-Ins tab on the ribbon, and click the Explore tool on the Content panel; the Content Explorer appears (see Figure 9.14).

3. Click the Configure Settings button in the Content Explorer.

4. Click the Add Watched Folder button in the Configuration Console dialog box. Add the following path (if it’s not already there):

   \C:\Program Files\Autodesk\AutoCAD 2014\Sample

   Click OK in the Edit Watched Folder dialog box that appears. AutoCAD goes to work indexing the watched folder (see Figure 9.15). Click the Close button in the Configure Console dialog box. The indexing process will take approximately 10 minutes before all the content in the Sample folder will be available in the Content Explorer.
5. Double-click the Sample folder that appears in the Content Explorer. Then double-click Sheet Sets, Architectural, and A-03.dwg. The Content Explorer shows all the block references, block definitions, layers, layouts, and styles present in the drawing (see Figure 9.16).

6. You can click on any of the breadcrumbs to go to specific folders in the local path. Alternatively, you can access online content. Open the Content Sources menu, and select Autodesk Seek. Double-click the Chairs folder, and select this item in the list: Zody Task Chair With Fixed Arms (see Figure 9.17).

7. Double-click the selected item. The page that appears in the Content Explorer lists the available files. Right-click the first icon—SZT-20-122 MA1, 2D—for the two-dimensional representation of this chair (see Figure 9.18) and choose Insert. The cursor displays a thumbnail image of the file with a progress bar.
FIGURE 9.17 Searching for chairs

FIGURE 9.18 Selecting a specific file to download
8. When the download is complete, you may be prompted to create a new block name for the content. Type **TaskChair** in the Substitute Block Name dialog box that appears and click OK.

9. Choose an arbitrary location in Reception, and click to insert the chair. Press Enter repeatedly to accept the default scale, rotation, and multiple attribute values.

10. Delete the receptionist’s chair, move the new chair into its place, and rotate it to face the room. Figure 9.19 shows the downloaded chair behind the receptionist’s desk.

11. Save your work as **Ch9-D.dwg**, and close the Content Explorer.

---

**Storing Content on Tool Palettes**

Tool palettes are used for storing just about any type of content for quick reuse. You create tools on a palette by dragging objects—including blocks, hatches, images, dimensions, tables, lights, cameras, materials, visual styles, and Xrefs—onto the palette from any saved drawing.
In the following steps, you'll create a new palette, drag a sofa onto it, and then use the tool to add another sofa:

1. If the file is not already open, go to the book’s web page, browse to Chapter 9, get the file Ch9-D.dwg, and open it.

2. Select the ribbon’s View tab, and click the Tool Palettes button on the Palettes panel (see Figure 9.20).

3. Open the Properties menu on the Tool Palettes panel. The items listed at the bottom of the menu are palette groups. Select Architectural. The Architectural palette group contains one palette, which is also called Architectural.


5. Select the receptionist’s chair. Drag this chair (not using a grip) onto the Furniture palette. TaskChair appears with a preview icon (see Figure 9.21).

6. Right-click the TaskChair tool in the Furniture palette, and choose Properties from the context menu. Change Prompt For Rotation to Yes in the Tool Properties dialog box that appears (see Figure 9.22). Click OK.
Select the Manager’s offices on the other side of the wall behind the receptionist’s chair. Type `UNGROUP`, and press Enter. Erase the manager’s chair immediately behind the receptionist’s chair.

Click the TaskChair tool on the Furniture tool palette. Click the place where the manager’s chair used to be, and then specify the rotation by clicking a second time. Click OK or Cancel to close the Edit Attributes dialog box that appears. Figure 9.23 shows the result.
Referencing External Drawings and Images

External references (called Xrefs) are a more dynamic alternative to blocks. Xrefs linked to the current drawing are automatically updated every time the current drawing is opened. Blocks, on the other hand, must be edited in place or redefined when they are changed. The real efficiency with Xrefs comes when you link one file into multiple drawing files, because changes made to the linked file are automatically reloaded in all the files that have the Xref attached.

In the following steps, you will externally reference a core (elevators, stairs, shafts) and shell (exterior envelope) drawing into the drawing containing items owned by the building tenant (walls, doors, furniture, and so on). The advantage of working this way is that the core and shell generally do not change from floor to floor, whereas the tenant improvement drawings are typically unique to each floor. Changes to the core and/or shell can be made in separate drawings that are linked to all the individual tenant drawings.

1. Go to the book’s web page, browse to Chapter 9, get the file Ch9-CoreShell.dwg, and open it. Figure 9.24 shows the building core and shell.

2. Return to the book’s web page, browse to Chapter 9, get the file Ch9-F.dwg, and open it. Figure 9.25 shows the objects owned by the tenant.
Referencing External Drawings and Images

**Figure 9.24** Core and shell drawing

**Figure 9.25** Tenant improvement floor plan
3. Select the ribbon’s View tab, and click the External References Palette button in the Palettes panel. Open the Attach menu, as shown in Figure 9.26.

![Attach menu](image)

**Figure 9.26** Attaching a DWG file in the External References palette

4. Select Attach DWG from the menu. Select the file Ch9-CoreShell.dwg, and click Open in the Select Reference dialog box.

5. In the Attach External Reference dialog box that appears, deselect Specify On-Screen in the Insertion Point area (see Figure 9.27). Click OK.

![Attach External Reference](image)

**Figure 9.27** Attaching an external reference

You can externally reference DWG, DWF, DGN, PDF, and a variety of image file formats.
6. The core and shell appear faded with respect to the tenant drawing (see Figure 9.28).

7. Select the core or shell to select the single Xref object. Click the Open Reference tool on the Edit panel of the External Reference tab that appears on the ribbon.

8. Redesign the Women’s washroom so that it has three sinks, as shown in Figure 9.29.

9. Type **CLOSE**, and press Enter twice to close and save Ch9-CoreShell.dwg.

10. A balloon appears in the drawing status bar informing you that an external reference has changed (see Figure 9.30). If no notification balloon appears, right-click the Xref that needs to be reloaded in the External References palette and choose Reload. Click the hyperlinked blue text to reload the Ch9-CoreShell Xref. The changes made to the Women’s washroom are now visible in the tenant drawing.

11. Save your work as Ch9-6.dwg.

**FIGURE 9.28** Core and shell drawing is externally referenced into the tenant drawing.

You can adjust the amount of fading the Xref displays in the OPTIONS command on the Display tab within the Options dialog box.
FIGURE 9.29 Redesigning the Women’s washroom for three sinks

FIGURE 9.30 Balloon notification that an Xref has changed
The Essentials and Beyond

In this chapter, you learned how to work with global blocks, the Content Explorer, Tool Palettes, and Xrefs. You learned how to increase drawing and editing efficiency by using blocks and Xrefs. You can now access and work with content beyond the current drawing. This is the key to working in a team, because team members regularly need to share content with one another. Global blocks and Xrefs are the means for exchanging design data within a team. The Content Explorer and the Tool Palettes feature make finding and using design data much easier.

Additional Exercise

Explore the Autodesk Design Center using the ADC command. The Design Center is similar to the Content Explorer but without the search engine functionality. Reopen Ch9-G.dwg if it’s not still open. Expand the folder list in the DesignCenter palette, and navigate to the Chapter_06 folder on your hard drive; then expand Ch6-Final.dwg. Select Blocks, and then drag the Phone-Desk block into the drawing canvas of Ch9-G.dwg. Move this phone to the President’s desk.
Creating and Editing Text

Text is an essential part of every drawing. You use the written word to clarify graphical depictions and delineate your design intent with specific language. It’s good to remember that drawings can be used as part of legal construction documents, and you typically need to clarify your design intent with text that appears on the drawings themselves. In this chapter, you’ll learn how to style text, how to write both lines and paragraphs of text using specialized commands, and how to edit existing text.

- Creating text styles
- Writing lines of text
- Writing and formatting paragraphs of text using MTEXT
- Editing text

Creating Text Styles

The AutoCAD® software can’t help you with your grammar or linguistic style, but it can style the appearance of text. Text styles associate specific fonts, optional text heights, and special effects with text objects. In the following steps, you will create the text styles that you will use in the next section when creating text objects.


2. On the ribbon’s Home tab, expand the Annotation panel and open the first drop-down menu (for text styles). Every drawing has both an Annotative and Standard style by default. Select Manage Text Styles at the bottom of the panel (see Figure 10.1).
3. Click the New button in the Text Style dialog box that appears. Type \texttt{Title} in the New Style dialog box and click OK.

4. Open the Font Name drop-down and select Garamond. The symbol next to the font name indicates this is a TrueType font. Set Font Style to Bold, and deselect Annotative (see Figure 10.2). Click the Apply button.

5. Select Standard in the Styles list on the left side of the Text Style dialog box. Open the Font Name drop-down and select \texttt{simplex.shx}. The symbol next to the font name indicates this is a shape-based font that is specific to AutoCAD. Type $1'-0"$ (or 30 cm) in the Height text box. Type 0.8000 as the Width Factor value in the Effects area so that this style will be 20 percent narrower than the default. Click the Apply, Set Current, and Close buttons (in that order).
6. Save your work as Ch10-B.dwg or Ch10-B-metric.dwg. The styles you created are saved within the drawing even though you can’t see them on the drawing canvas.

Writing Lines of Text

You will use the TEXT command when you want to create a single line of text. TEXT creates independent objects on every line so that these objects are suitable for use in symbols or labels on drawings. You will learn how to create text that fits within a specified linear distance so that the text fits within a rectangle or circle, for example. In addition, you will justify text so that it can be easily reused and its content changed without having to reposition the text every time to maintain alignment with surrounding geometry. You will also discover that text objects can be manipulated and duplicated using many of the commands you already know.

Creating Text to Fit

There are many situations where you will want to fit text within geometric objects. For example, you might employ a rectangular symbol in which a number of room names might be displayed in each case where the symbol is to be used. If a text object were always to fit perfectly within the given rectangle, it would simplify having to create rectangles of different widths for each room in which the symbol is to be used. In the following steps, you will create single-line text, justified to fit within just such a rectangular symbol:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 10, get the file Ch10-B.dwg or Ch10-B-metric.dwg, and open it.

2. Zoom in on the small rectangle in the upper-left corner of the drawing canvas.

3. Click the Offset tool in the Modify panel, type 4” (or 10 cm) to set the offset distance, and press Enter. Select the small rectangle, and then click a point inside the rectangle to offset another smaller rectangle inside.

4. Toggle on Object Snap on the status bar. Right-click the same button, and select both Endpoint and Center running object snap modes if they are not already selected.
5. Open the menu under the Text tool on the Annotation panel, and select Single Line from the menu. The command prompt reads:

```
Current text style: "Standard"
Text height: 1'-0" Annotative: No
Specify start point of text or [Justify Style]:
```

Type **J** (for Justify), and press Enter.

6. The command prompt now reads as follows:

```
Enter an option [Align Fit Center Middle Right TL TC TR ML MC MR BL BC BR]:
```

Type **F** (for Fit), and press Enter.

7. Click points A and B in Figure 10.3. A blinking cursor appears.

![Figure 10.3: Specifying the ends of a fit baseline](image)

**FIGURE 10.3** Specifying the ends of a fit baseline

8. Type **OFFICE**, and press Enter twice. The TEXT command ends and the single line of text appears on the drawing canvas (see Figure 10.4).

![Figure 10.4: Making single-line text fit within a predefined space](image)

**FIGURE 10.4** Making single-line text fit within a predefined space

9. Select the inner rectangle, and press the Delete key.

10. Toggle on Ortho mode on the status bar.

11. Click the Move tool on the Modify panel, type **L** (for Last), and press Enter twice. Click an arbitrary point on the drawing canvas, move the cursor upward from that point, type **2"** (or **5 cm**), and press Enter. The text moves up so that the word **OFFICE** is centered within the rectangle (see Figure 10.5).
FIGURE 10.5  Centering the text within
the rectangle by moving it upward

12. Save your work as Ch10-C.dwg or Ch10-C-metric.dwg.

Justifying Text

AutoCAD has numerous options that let you justify text to suit almost any conceivable geometric situation. In the following steps, you will align text so that it appears centered within a *callout symbol* indicating the drawing and sheet number:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 10, get the file Ch10-C.dwg or Ch10-C-metric.dwg, and open it.

2. Click the Pan tool in the Navigation bar, and drag from right to left to reveal the circle with a line running through it. Press Esc to exit the Pan tool.

3. Type **TEXT**, and press Enter. The command prompt reads:

   **Specify start point of text or [Justify Style]:**

   Type **J** (for Justify), and press Enter.

4. The command prompt now reads:

   **Enter an option [Align Fit Center Middle Right TL TC TR ML MC MR BL BC BR]:**

   Type **MC** (for Middle Center), and press Enter. Type **CEN** (for Center), and click the circle to make the center of the circle the middle point of the text. Press Enter to accept 0 as the default rotation angle. Type **3**, and press Enter twice.

5. Click the Move tool on the Modify panel, type **L** (for Last), and press Enter twice. Click an arbitrary point on the drawing canvas, move the cursor upward from that point, type **18”** (or **40 cm**), and press Enter. The text is centered within the upper semicircle.

6. Save your work as Ch10-D.dwg or Ch10-D-metric.dwg.
Transforming and Creating Text

Text objects can be transformed with the same commands you might use on other types of objects—commands such as MOVE, COPY, ROTATE, SCALE, and MIRROR. In the following steps, you will mirror and copy existing text to create new text objects that you will alter later in the “Editing Text” section. In addition, you will create new text in a different style.

1. If the file is not already open, go to the book’s web page, browse to Chapter 10, get the file Ch10-D.dwg or Ch10-D-metric.dwg, and open it.

2. Click the Mirror tool on the Modify panel, select the text object (3), and press Enter. Click the Endpoint at point A and the Center point at B, as shown in Figure 10.6, to define the mirror. The command line reads:

   Erase source objects? [Yes No] <N>:

   ![Figure 10.6 Mirroring text to create a duplicate text object]

3. Press Enter to accept the default, No, and the MIRROR command is done.

4. Click the Copy tool on the Modify panel, type L (for Last), and press Enter twice. Click an arbitrary point on the drawing canvas, move the cursor to the right from this point, type 4′ (or 140 cm), and press Enter twice. A new text object is created to the right of the text you mirrored in the previous step.

5. Click the Single line text tool on the Annotation panel. The command prompt reads:

   Specify start point of text or [Justify Style]:

Transforming and editing existing text is an alternative to creating new text objects from scratch.
6. Type **S** (for Style), and press Enter. Type **Title** (the name of one of the styles you created in the “Creating Text Styles” section), and press Enter. Title is now the current style.

7. Click point A in Figure 10.7 as the start point of text. The command prompt now reads:

   Specify height <6”>:

   ![Drawing Title](image)

   **FIGURE 10.7** Creating Title text

---

**MIRRORING TEXT**

Set the **MIRRTEXT** system variable to 1 to mirror text as well as objects with the **MIRROR** command. Text mirrored with **MIRRTEXT** set to 1 appears backward or upside down.

![MIRRTEXT example](image)

---

8. Type **1'-6”** (or 45 cm) to specify the text height and press Enter. Press Enter again to accept a default rotation of 0 degrees (horizontal). Type **Drawing Title**, and press Enter twice to end the **TEXT** command.

9. Save your work as Ch10-E.dwg or Ch10-E-metric.dwg.
Writing and Formatting Paragraphs of Text Using MTEXT

The MTEXT command is a word processing program within AutoCAD that treats all the lines and paragraphs you write as a single object. The powerful MTEXT command gives you word wrap, per-letter style overrides, tabs, inline spell checking, control over line spacing, bulleted and numbered lists, column formatting, and many other features.

MTEXT is ideally suited to writing general notes on drawings and other lengthy blocks of text. In the following steps, you will create and format some unusual general notes. Instead of typing multiple paragraphs, you’ll import one of the most famous monologues in the English language and turn it into a series of hypothetical steps.

1. If the file is not already open, go to the book’s web page, browse to Chapter 10, get the file Ch10-E.dwg or Ch10-E-metric.dwg, and open it. In addition, get the file Hamlet.txt and double-click the file to open it in Notepad on the PC or TextEdit on the Mac. Select Format ➔ Word Wrap in Notepad to see the text wrap onto multiple lines if necessary.

2. Press Alt+Tab to switch back to AutoCAD. Pan over to the large rectangle in Ch10-E.dwg or Ch10-E-metric.dwg.

3. Type ST (for Style), and press Enter. Double-click Standard in the Styles list on the left side of the Text Style dialog box. Standard is now the current style. Click the Close button.

4. Open the menu under the Text tool on the Annotation panel, and select Multiline Text from the menu. Click points A and B, as shown in Figure 10.8.

FIGURE 10.8 Specifying the opposite corners of a block of multiline text
5. The Text Editor context tab appears on the ribbon. Expand its Tools panel, and click the Import Text button, as shown in Figure 10.9.

![Figure 10.9](image)

**Figure 10.9**
The Text Editor context tab appears when you're creating or editing multiline text objects.

---

**Context Tab or In-Place Editor**

If you are in a workspace that doesn't support the ribbon (such as AutoCAD Classic), then the Text Editor context tab cannot appear. Instead, you will see the In-Place Editor, which has most of the same functionality.

---

6. Click *Hamlet.txt* in the Select File dialog box that appears. Click Open, and text appears within the large rectangle (see Figure 10.10). The built-in spell checker identifies misspelled words by underlining them in red. Perhaps this is not surprising for English written 400 years ago, but in your own projects, right-click any underlined word that seems incorrect (which most likely wouldn't include company or product names, or technical jargon) for correctly spelled suggestions.

---

7. Drag the cursor from the end to the beginning of the block of text, and highlight all the text. Open the Bullets And Numbering menu, and choose Numbered from the list. The number 1 appears at the start of the text. Click strategic points in the text, and press Enter to separate the paragraph into the numbered notes shown in Figure 10.11. Don't worry if the text extends below the lower edge of the rectangle (it should).
8. Click within the block of text to deselect all text. Drag out a selection that includes the phrase “To be or not to be – that is the question.”

Open the Text Editor Color Gallery drop-down in the Formatting panel and select Red. Click the Make Uppercase button in the same panel (see Figure 10.12).

![Figure 10.12](image)

Choose Make Uppercase from flyout menu

9. Click anywhere outside the block of text on the drawing canvas to end the MTEXT command.

10. Save your work as Ch10-F.dwg or Ch10-F-metric.dwg.
Editing Text

Editing text can mean many different things, from changing content (the words) and text object properties, to creating multiple columns of text. You would be very frustrated indeed if you couldn’t correct typographical errors, because everyone seems to make them. Fortunately, editing text is as simple as double-clicking, highlighting the text in question, and retyping. It is also easy to create multiple columns in AutoCAD by dragging a grip. Creating columns of text can help you fit the required words into the space available on your drawings.

Editing Content and Properties

Editing text content is as simple as double-clicking existing text and typing something new. Editing text properties requires you to use the Quick Properties palette or the Properties panel. In the following steps, you will edit both content and properties:

1. If the file is not already open, go to the book’s web page, browse to Chapter 10, get the file Ch10-F.dwg or Ch10-F-metric.dwg, and open it.

2. Double-click the text in the lower semicircle of the drawing title symbol to invoke the DDEDIT command. The number 3 is highlighted. Type A-4, click outside the editing window on the drawing canvas, and press Esc to stop editing. The bubble now references the hypothetical drawing 3 on sheet A-4 (see Figure 10.13).

3. Toggle on Quick Properties on the status bar, and select the 3 under the text Drawing Title. In the Quick Properties window that appears, change Justify to Middle Left and type Scale: 1/8” = 1'-0" (or Scale: 1:20) in the Contents text box (see Figure 10.14).

4. Press Enter to update the selected object. Press Esc to deselect. Toggle off Quick Properties. Figure 10.15 shows the result.
5. Save your work as Ch10-G.dwg or Ch10-G-metric.dwg.

Working with Columns

You can create multiple columns easily with any multiline text object. This feature is perfect if the text you have written doesn't fit into the space between the drawing and its title block on a typical drawing. Creating multiple columns gives you more layout options, allowing you to find the best fit for paragraphs of text within the space available. In the following steps, you will move object grips to create and size two columns:

1. If the file is not already open, go to the book's web page, browse to Chapter 10, get the file Ch10-G.dwg or Ch10-G-metric.dwg, and open it.

2. Click once on the numbered Hamlet text to select it and reveal its grips. Click the Column Height (bottom) grip, move it upward, and click again, automatically creating two columns, as shown in Figure 10.16.
3. Click the Column Width (middle) grip, and move it to the left to reduce the size of both columns simultaneously. Click to set its new position. Click and move the right grip until it reaches the right edge of the rectangle, and then click to set its new position (see Figure 10.17).

4. The first column is too short compared to the right column. Move the Column Height (bottom) grip down until the text in both columns is roughly equalized. Press Esc to deselect the text. Select the rectangle, and press the Delete key. Figure 10.18 shows the result.

5. Save your work as Ch10-H.dwg or Ch10-H-metric.dwg.
The Essentials and Beyond

In this chapter, you learned how to work with text. You created text styles, wrote and justified single lines of text, and imported multiple paragraphs of text. In addition, you edited and styled multiline text and learned to control its appearance. You should now be able to express yourself in written form within AutoCAD, and thus convey your design intent both graphically and literally.

Additional Exercise

Explore the FIND command on your own. Use it not only to find but also to replace specific words within any of the text in the drawing, its blocks, attributes, dimensions, tables, and/or Xrefs. You can confine a find and replace operation specifically using search options such as Match Case, Search Xrefs, search within Dimension Or Leader Text, and many others. There is an arrow in the lower-left corner of the Find And Replace dialog box that you click to expand the dialog box and thus access all the search options and searchable text types. The following graphic shows the expanded options.
Dimensioning

*Dimensioning is the art* of annotating drawings with precise numerical measurements. The process is generally straightforward in the AutoCAD® program because everything is typically drawn in real-world scale. Dimensions will automatically display the correct measurements as long as the geometric objects to which they refer are drawn to actual size.

In this chapter, you’ll learn the mechanics of dimensioning in model space. Dimensioning in paper space and in viewports is covered in Chapter 13, “Working with Layouts and Annotative Objects.”

- Styling dimensions
- Adding dimensions
- Editing dimensions

**Styling Dimensions**

The appearance of dimensions (the size of text and arrows, the length of extension lines, and so on) is controlled by dimension styles. Every drawing comes with a Standard dimension style, which of course is the current style as there is only one by default. When you create more than one dimension style, you must choose which one is current. New dimension objects are assigned the current dimension style in much the same way that objects and layers or text and text styles work.

You can customize dimension styles and even create sub-styles to control the way different types of dimensions appear according to your personal preferences, or to adhere to a corporate or industry standard established for dimensions. For example, if you want to use architectural tick marks rather than arrowheads for linear and aligned dimensions but want to use arrowheads for radius, diameter, and angular dimensions, these preferences can be encoded in a dimension style and a series of sub-styles.
In the following steps, you will modify the Standard dimension style and create a few sub-styles for specific types of dimensions in preparation for adding dimension objects in the next section:

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 11, get the file Ch11-A.dwg, and open it (see Figure 11.1).

![Figure 11.1](image)

**Figure 11.1** The geometric drawing you will dimension

2. Select the Home tab on the ribbon if it is not already selected. Expand the Annotation panel, and click the Dimension Style tool (see Figure 11.2).

3. As you can see in the Dimension Style Manager, every drawing has Standard and Annotative dimension styles by default (see Figure 11.3). The Standard style is selected by default. Click the Modify button to alter the Standard style.
Styling Dimensions in Multiple Drawings

Modifying dimension styles in a particular drawing in no way affects the dimensions or styles in other drawings. If you want to use the same dimension styles in future drawings, customize the dimension styles in your drawing template.

4. Select the Primary Units tab in the Modify Dimension Style: Standard dialog box. Set Precision to 0.000, and select Trailing in the Zero Suppression section (see Figure 11.4). If you are in a country that uses a comma instead of a period as a decimal separator, select “,” (Comma) in the Decimal Separator drop-down menu.
5. Select the Symbols And Arrows tab. In the Arrowheads section, choose Open 30 from the First drop-down (see Figure 11.5). The Second drop-down automatically matches the first by default, so it now says Open 30 as well.
6. Select the Lines tab. Double-click the Offset From Origin value to select it, type **0.125**, and press Tab (see Figure 11.6). Observe in the preview image how the distance between the object and its extension lines increases. Click OK and Close to save the modifications you’ve made to the Standard style.

![Modify Dimension Style: Standard](image)

**FIGURE 11.6** Increasing the offset from origin distance

---

**Understanding Dimension Styles**

Changing a dimension style automatically updates all existing dimension objects in the current drawing that have that style assigned.

---

7. Type **D** (for Dimension Style), and press Enter. The Dimension Style Manager reappears. Click the New button to open the Create New Dimension Style dialog box. Verify that Start With is set to Standard. Choose Angular Dimensions from the Use For drop-down (see Figure 11.7). Click Continue.
8. The New Dimension Style: Standard: Angular dialog box appears. Select the Symbols And Arrows tab. Change the First arrowhead drop-down to Closed Filled. The Second arrowhead automatically changes to Closed Filled as well (see Figure 11.8). The preview image reveals how the angular dimension will appear. Click OK.

9. Click the New button again in the Dimension Style Manager. Select Radius Dimensions in the Use For drop-down and click Continue. Select Closed Filled in the Second arrowhead on the Symbols And Arrows tab. The preview image again reveals what a radial dimension will look like governed by this sub-style; click OK.
10. Select Standard in the styles list in the left pane of the Dimension Style Manager. The preview image now shows the cumulative effect of the style and its sub-styles: open arrowheads for linear and aligned dimensions and closed filled arrowheads for angular and radial dimensions (see Figure 11.9). Click Close.

![Figure 11.9](image)

**Figure 11.9** The preview image shows how different types of dimensions will appear when they are added to the drawing.

11. Save your work as Ch11-B.dwg. Dimension styles are saved within the drawing.

**Adding Dimensions**

In technical drawings, dimensions are typically measurements for which the designer may be legally responsible. So although it is essential to know how to add specific dimensions to a drawing, it is also useful to use *inquiry commands* that measure linear objects (MEASUREGEOM or DIST) or find areas (AREA) without making specific annotations in the drawing. You will explore how to do so in the following section. In addition, you will add a variety of dimension objects that show specific measurements on the drawing. The section ends with a discussion on how to add a *multileader*, which is text with an arrow pointing to a specific geometric feature in a drawing.
Using Inquiry Commands

Use inquiry commands when you want to find out (but not document) the length, angle, name, and/or area of a specific feature without annotating the drawing with this information. In the following steps, you’ll explore inquiry commands to get these specific types of information from a drawing:

1. If the file is not already open, go to the book’s web page, browse to Chapter 11, get the file Ch11-B.dwg, and open it.

2. Toggle on Object Snap mode on the status bar if it is not already on. Right-click the Object Snap button, and turn on Endpoint and Intersection running object snap modes.

3. Toggle on Dynamic Input on the status bar. Click the Distance tool in the Utilities panel of the Home tab on the ribbon. Click points A and B, as shown in Figure 11.10. The distance 5.000 is shown onscreen, and the command prompt reads:

   Distance = 5.000, Angle in XY Plane = 26.565,
   Angle from XY Plane = 0.000 Delta X = 4.472,
   Delta Y = 2.236, Delta Z = 0.000

   ![Figure 11.10 Measuring the distance between two points](image-url)
4. Open the Measure menu in the Utilities panel, select the Radius tool, and select the circle. The command prompt reads:

Radius = 1.000
Diameter = 2.000

5. Type **A** (for Angle), and press Enter. Select lines A and B, as shown in Figure 11.11. The command prompt now gives the value:

\[ \text{Angle} = 36.87^\circ \]

6. Type **AR** (for area), and press Enter. The command prompt reads:

Specify first corner point or [Object Add area Subtract area eXit] 
<Object>:

7. Press Enter to accept the default Object option, and select the circle. The command prompt gives the values:

Area = 3.142, Circumference = 6.283
8. The area within the circle turns green to give you a visual indication of which area and circumference are measured. Figure 11.12 shows the circle’s area of \( \pi \) and circumference of \( 2 \pi \). Press Esc and the \texttt{MEASUREGEOM} command ends.

![Figure 11.12 Measured area shown in green](image)

**Adding Dimension Objects**

In the following steps, you’ll add dimension objects one at a time using a variety of specialized tools to produce dimensions that are linear, aligned, angular, radial, and so on.

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 11, get the file \texttt{Ch11-B.dwg}, and open it.

2. Toggle on Object Snap mode on the status bar if it is not already on. Right-click this button, and turn on Endpoint and Intersection running object snap modes if necessary.

3. Click the Linear dimension tool on the Annotation panel. Click points A and B to specify the first and second extension line origin points, as shown in Figure 11.13. Click point C to specify the dimension line location.
4. Press the spacebar to repeat the last command. The command prompt reads:

   Specify first extension line origin or <select object>:

   Press Enter to accept the default option (Select Object). Click the top red line, and then click point A, as shown in Figure 11.14.

   ![Figure 11.14](image)
5. Type **DIMCENTER** (for Dimension Center Mark), and press Enter. Select the circle, and a small crosshair symbol appears at the center of the circle.

6. Type **DIMLIN** (the alias for the **DIMLINEAR** command), and press Enter. Click points A, B, and C, as shown in Figure 11.15.

![Figure 11.15 Creating another linear dimension](image)

7. Type **DIMCONTINUE** (for Dimension Continue), and press Enter. Click point A, as shown in Figure 11.10, to add another linear dimension below the previous one. Press Esc to end the command.

8. Open the dimension menu in the Annotation panel, and select the Aligned tool. Click points A, B, and C, as shown in Figure 11.16.

9. Add the four additional aligned dimensions shown in Figure 11.17 measuring 1, 2, 3, and 4 units.
FIGURE 11.16 Adding an aligned dimension

FIGURE 11.17 Adding additional aligned dimensions
10. Open the dimension menu in the Annotation panel, and select the Angular tool. Select lines 1 and 2, as shown in Figure 11.18, and then click point A. Press the spacebar to repeat the \texttt{DIMANGULAR} command, select lines 2 and 3, and then click point B.

![Figure 11.18 Adding angular dimensions](image)

11. Open the dimension menu in the Annotation panel, and select the Radius tool. Select the circle, and then click a point inside the circle to locate the radius value (see Figure 11.19).

12. Save your work as \texttt{Ch11-C.dwg}.

**Adding and Styling Multileaders**

A \textit{multileader} is text with a line tipped by an arrowhead that leads the eye to specific geometric features. Multileader styles control the appearance of leader objects in much the same way that dimension styles control the appearance of dimensions. In the following steps, you will add a leader object and then configure the multileader style.

1. If the file is not already open, browse to Chapter 11, get the file \texttt{Ch11-C.dwg}, and open it.
2. Select the Leader tool in the Annotation panel. Click points A and B, type \textbf{Area of circle} = 3.142 (as shown in Figure 11.20), and then press Ctrl+Enter. You have to use Ctrl in addition to Enter to end the command because Enter by itself advances to the next line.

3. Expand the Annotation panel, and click the Multileader Style button. Click the Modify button in the Multileader Style Manager dialog box that appears.

4. Choose Dot from the Symbol drop-down in the Arrowhead section on the Leader Format tab of the Modify Multileader Style: Standard dialog box (see Figure 11.21). Click OK and Close, and the leader object automatically has a dot on its end.

5. Save your work as Ch11-D.dwg.
Editing Dimensions

Dimensions have grips that allow you to reposition extension lines, the dimension line, and dimension text independently of one another. In the following steps, you will edit the length and location of extension and dimension lines directly with grips, adjust a dimension style to affect the appearance of dimension objects, and use a few specialized dimension-editing commands:

1. If the file is not already open, browse to Chapter 11, get the file Ch11-D.dwg, and open it.

2. Toggle on Object Snap mode on the status bar if it is not already on. Right-click the Object Snap button, and turn on Endpoint and Intersection running object snap modes.

3. Click the horizontal linear dimension with a value of 2.236 to select it. Click the lower-left grip to adjust the length of this extension line. Snap the grip to point A, as shown in Figure 11.22. Press Esc to deselect.
4. Type D (alias for the DIMSTYLE command), and press Enter. Select the Angular sub-style in the Dimension Style Manager that appears, and click the Modify button.

5. Select the Fit tab in the Modify Dimension Style: Standard: Angular dialog box. Select the Text radio button in the Fit Options section (see Figure 11.23). Click OK and Close to close all open dialog boxes. The angular values appear outside the lines being measured.
6. Type **DIMEDIT** (for Dimension Edit), and press Enter. The command prompt reads:

   Enter type of dimension editing
   [Home New Rotate Oblique] <Home>: 

7. Type **N** (for New), and press Enter. A text-editing window appears below the last text you entered. Delete the zero.

8. Type **EQ** (for Equal), and then press Ctrl+Enter to end text entry mode. Select both vertical linear dimensions having values of 2.236, and press Enter. Figure 11.24 shows the result.

![Figure 11.24 Editing dimension text content with DIMEDIT](image)

9. Type **DIMTEDIT** (for Dimension Text Edit), and press Enter. Select the aligned dimension with a value of 2 and press Enter. The command prompt reads:

   Specify new location for dimension text or [Left Right Center Home Angle]: 

10. Type **L** (for Left), and press Enter. The dimension text is now left-justified in relation to the dimension line, so the 2 is more easily read within the whitespace left within the red lines (see Figure 11.25).

11. Select the ribbon’s Annotate tab, and click the Break tool on the Dimensions panel. The command prompt reads:

   Select dimension to add/remove break or [Multiple]:
12. Type M (for Multiple), and press Enter. Select the dimensions with values of 2.236, 3, and 5 and press Enter. The command prompt reads:

   Select object to break dimensions or [Auto Remove] <Auto>:

13. Press Enter to accept the default Auto option, and the DIMBREAK command ends. Breaks are made in the selected dimensions where they cross other objects (see Figure 11.26).

14. Your drawing should now resemble Ch11-E.dwg, which is available at this book’s web page.
In this chapter, you took your first steps in the art of dimensioning. You learned how to adjust dimension styles and create new sub-styles; how to add linear, aligned, angular, and radial dimension objects; and how to edit dimensions using a variety of techniques.

Additional Exercise

Explore the `DIMBASELINE` command on your own. Baseline dimensions all reference the same base point to eliminate cumulative errors that can crop up due to rounding errors between consecutive adjacent dimensions. In AutoCAD 2014, new baseline and continued dimension objects appear in the dimension style of the selected dimension object by default. Try creating two sets of baseline dimensions, all in the same dimension style, that reference the left and bottom edges of the diagram shown here:
CHAPTER 12

Keeping In Control with Constraints

Constraints are specific restrictions applied to objects that allow for design exploration while maintaining object shape and/or size within predefined limits. In this chapter, you will create three types of constraints in the AutoCAD® 2014 program: geometric, dimensional, and user-created. Once the design has been sufficiently constrained, you will make a host of geometric and dimensional changes simply by changing a single parameter.

- Working with geometric constraints
- Applying dimensional constraints and creating user parameters
- Constraining objects simultaneously with geometry and dimensions
- Making parametric changes to constrained objects

Working with Geometric Constraints

Geometric constraints allow you to force specific 2D objects to be coincident, collinear, concentric, parallel, perpendicular, horizontal, vertical, tangent, smooth, and symmetric; to have equal lengths; or to be fixed in world space. In the following steps, you will assign sufficient geometric constraints to ensure that a rectangle will always remain square even when it is stretched:

2. Select the Rectangle tool on the Draw panel. Click two points on the drawing canvas to create an arbitrarily sized rectangle.
3. Toggle Infer Constraints mode on in the status bar.
4. Press the spacebar to repeat the `RECTANG` (for Rectangle) command, and then click two more points to draw another arbitrarily sized rectangle adjacent and to the right of the first one (see Figure 12.1). AutoCAD automatically infers perpendicular and parallel constraints from the geometry of the second rectangle.

![Figure 12.1 Drawing two rectangles, one unconstrained](image)

5. Toggle off Infer Constraints mode by pressing Ctrl+Shift+I.

6. Select both rectangles with a crossing selection window. Hover the cursor over the upper-right grip of the left rectangle, select Stretch Vertex from the grip menu that appears, and stretch it up and to the right so that the rectangle deforms. Hover the cursor over the upper-right grip of the right rectangle, select Stretch Vertex from the grip menu, stretch it up and to the right, and click to set its new location. The rectangle remains a rectangle because of the constraints (see Figure 12.2). Press Esc to deselect.

7. Select the Parametric tab on the ribbon, and select the Auto Constrain tool in the Geometric panel. Select the unconstrained rectangle on the left and press Enter. Two constraints are applied: perpendicular and horizontal (see Figure 12.3).
8. Select the Parallel constraint tool in the Geometric panel. Click lines A and B, as shown in Figure 12.3. Line B is automatically repositioned to conform to the parallel constraint applied to line A.

9. Press the spacebar to repeat the GCPARALLEL (for Geometric Constraint Parallel) command. Click lines C and D, as shown in Figure 12.3.
Chapter 12 • Keeping In Control with Constraints

10. The left rectangle not only has parallel and perpendicular constraints like the right rectangle, but it also has a horizontal constraint that was applied by the Auto Constrain tool. Select the right rectangle, and press the Delete key.

11. Select the Equal constraint tool in the Geometric panel. Click lines A and C, as shown in Figure 12.3. The rectangle becomes a square (see Figure 12.4).

12. Multiple constraints are grouped together in what is called a constraint bar. Position the cursor over the constraint bar, and you'll see a tiny Close box. Click it to hide the constraint bar.

13. Click the Show All button in the Geometric panel. The hidden constraint bar reappears.

14. Right-click the horizontal constraint, and choose Delete from the context menu. The rectangle is no longer constrained horizontally (so you could rotate it if desired).

15. Click the Hide All button in the Geometric panel. The constraints are hidden but still active.

16. Save your work as Ch12-B.dwg.

Hiding constraints does not remove them; it merely reduces visual clutter.
Applying Dimensional Constraints and Creating User Parameters

Dimensional constraints allow you to control object sizes with specific numerical values and to set up dynamic dimensional relationships with mathematical equations and formulas. User constraints are not tied to specific geometry but hold values calculated from dimensional constraints. In the following steps, you will create dimensional and user constraints:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 12, get the file Ch12-B.dwg, and open it.

2. Select the ribbon’s Home tab, open the Layer drop-down menu in the Layers panel, and select Layer 2 to make it the current layer.

3. Select the Parametric tab on the ribbon. Select the Linear constraint tool in the Dimensional panel, and click constraint points A and B, as shown in Figure 12.5. Constraint points highlight in red on screen when you move the cursor near them. Click point C to locate the dimension line. Press Enter to accept the default dimension text. This dimensional constraint is automatically given the variable name d1.

FIGURE 12.5 Creating a vertical linear dimensional constraint
4. Type \textbf{C} (for Circle), and press Enter. Draw an arbitrarily sized circle anywhere within the square.

5. Click the Linear constraint tool in the Dimensional panel, and click the first constraint point in the upper-left corner of the rectangle. Click the circle to accept its center as the second constraint point. Move the cursor upward (see Figure 12.6), and click to place the horizontal dimension line above the rectangle. Move on to step 6 without pressing Enter.

![Figure 12.6 Creating a horizontal linear dimensional constraint](image)

6. Type $d_2=d_1$, and press Enter. The circle moves over so that it is horizontally centered within the rectangle and the constraint reads $fx: d_2=d_1$. The $fx$ means the dimensional constraint is calculated by a function.

7. Press the spacebar to repeat the \texttt{DCLINEAR} (for Dimensional Constraint Linear) command. Click the first constraint point in the upper-right corner of the rectangle. Click the circle to accept its center as the second constraint point. Move the cursor to the right, and click to place the vertical dimension line to the right of the rectangle. Type $d_3=d_1$, and press Enter. The circle is now centered within the square (see Figure 12.7).

---

\textbf{You can convert an existing dimension into a dimensional constraint with the DIMCONSTRAINT command.}
8. Click the Parameters Manager button in the Manage panel to open the Parameters Manager. All the dimensional constraints that you have created are listed here (d1, d2, and d3). Click the $\text{fx}$ button to create a new user parameter.

9. Type \textbf{P} (for Perimeter) as the user parameter name and press Enter. Double-click the Expression value, type \textbf{d1*8} (d1 times 8), and press Enter (see Figure 12.8). The perimeter of the square is equal to eight times the length of half of one of its sides. Close the Parameters Manager.

\begin{figure}
\centering
\includegraphics[width=0.8\textwidth]{figure127.png}
\caption{Adding another linear constraint that is calculated by a function}
\end{figure}

\begin{figure}
\centering
\includegraphics[width=0.8\textwidth]{figure128.png}
\caption{Adding a user parameter in the Parameters Manager}
\end{figure}
10. Select the Hide All button in the Dimensional panel.

11. Select the Diameter constraint tool in the Dimensional panel, select the circle, click a point inside the circle to locate the dimension line, type \texttt{dia=P/PI}, and press Enter. The variable PI is hard-coded as 3.14159265; there is no need to define it as a user variable. The circumference of the circle is now equal to the perimeter of the square, traditionally called \textit{squaring the circle} (see Figure 12.9).

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{fig12-9.png}
\caption{Squaring the circle with constraints defined by formulas}
\end{figure}

12. Save your work as Ch12-C.dwg.

**Constraining Objects Simultaneously with Geometry and Dimensions**

You can use geometric and dimensional constraints together to force objects to conform to your design intent. In the following steps, you will draw two more circles and constrain their positions and sizes using a combination of geometric and dimensional constraints:

1. If the file is not already open, go to the book’s web page, browse to Chapter 12, get the file Ch12-C.dwg, and open it.
2. Select the ribbon’s Home tab, open the Layer drop-down menu in the Layers panel, and select Layer 3 to make it the current layer.

3. Type C (for Circle), and press Enter. Draw an arbitrarily sized circle anywhere within the square.

4. Select the ribbon’s Parametric tab, and then click the Concentric constraint tool in the Geometric panel. Select the green circle and then the blue circle. The blue circle immediately moves to conform to the geometric constraint so that it is concentric within the larger circle.

5. Select the Radius constraint tool in the Dimensional panel, select the blue circle, and click a point inside the circle to locate the dimension line. Type rad=d1, and press Enter. The blue circle changes size so that it fits perfectly within the square (see Figure 12.10).

6. Select the Hide All button in the Dimensional panel.

7. Select the ribbon’s Home tab, open the Layer drop-down menu in the Layers panel, and select Layer 4 to make it the current layer.
8. Type **C** (for Circle), and press Enter. Draw an arbitrarily sized circle anywhere above the square.

9. Select the ribbon’s Parametric tab, and click the Tangent constraint tool in the Geometric panel. Select the top line of the square as the first object and the magenta circle as the second object. The circle moves down to conform to the tangent constraint (see Figure 12.11).

![Figure 12.11 Applying a tangent geometric constraint](image)

10. Press the spacebar to repeat the **GCTANGENT** (for Geometric Constraint Tangent) command. Select the blue circle first, and then select the magenta circle. The magenta circle moves on top of the blue circle to conform to the new tangent constraint.

11. Click the Linear constraint tool in the Dimensional panel. Click the magenta circle, the blue circle, and then a point off to the right to place the dimension line. Type `d4=dia/2`, and press Enter (see Figure 12.12). The center of the magenta circle is anchored effectively at the top quadrant (or top cardinal point) of the green circle.
12. Click the Hide All button in the Dimensional panel, and click the Hide All button in the Geometric panel. All constraints are hidden but still active.

13. Save your work as Ch12-D.dwg.

Making Parametric Changes to Constrained Objects

Once you have intelligently applied geometric and/or dimensional constraints, it is easy to make parametric changes that affect the shape and/or size of multiple interconnected objects. In the following steps, you will change a single parameter ($d_1$) and see how it affects the objects you have constrained. In addition, you will add dimensions to two circles and uncover an amazing coincidence.

1. If the file is not already open, go to the book's web page, browse to Chapter 12, get the file Ch12-D.dwg, and open it.
2. Select the ribbon’s Parametric tab, and click the Parameters Manager button in the Manage panel.

3. Double-click the \( d_1 \) parameter’s expression. Type 3, and press Enter. All parameter values are recalculated because they are all based on the first parameter you created earlier in this chapter (see Figure 12.13).

4. Click the Zoom Extents tool in the Navigation bar. The form of the diagram remains unchanged; only the scale has changed.

5. The Earth’s polar radius is 3949.9 miles (or 6356.8 km). Double-click the \( d_1 \) parameter’s expression. Type 6356.8, and press Enter. Close the Parameters Manager.

6. Click the Zoom Extents tool in the Navigation bar.

7. Select the ribbon’s Home tab, open the Layer drop-down menu in the Layers panel, and select 0 to make it the current layer.

8. Select the ribbon’s Annotate tab, open the Dimension menu in the Dimensions panel, and click the Radius tool. Select the blue circle, and then click a point inside the circle to locate the dimension object.

9. Press the spacebar to repeat the \texttt{DIMRADIUS} (Dimension Radius) command. Select the magenta circle, and click a point outside the circle to locate the dimension object. Figure 12.14 shows the result.
The perimeter of the square is constrained to equal the circumference of this circle.

**FIGURE 12.14** Dimensioning two radii in the squaring the circle diagram

10. The Moon’s polar radius is 1078.7 miles (or 1735.97 km). The diagram amazingly encodes the sizes of Earth and Moon with accuracy exceeding 99.9 percent. Your drawing should now resemble Ch12-E.dwg, which is available on the book’s web page.

---

**THE ESSENTIALS AND BEYOND**

In this chapter, you learned how to apply constraints to cause objects to conform to specific geometric, dimensional, and formulaic requirements. You saw how modifying constraint expressions makes objects automatically change their shapes and sizes to conform to the sum total of all applied constraints.

(Continues)
Additional Exercise

Explore annotational constraints on your own. For example, show all dimensional constraints, and then select the \( d1 \) constraint and open the Properties palette. Change the Constraint Form property to Annotational. Annotational constraints cannot be hidden but instead annotate the drawing, somewhat like dimension objects. However, the padlock symbol identifies them as dimensional constraints.
CHAPTER 13

Working with Layouts and Annotative Objects

There are two distinct spaces in which you can create drawings: modelspace and paperspace. Typically, 2D drawings and 3D models are created in modelspace. Layouts in paperspace bring together annotations and drawings ultimately to be plotted on paper or published electronically. Viewports display drawings at specific scales on layouts, which is where you’ll draw title blocks that frame the drawings. You will learn about all of them in this chapter and how to use each.

- Creating annotative styles and objects
- Creating layouts
- Adjusting floating viewports
- Overriding layer properties in layout viewports
- Drawing on layouts

Creating Annotative Styles and Objects

All the geometry you draw in the AutoCAD® program is created at its actual size. However, the heights of text, dimensions, and attributes present a potential problem. As drawings are scaled down from their real-world size to be represented on paper using viewport scale (which you’ll learn more about in the “Adjusting Floating Viewports” section later in this chapter), text, dimensions, and attributes are likewise scaled down to fit on paper.

To compensate, users of versions before AutoCAD 2008 intentionally had to scale text, dimensions, and attributes much larger in modelspace than their intended size on paper so that, when reduced in a viewport, they appeared at
the correct size on paper. Complicating this issue is the fact that, if you wanted to display the same drawing at different scales on the same sheet of paper (a common occurrence), you would have to duplicate all the annotation, assign copies to different layers, and scale the annotation according to each viewport’s scale.

Fortunately, annotative objects overhaul and greatly simplify this process by automatically displaying text, dimensions, and/or attributes at different heights on the same drawing according to the viewport scale in which they are displayed.

The purpose of annotative styles is to control the appearance of annotative objects such as text, dimensions, and/or attributes. I will discuss both text and dimensions in upcoming sections, but will hold off on attributes until Chapter 15, “Storing, Presenting, and Extracting Data.” As you’ll see, annotative objects change their sizes automatically to fit the drawing scale.

**Working with Annotative Text**

In the following steps, you will configure an annotative text style to display text at 1/8” (or 0.4 cm) high on paper. All the text objects assigned to this style will automatically adjust their heights to 1/8” (or 0.4 cm) no matter in what scale the drawing is shown. In this way, annotative objects automatically change their sizes relative to other geometry in the drawing.

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 13, get the file Ch13-A.dwg (or Ch13-A-metric.dwg), and open it.

2. Type **ST** (for Style), and press Enter. Click the New button in the Text Style dialog box that appears. Type **Annotative** as the style name in the New Text Style dialog box and click OK.

3. Select Arial as the font name, select Annotative in the Size area, type 1/8” (or 0.4 cm) for Paper Text Height, and type 0.9 for the Width Factor (see Figure 13.1). Click Apply, and then click Close.

4. Select Zoom Realtime from the Navigation bar, and zoom into the room with the round table at the top of the floor plan by dragging upward.

5. Click the Multiline Text tool in the Annotate panel on the ribbon’s Home tab. Select 1/16” = 1’-0” (or 1:200 for metric) from the drop-down menu in the Select Annotation Scale dialog box that appears (see Figure 13.2). Click OK.
6. Click the first corner at some arbitrary point inside the round table. Type J (for Justify), and press Enter. The command prompt reads:

   Enter justification [TL TC TR ML MC MR BL BC BR] <TL>:

   Type MC (for Middle Center), and press Enter. Click the second point a short distance down and to the right. Type Conference Room, and press Ctrl+Enter to end the MTEXT command. Pressing Enter moves you to the next line in multiline text, so you must hold Ctrl while pressing Enter to end the command.

7. Click the Move tool on the Modify panel, type L (for Last), and press Enter twice. Type INS (for Insert), and click the text object. Type CEN (for Center), hover the cursor over the circle, and press Enter.
the circular table to center the text on the table (see Figure 13.3). This text appears 1/8” high in 1/16” = 1’-0” scale (or 0.4 cm high in 1:200 scale).

**FIGURE 13.3** Centering multiline text on the circular table

8. Select the two toggles adjacent to Annotation Scale on the status bar so that both have yellow icons indicating that they are turned on (see Figure 13.4).

![Annotative controls on the status bar](image)

9. Change the Annotation Scale to 1/2” = 1’-0” (or 1:20 for metric) in the status bar. The text you created appears much smaller. This text will appear 1/8” high in 1/2” = 1’-0” scale (or 0.4 cm in 1:20 scale). Select the text object, and observe both scales simultaneously (see Figure 13.5). Press Esc to deselect.

10. Save your work as Ch13-B.dwg or Ch13-B-metric.dwg.
Working with Annotative Dimensions

In much the same way as text, dimensions can be made annotative so that they change sizes when the annotative scale is changed. In the following steps, you will explore how to do this by creating an annotative dimension style and then adding an annotative linear dimension:

1. If the file is not already open from performing the previous step, go to the book’s web page, browse to Chapter 13, get the file Ch13-B.dwg or Ch13-B-metric.dwg, and open it.
2. Type **D** (for Dimension Style), and press Enter. Click the New button in the Dimension Style Manager to bring up the Create New Dimension Style dialog box. Type **Annotative** in New Style Name, and click the Annotative check box (see Figure 13.6). Then do the following:

- If you are using Imperial units, click Continue, OK, and then Close.
- If you are using metric units, click OK, select Decimal Units and Precision of 0 (whole centimeters) on the Primary Units tab of the Modify Dimension Style dialog box, click OK, and click Close.

![Create New Dimension Style](image)

**Figure 13.6** Creating an annotative dimension style

3. Toggle on Object Snap. Verify that endpoint running object-snap mode is on by right-clicking the icon in the status bar.

4. Click the Linear dimension tool in the Annotate panel. Click points A, B, and C, as shown in Figure 13.7.

![Drawing a linear dimension](image)

**Figure 13.7** Drawing a linear dimension

5. Select the 1/16" = 1'-0" (or 1:200 in metric) scale button in the Annotation Scale menu on the status bar. A much larger dimension object appears in the drawing canvas. Select the dimension object and, using one of the dimension line grips at either end of the dimension line, move it upward so that the dimension has longer extension lines. Press Esc to deselect. Figure 13.8 shows the result.

Annotative styles can have any name. What makes a style annotative is the check box in the Create New Dimension Style dialog box.

Each scale’s versions of annotative text and dimensions are separate objects, which should be adjusted independently with grips for clarity.
6. Save your work as Ch13-C.dwg or Ch13-C-metric.dwg.

Creating Layouts

Think of layouts as sheets of virtual paper because that’s what they represent. You will create layouts whether you ultimately plan to publish the drawing on paper or in electronic form. Each drawing can have multiple layouts to publish in a variety of formats. In the following steps, you will create two layouts, one for an 8.5” × 11” sheet of paper (or ISO A4) and another for a 30” × 42” drawing (or ISO A0), which are standard business and drawing sizes:

1. If the file is not already open, go to the book’s web page, browse to Chapter 13, get the file Ch13-C.dwg or Ch13-C-metric.dwg, and open it.

2. Click the Layer Properties tool in the Layers panel on the ribbon’s Home tab.

3. Click the New Layer button in the Layer Properties Manager that appears. Type Z-Viewport, and press Enter. With the Z-Viewport line still highlighted, press Alt+C to make the new layer current. Click the printer icon in the Z-Viewport layer’s Plot column to make this layer nonplotting (see Figure 13.9). Close the Layer Properties Manager.
Layout and model tabs are a legacy interface that longtime AutoCAD users may prefer to keep using. If you see tabs at the bottom of the drawing canvas labeled Model and Layout1, then you are looking at the older interface. Right-click either of these tabs, and choose Hide Layout And Model Tabs to use the more streamlined, modern interface.

4. If layout tabs are displayed, click the Layout1 button. If the layout tabs are hidden, click the Quick View Layouts button and then click Layout1 on the status bar or the Layout1 tab on the lower edge of the drawing window.

The image in the drawing canvas changes as you enter paperspace: A white representation of paper is displayed with an automatically created viewport through which you can see the drawing in modelspace. The viewport object is on the Z-Viewport layer. The viewport frame will not appear in the output because it is on a nonplotting layer. The contents of the viewport will be output, however. The dashed lines indicate the limits of the plotting device’s printable area (see Figure 13.10).
5. Select the ribbon’s Output tab. Click the Page Setup Manager tool in the Plot panel, and click the Modify button in the Page Setup Manager dialog box that appears. When the Page Setup: Layout1 dialog box opens, select the DWG To PDF.pc3 plotter from the Name drop-down, choose monochrome.ctb from the Plot Style Table drop-down, check Display Plot Styles, and do the following:

- If you are using Imperial units, select ANSI Expand A (8.50 × 11.00 Inches) as the paper size (see Figure 13.11). Leave the plot scale at 1 inch = 1 unit. Click OK, and then click Close.

- If you are using metric units, select ISO Full Bleed A4 (297.00 × 210.00 MM) as the paper size. Set the plot scale to 10 mm = 1 unit. Click OK, and then click Close.

6. Click Quick View Layouts in the status bar. Click the New Layout icon at the bottom of the Quick View Layouts interface that appears at the bottom of the drawing canvas. Click Layout2 to open it (see Figure 13.12). Click the Close Quick View Layouts icon.
7. Click the Page Setup Manager in the Plot panel. Click the Modify button in the Page Setup Manager dialog box that appears to modify Layout2. Select the DWG To PDF.pc3 plotter, select monochrome.ctb from the Plot Style Table drop-down, and check Display Plot Styles. Then do the following:

- If you are using Imperial units, select ARCH E1 (30.00 × 42.00 Inches) as the paper size. Leave the plot scale at 1 inch = 1 unit. Click OK, and then click Close.

- If you are using metric units, select ISO A0 (841.00 × 1189.00 MM) as the paper size. Set the plot scale to 10 mm = 1 unit. Click OK, and then click Close.
8. A single tiny viewport was automatically created on the current layer in the corner of the layout. You will configure this viewport in the next section and create an additional viewport. Save your work as Ch13-D.dwg or Ch13-D-metric.dwg.

Adjusting Floating Viewports

Think of floating viewports as windows that exist in paperspace through which one sees into modelspace. Viewports are termed *floating* because you can position and size their frames however you like in relation to the paper represented in a layout. You will configure a single floating viewport on Layout1 and two separate viewports on Layout2 to gain experience with viewports.

Working on Layout1

In the following steps, you will set the scale of the building floor plan on Layout 1 and then adjust its viewport to fit the floor plan:

1. If the file is not already open, go to the book's web page, browse to Chapter 13, get the file Ch13-D.dwg or Ch13-D-metric.dwg, and open it.

2. Click the Quick View Layouts icon on the status bar. Select Layout1, and then press Esc to exit Quick View Layouts mode.

3. Click the PAPER icon on the status bar. This icon toggles between paperspace and modelspace, and the word displays which space you are currently in (now modelspace). The viewport's frame highlights with a thicker representation when displaying modelspace (see Figure 13.13). Move the cursor inside the viewport, and observe that the crosshair cursor is available only within the viewport.

4. Choose 1/16" = 1'-0" (or 1:200 in metric) from the Viewport Scale menu button on the status bar, as shown in Figure 13.14. The viewport zooms into the building core, which is in the center of the plan. At this exact zoom magnification, the plan appears in 1/16" scale (or 1:200) in the layout.

5. Click the MODEL icon on the status bar to switch back to paperspace. Move the crosshair cursor across the drawing canvas, and observe that it appears across the entire paper.
6. Viewport frames exist in paperspace only. Click the single viewport frame to select it. Select the upper-right grip and move it upward and to the right until it is close to the upper-right corner of the paper but inside the plot device limits. Click the lower-left grip, and move it to the lower-left corner inside the device limits (see Figure 13.15). Press Esc to deselect the viewport.

7. Unfortunately the plan doesn’t fit on the page in 1/16” scale. Click the PAPER icon on the status bar to switch back into modelspace. Toggle on the Automatically Add Scales to Annotative Objects button in the status bar. Select 1/32” = 1’-0” (or 1:300 in metric) from the Viewport Scale menu button on the status bar. The drawing fits on the page, and new annotative objects are created in this scale.
8. Zoom in and select the single dimension object, and move its dimension line upward for clarity. Note, however, that by zooming, you have changed the viewport scale. Again select $1/32" = 1'-0"$ (or 1:300 in metric) from the Viewport Scale menu button on the status bar, and pan the drawing to the center of the page (see Figure 13.16).

**Figure 13.15** Adjusting the viewport in an attempt to display the entire floor plan at $1/16"$ scale (or 1:200 in metric)

**Figure 13.16** Finding the largest scale that will fit on the page
9. Click the MODEL icon on the status bar to switch back to paperspace.

10. Save your work as Ch13-E.dwg or Ch13-E-metric.dwg.

Working on Layout2

In the following steps, you will adjust the viewport on Layout2 and, in the process, discover that certain combinations of building geometry, viewport scales, and paper sizes do not always mesh. You will fix the problem by selecting a different viewport scale, and then adjust the viewport to fit the floor plan. In addition, you’ll create a viewport from scratch and adjust it.

1. If the file is not already open, go to the book’s web page, browse to Chapter 13, get the file Ch13-E.dwg or Ch13-E-metric.dwg, and open it.

2. Click the Quick View Layouts icon on the status bar. Select Layout2, and then press Esc to exit Quick View Layouts mode.

3. As an alternative to clicking PAPER on in the status bar, double-click inside the viewport to activate it. The Paper/Model toggle now indicates that you are in the modelspace of the viewport.

4. Choose \( \frac{1}{4} \) \( \text{g} \) \( = \) 1'-0" (or 1:40 in metric) from the Viewport Scale menu on the status bar.

5. Double-click the layout outside of the viewport to switch back into paperspace. Move the cursor across the drawing canvas, and observe that you can move it across the entire paper now that it is active.

6. Viewport frames exist in paperspace only. Click the viewport frame to select it. Select the upper-right grip, and move it upward until it is close to the upper-right corner of the paper but inside the plot device limits. Click the lower-left grip, and move it to the lower-left corner inside the device limits. Press Esc to deselect.

7. Double-click inside the viewport to switch back into modelspace. Drag the mouse wheel (but do not turn the wheel) to pan the drawing over within the viewport to center it on the paper. The \( \frac{1}{4} \) \( \text{g} \) (or 1:50 in metric) scale drawing almost fits, but it’s too tight to fit comfortably on ARCH E1 or ISO A0 paper. You couldn’t have known this without first creating the layout and trying to fit the drawing to the paper at this specific scale.
8. Verify that the option Automatically Add Scales To Annotative Objects When The Annotation Scale Changes is toggled on in the status bar, and then select 3/16” = 1’-0” scale (or 1:60 in metric) in the Viewport Scale menu. The floor plan now fits the layout.

9. Double-click the paper outside the viewport to switch back into paperspace. Select the viewport, and grip-edit it so that it closely surrounds the plan geometry. Move the plan to the left on the paper to make room for another drawing on this layout. Figure 13.17 shows the result.

![Figure 13.17](image)

**FIGURE 13.17** The drawing fits the paper at 3/16” scale (or 1:50 in metric)

10. Type `MV` (for Make Viewport), and press Enter. Click two arbitrary corner points to the right of the existing viewport to create a new viewport. The `MVIEW` command ends.

11. Double-click within the new viewport to enter its modelspace. Select 1/2” = 1’-0” (or 1:20 in metric) in the Viewport Scale menu on the status bar; the viewports zoom into the Elevator Lobby again. Pan downward until you center the view on the Conference Room. Double-click outside the viewport to return to paperspace. Figure 13.18 shows the result.
12. Select both viewport objects, and then click the Lock Viewport icon on the status bar. Press Esc to deselect. Double-click inside the new viewport, and roll the mouse wheel forward to zoom in. Whereas before when you locked the viewport, only the space within the viewport zoomed in, now the entire layout zooms in.

13. Save your work as Ch13-F.dwg or Ch13-F-metric.dwg.

**Overriding Layer Properties in Layout Viewports**

Each viewport maintains its own set of layer properties that can override the drawing's basic layer properties. In the following steps, you will use this feature to turn off a selection of layers in a particular viewport, while continuing to display these same layers in another viewport.

1. If the file is not already open, go to the book's web page, browse to Chapter 13, get the file Ch13-F.dwg or Ch13-F-metric.dwg, and open it.

2. Double-click within the larger viewport on Layout2 that shows the entire floor plan to activate it and switch into floating modelspace.

3. Click the Layer Properties tool on the Layers panel on the ribbon's Home tab.
4. Expand the palette to the right by dragging its edge. Observe a set of properties in columns preceded with the letters VP (viewport). Click the icons in the VP Freeze column for layers A-furn, A-flor-fill, and A-flor-patn to freeze them in the current viewport (see Figure 13.19).

![Figure 13.19](image)

**Figure 13.19** Freezing selected layers in the current viewport only

5. Double-click on the paper outside the viewport to switch back into paperspace. The furniture and furniture systems disappear from the current viewport, but the Conference Room round table is still visible in the viewport on the right of Layout2 (see Figure 13.20). Close the Layer Properties Manager.

6. Save your work as Ch13-G.dwg or Ch13-G-metric.dwg.

![Figure 13.20](image)

**Figure 13.20** Furniture is visible in the viewport on the right but not in the left viewport, whose layer properties have been overridden.
Drawing on Layouts

You can draw on layouts just as you can draw in modelspace. However, the types of content drawn on layouts will necessarily be of a different character, such as a title block, viewports, and (optionally) dimensions. Layouts have the measurements of physical sheets of paper and are not meant to hold real-world geometry directly (that is what modelspace is used for).

One way to draw directly on layouts is to use *title blocks*, which are borders surrounding the drawing that also have rectangles in which text identifying the sheet is placed. You can also draw dimensions directly on layouts. Dimensions added in paperspace are associated with geometry in modelspace. If the real-world geometry changes, then the dimensions will automatically update.

In the following steps, you will draw a title block and add a dimension to the paperspace of the layout:

1. If the file is not already open, go to the book’s web page, browse to Chapter 13, get the file Ch13-G.dwg or Ch13-G-metric.dwg, and open it.

2. Type LA (for Layer Properties Manager), and press Enter. Click the New Layer icon, type Z-Title, and press Enter. Double-click the new layer to make it current. Select a Lineweight value of 0.039” (or 1.00 mm) for a thick border. Toggle the Plot icon on. Close the Layer Properties Manager.

3. Click the Rectangle tool in the Draw panel. Click the corner points as closely as possible to the edges of the paper in Layout2. You cannot use object snap in this instance.

**Title Blocks**

Drawings are legal documents and, as such, typically indicate the drawing scale, sheet name, and sheet number. This information is traditionally shown with text or attributes in a title block, which is drawn directly on the layout.
4. Set the Text layer as current by selecting it in the Layer drop-down in the Layers panel.

5. Verify that the PAPER/MODEL toggle on the status bar reads PAPER. Zoom into the smaller viewport on the right of Layout2.

6. Right-click the Object Snap icon in the status bar, and toggle on quadrant snap. Click the Linear tool in the Annotation panel, and click points A, B, and C as shown in Figure 13.21. Points A and B are on the quadrants of the circle. A dimension measuring 9'-0" (274 for metric) appears on the layout in paperspace that looks similar to the dimension you drew earlier in this chapter in modelspace.

7. Click Maximize Viewport on the status bar. A red border indicates that you are working in the modelspace of a viewport in maximized mode.

Dimensions added in paperspace are necessarily specific to each drawing and cannot be shown simultaneously in multiple viewports as annotative, modelspace dimensions can.
Working in Multiple Maximized Viewports

When you work in a maximized viewport on a layout that has more than one viewport, the Next and Previous arrows appear surrounding the status bar toggle. Click these arrow icons to cycle through each and every viewport on a layout while staying in maximized mode.

8. Select the circle representing the table, and select its top quadrant grip. Type 4’8” (140 cm in metric), and press Enter to input the new radius. The circle grows slightly larger.

9. Click Minimize Viewport in the status bar. The drawing canvas returns to Layout2. The dimension in paperspace is automatically updated with the value of 9’-4” (280 cm in metric).

10. Select the Output tab on the ribbon, and click the Preview tool in the Plot panel. What you now see is what you would get if you published this drawing (see Figure 13.22). Press Esc to exit the preview.

![Plot preview of Layout2](image)

**Figure 13.22** Plot preview of Layout2

11. Save your work as Ch13-H.dwg or Ch13-H-metric.dwg. Your drawing should now resemble the files available on the book’s web page.
In this chapter, you learned the differences between modelspace and paperspace. You created layouts and viewports, set viewport scales, and adjusted viewports to fit the real-world geometry. In addition, you overrode layer properties in viewports, worked in maximized viewports, drew a title block, and dimensioned in paperspace. In short, you are now fully prepared to create physical and electronic output in the next chapter.

Additional Exercises

TILEMODE is the system variable that switches between modelspace where tiled viewports are possible (TILEMODE=1) and paperspace where floating viewports are possible (TILEMODE=0). Create tiled modelspace viewports with the VPORTS command on your own. You can alternatively create tiled viewports using the leftmost menu in the upper-left corner of the drawing canvas.

Tiled viewports are most useful when working on 3D models to get multiple simultaneous views of complex geometry, but they can also be used to get a simultaneous overview and detailed view of a 2D drawing. Try working at a few different magnifications in Ch13-H.dwg or Ch13-H-metric.dwg with three viewports so that you can see the overall plan and two detailed views simultaneously.
Printing and Plotting

Plotting is the term for producing physical prints using a large-format printer, which is either networked or directly connected to an AutoCAD® workstation. There is much more to plotting a drawing or publishing an entire sheet set than hitting the Print icon, however. Before you can successfully print, you must first learn to configure a plotter and a plot style table; you’ll then learn how to create professional output from modelspace and/or paperspace. As you’ll see in this chapter, you’ll also have the option to keep everything in digital format and export DWF or PDF files that can be shared on the Internet with your partners and clients.

- Configuring output devices
- Creating plot style tables
- Using plot style tables
- Plotting in modelspace
- Plotting layouts in paperspace
- Exporting to an electronic format

Configuring Output Devices

In the most general sense, everything you do on a computer is a form of input. Creating physical or even electronic drawings, on the other hand, are forms of output. Output devices are more commonly known as printers.

Large-format (24” wide or larger) printers are marketed as “plotters” because of the history of technology. When I started my career more than 20 years ago, plotters had technical pens in them that you had to refill individually with ink. The paper (actually Mylar film) was rolled back and forth, and the pens literally plotted one line at a time. Thankfully, modern inkjet technology is much faster, so you no longer wind up with clogged pens and ink on your hands.
In the following sections, you will configure an output device by setting up a system printer and an AutoCAD plotter. Once these steps are completed, you won’t have to perform them again on the same computer.

**Setting Up a System Printer**

The first thing you’ll need to do is set up a system printer, which contains *drivers* that your operating system uses to control the output device. System printers are not specific to AutoCAD; device manufacturers supply drivers, which you then install to become printers on your system.

If you are reading this book at work, you undoubtedly already have a system printer or your CAD manager has installed one for you. For the purposes of this book, however, you will install a driver for the HP DesignJet 800 plotter (an industry workhorse), whether or not you own this device. You will be using the HP DesignJet 800 system printer in this chapter. The following steps guide you in installing this typical system printer:

1. Open your browser, and type **HP DesignJet 800 42 driver** as a Google search. Select the first search result, or go to [www.hp.com](http://www.hp.com) and search for Download Drivers and Software.

2. Select your operating system from the list, and download the appropriate driver.

3. Install the driver following the manufacturer’s instructions. Select File:Port in the installation options because you don’t have access to the actual device. If you did have the physical device, you would select the relevant connection port, such as Parallel, Ethernet, USB, or Wireless.

**Setting Up an AutoCAD Plotter**

Most programs send output directly to system printers, but AutoCAD is an exception. AutoCAD has another layer of software between the program and the operating system known as an AutoCAD plotter. In this section, you will set up an AutoCAD plotter that sends its output to the system printer, which in turn hands off the print job to the output device itself.

1. In AutoCAD, type **PLOTTERMANAGER** and press Enter. The Windows Explorer dialog box appears displaying the Add-A-Plotter Wizard and various AutoCAD plotters that have the .pc3 file extension (see Figure 14.1).

3. Select the System Printer radio button (see Figure 14.2) and click Next.

**Plotting Raster Images to Scale**

For more information on setting up and plotting to a raster plotter driver in AutoCAD, see my book *Enhancing Architectural Drawings and Models with Photoshop* (Sybex, 2010). Raster images of drawing layers can be output to scale from AutoCAD and enhanced in Photoshop for presentation.
4. Select the HP DesignJet 800 system printer from the list in the Add Plotter – System Printer dialog box (see Figure 14.3). The listed printers will differ on your computer depending on which drivers you (or your CAD manager) have already installed on your system. Click Next.

5. The next page allows you to import a legacy PCP or PC2 file from older versions of AutoCAD. Since you are creating a PC3 file from scratch, click Next to open the Add Plotter – Plotter Name page.

6. AutoCAD now suggests a name for the plotter that is identical to the name of the system printer. Type the name **HP DesignJet 800 Plotter** to differentiate the new printer name from the system printer (see Figure 14.4). Click Next.
7. The final page of the Add Plotter wizard allows you to edit the newly created plotter driver itself. Click the Edit Plotter Configuration button to do this.

8. Select the Device And Document Settings tab, and then select the Filter Paper Sizes node in the Plotter Configuration Editor dialog box that appears. Click the Uncheck All button. You should filter the list of paper sizes to display only the sizes you use. Scroll down the list, and select the following paper sizes: Arch C (landscape) and Arch D (landscape). Figure 14.5 shows the result.

![Plotter Configuration Editor - HP DesignJet 800 Plotters](image)

**Figure 14.5** Filtering out all unused paper sizes

9. Click OK to close the Plotter Configuration Editor. Click Finish to close the Add-A-Plotter Wizard.

10. The new AutoCAD plotter driver you just created, HP DesignJet 800 Plotter.pc3, appears in the Windows Explorer window that was opened in step 1 (see Figure 14.6). Close Windows Explorer.
Creating Plot Style Tables

Plot style tables determine the final appearance of objects in terms of their color, linetype, lineweight, end cap, line fill, and screening percentage. Plot style tables take precedence over layer properties when the drawing is printed.

In addition to creating a system printer and AutoCAD plotter, you will need to create a plot style table or use an existing one. AutoCAD has two types of plot style tables: color-dependent and named.

**Color-Dependent Plot Style Tables (CTB Files)**  These have been used since the days of pen plotters when you assigned a number of colors in AutoCAD to a specific physical pen. For example, red objects might plot using the 0.5 mm pen, and green and yellow objects might use the 0.7 mm pen. Many firms still use color-dependent plot style tables today.

**Named Plot Styles (STB Files)**  These were a new feature in AutoCAD 2000. Named plot style tables offer greater flexibility as compared with color-dependent plot styles because plot criteria can be assigned by layer or by object rather than by color only. In the following exercise, you will create a named plot style. Named plot styles use the .stb file extension.

1. Type `STYLESMANAGER`, and press Enter. Windows Explorer appears and displays a number of preset plot style table files (see Figure 14.7).

2. Double-click the Add-A-Plot Style Table Wizard. Read the introductory page and then click Next.
3. Select Start From Scratch on the next page (see Figure 14.8). Click Next.

![Windows Explorer showing the plot styles folder](image1)

**Figure 14.7** Windows Explorer showing the plot styles folder

4. Select the Named Plot Style radio button on the next page. This will create a named plot style having one default style called Normal. Click Next.

5. For lack of a more descriptive name, type **My plot style** on the File Name page (see Figure 14.9). Click Next.
6. The final page of the wizard allows you to edit the newly created STB file itself. Click the Plot Style Table Editor button.

7. Select the Form View tab in the Plot Style Table Editor that appears. Click the Add Style button. Type **Black**, and press Enter.

8. Open the Color drop-down, and select Black (see Figure 14.10).

9. Click the Add Style button again, type **20% Screen**, and press Enter. Highlight the value next to the word Screening, type **20**, and press Tab. Click Save & Close to close the Plot Style Table Editor.

---

**FIGURE 14.9**  Typing a name for the plot style

**FIGURE 14.10**  Creating a Black plot style

*Screening* refers to the intensity of ink sprayed on the paper while plotting. Selecting 100 directs the inkjet print head to spray at full intensity whereas setting this value to 0 will not spray any ink. Intermediate values produce varying levels of grayscale.
10. Click Finish to close the Add Plot Style Table wizard. The named plot style table you just created, My plot style.stb, appears in the Windows Explorer window that was opened in step 1 (see Figure 14.11). Click the close box in Windows Explorer.

**FIGURE 14.11** The newly named plot style table appears in Windows Explorer.

**Using Plot Style Tables**

New drawings are created using either color-dependent or named plot style tables. A setting in the Options dialog box controls this behavior. Existing drawings must go through a conversion process to switch from utilizing one plot style table type to the other.

In the next exercise, you will configure new drawings to utilize named plot style tables and learn how to use plot styles by layer or by object.

**Configuring New Drawings for Named Plot Style Tables**

In the following steps, you will configure new drawings to use named plot styles and you will save a template that has a named plot style table assigned:

1. Type **OP** (for Options), and press Enter. Select the Plot And Publish tab in the Options dialog box that appears.
2. Click the Plot Style Table Settings button in the lower right of the Options dialog box. Select the Use Named Plot Styles radio button in the Plot Style Table Settings dialog box that appears. Select My_plot_style.stb from the Default Plot Style Table drop-down menu. Select Black from the Default Plot Style For Layer 0 drop-down menu. Select ByLayer from the Default Plot Style For Objects drop-down menu if it is not already selected (see Figure 14.12). Click OK, and then click OK again to close both of the open dialog boxes.

3. Click the New button on the File tabs. Click the arrow button adjacent to the Open button in the Select Template dialog box that appears. Choose Open With No Template – Imperial from the drop-down menu (see Figure 14.13).

4. Type UN (for Units), and press Enter. Choose Architectural units (or Decimal units in metric) with a precision of 1/4" (metric users choose a precision of 0.0). Set Units To Scale Inserted Content under the Insertion Scale area to Inches (or Centimeters in metric) (see Figure 14.14). Click OK.

**Figure 14.12** Configuring the default plot style behavior and settings for new drawings
Using Plot Style Tables

FIGURE 14.13 Creating a new drawing without using a template

FIGURE 14.14 Setting architectural drawing units

5. Click the Save As button in the Quick Access toolbar. Change the Files Of Type drop-down in the Save Drawing As dialog box that appears to AutoCAD Drawing Template (*.dwt). Type My template in the File Name text box (see Figure 14.15). Click Save.

AutoCAD® 2014 allows you to save a copy of any template or drawing file remotely in Autodesk 360 within the Save As dialog box. Autodesk 360 also appears in Windows Explorer, fully integrated into Windows’ filesystem. Saving and opening drawings in the cloud is now as simple as saving and opening locally.
6. Type **Named plot styles and architectural units** in the Template Options dialog box that appears (see Figure 14.16). Click OK.

7. Type **CLOSE**, and press Enter.

You can now create new drawings that have named plot styles (and architectural or decimal units) simply by selecting My Template—no other configuration is required.
Switching Plot Style Table Types in Existing Drawings

If you are switching from named plot styles to color-dependent plot styles in an existing drawing, use the `CONVERTPSTYLES` command to make the conversion. If you are going in the other direction and converting an existing drawing from color-dependent plot styles to named plot styles, you must first use the `CONVERTCTB` command and then use `CONVERTPSTYLES`.

Assigning Plot Styles by Layer or by Object

If you are working in a drawing that uses a color-dependent plot style table, then the plot styles are automatically configured by color. When working on a drawing that uses a named plot style table, you will need to assign named plot styles by layer and/or by object, as shown in the following exercise:


2. Type `LA` (for Layer), and press Enter. Right-click any one of the layer names in the Layer Properties Manager that appears, and choose Select All from the context menu. Click the word Normal in the Plot Style column. The plot style table you created earlier (`My plot style.stb`) is selected. Choose Black in the Select Plot Style dialog box (see Figure 14.17). Click OK. Now all the layers will plot in black.

![Select Plot Style](image-url)  
**Figure 14.17** Selecting a plot style to assign to a layer
3. Click the Title layer in the Layer Properties Manager to select it; all the other layers automatically deselect. Click the Plot Style on the Title layer, and change it to Normal in the Select Plot Style dialog box that appears (see Figure 14.18). The title text will now appear in red.

![Figure 14.18: Configuring named plot styles by layer](image)

4. Close the Layer Properties Manager.

5. Select the ribbon’s View tab. Click the Properties button in the Palettes panel.

6. Click the solid hatch of the flooring in Marketing to select it (see Figure 14.19).

7. Open the Plot Style drop-down in the Properties palette, and select Other from the menu. Select 20% Screen in the Select Plot Style dialog box that appears. Click OK, and 20% Screen is listed as the plot style for the Hatch object in the Properties palette (see Figure 14.20). This object will plot with reduced intensity, so the hatch appears lighter.

8. Press Esc to deselect. Close the Properties palette.

9. Save your work as Ch14-B.dwg.
Using Plot Style Tables

**FIGURE 14.19** Selecting a hatch object

**FIGURE 14.20** Changing the plot style assigned to a specific object
Plotting in Modelspace

You can plot whatever you are working on in modelspace at any time. This is usually done to create a test plot, so that you (or your colleagues) can check and possibly mark up the evolving design on paper. In the following steps, you will create a test plot in modelspace.

1. Open the Ch14-B.dwg file. If this file is not open, find it on the book’s web page.

2. Click the Plot tool in the Quick Access toolbar. Open the Name drop-down menu in the Plot – Model dialog box (see Figure 14.21). Observe that both a system printer and an AutoCAD plotter appear for the HP DesignJet 800 device. Click Cancel.

3. It can be confusing seeing the system printers and AutoCAD plotters in the same drop-down menu in the Plot dialog box. You should hide the system printers to remove this doubling of potential output drivers. Type OP (for Options), and press Enter.

FIGURE 14.21 Selecting a plotter driver in the Plot dialog box
4. Select the Plot And Publish tab. Select Hide System Printers in the General Plot Options area (see Figure 14.22). Click OK.

5. Type `PLOT`, and press Enter. Select the HP DesignJet 800 Plotter. pc3 from the Name drop-down menu (no system printers appear). Select Arch C (landscape) in the Paper Size area and Extents in the What To Plot drop-down menu. Select Center The Plot in the Plot Offset area, deselect Fit To Paper in the Plot Scale area, and \( \frac{3}{8}'' = 1'0'' \) from the Scale drop-down menu. Click the More Options button to expand the dialog box. Select `My plot style.stb` in the Plot Style Table area. Select Plot Stamp On in the Plot Options area (see Figure 14.23).

6. Click the Plot Stamp Settings button, as shown in Figure 14.23. Select Drawing Name, Device Name, and Plot Scale in the Plot Stamp dialog box that appears (see Figure 14.24). Click OK.
7. Click the Preview button in the Plot – Model dialog box. Click Continue in the Plot – Plot Scale Confirm dialog box that appears. A preview window temporarily replaces the user interface (see Figure 14.25).

8. Click the Plot icon, as shown in Figure 14.25. The plot is immediately sent to the hypothetical HP DesignJet 800 output device. If this device were really attached to your computer, it would start plotting within a few seconds. Once the plot has been sent, a notification window appears in the lower-right corner of the user interface (see Figure 14.26). The plot is complete; click the close box in the notification window.
Plotting Layouts in Paperspace

Layouts are the preferred plotting environment where you can display multiple scaled drawings within viewports, surrounded by title blocks containing text, and/or having dimensions in paperspace. In the following steps, you will create and plot two layouts from paperspace:

1. Open the Ch14-C.dwg file. If this file is not open, find it on the book’s web page.
2. Click the Layout1 icon on the status bar. A single viewport is automatically generated on the layout.

3. Click the ribbon’s Output tab, and click the Page Setup Manager icon in the Plot panel. Click the New button in the Page Setup Manager dialog box that appears. Click OK in the New Page Setup dialog box to accept the default name of Setup1. Click OK to return to the Page Setup Manager.

4. In the Page Setup dialog box that appears, click the Modify button, open the Name drop-down menu, and select HP DesignJet 800 Plotter.pc3. Then select Arch C (landscape) in the Paper Size drop-down menu. Select My plot style.stb in the Plot Style Table drop-down menu (see Figure 14.27). Click OK.

5. The Page Setup Manager dialog box now lists Setup1 as a saved page setup. Select Display When Creating A New Layout (see Figure 14.28). Click the Set Current button, and then click Close.

6. Double-click within the viewport to activate floating modelspace. Select 3/8” = 1'-0” from the Viewport Scale menu on the status bar. Double-click outside the viewport on the drawing canvas to return to paperspace.
7. Select the viewport, and stretch its grips to reveal and center the entire building, as shown in Figure 14.29. You might need to move the viewport to center the building on the page, depending on how you stretch the grips.

![Figure 14.28](image1.png) **Figure 14.28**  Saving a page setup for use in the next layout

![Figure 14.29](image2.png) **Figure 14.29**  Configuring Layout1 to display the drawing in 3/8 scale
8. Press Ctrl+P to execute the PLOT command. Deselect Plot Stamp On in the Plot dialog box that appears. Click OK, and the plot is processed. Close the plot notification window when it appears.

9. Click the Quick View Layouts icon in the status bar. Click New Layout in the toolbar that appears, and then click the Layout2 icon to initialize it.

10. Select Setup1 in the Page Setup Manager that appears, and click the Set Current and Close buttons. Layout2 is configured the same way as Layout1.

11. Double-click inside the viewport to activate floating modelspace. Select 3/8" = 1'-0" from the Viewport Scale menu on the status bar.

12. Type LAYERSTATE, and press Enter. Select the Reflected Ceiling Plan layer state, and then click the Restore button (see Figure 14.30).

**FIGURE 14.30** Restoring a layer state in floating modelspace

13. Double-click outside the viewport on the drawing canvas to return to paperspace. Open the Application menu, choose the Print category, and then click Plot. Click the Preview button to open a preview window (see Figure 14.31).
14. Click the Plot icon in the upper-left corner of the preview window, and the plot is processed. Close the plot notification window.

Your drawing should now resemble Ch14-D.dwg, which is available among the book’s download files.

Exporting to an Electronic Format

If you’d like to reduce the amount of paper you use and eliminate reprographics and drawing shipment costs, Windows users can consider exporting their drawings to electronic formats such as DWF (Design Web Format) and/or PDF (Portable Document Format). Mac for AutoCAD users can’t export to DWF (they can, however, save as PDF in the Plot dialog box). You can email, FTP, or use an online service to transfer electronic files to your subcontractors and clients for collaboration or approval purposes. In the following steps, you will export a DWF file:

1. Open the Ch14-D.dwg file on the book’s web page.

2. Click the ribbon’s Output tab and, in the Export To DWF/PDF panel, click on the drop-down arrow under the Export icon. Select DWFx from the menu that appears.
3. Click the Save button in the Save As DWFx dialog box.

4. Right-click the Ch14-D.dwf file on your hard drive; select Open With, and select Microsoft Internet Explorer. After a few moments, the vector drawing appears in the browser. Click the Fit To Width button at the bottom of the interface (see Figure 14.32).

**FIGURE 14.32** DWFx drawing displayed in Internet Explorer

Use Autodesk Design Review if you want to view and mark up DWF or DWFx files.

---

**THE ESSENTIALS AND BEYOND**

In this chapter, you learned how to configure a typical output device by creating both a system printer and an AutoCAD plotter. You configured a plot style table and created a template that uses it. In addition, you plotted from both modelspace and layouts in paperspace, saved a page setup, and learned the entire plotting process. Finally, you learned how to keep everything in a digital format and export a DWFx file that can be shared over the Internet.

*(Continues)*
**Additional Exercise**

Explore the `PUBLISH` command on your own. Experiment with publishing multiple layouts from one drawing or any combination of modelspace views and layouts from multiple sheets all at once. The Publish feature is a great time-saver when you are ready to plot a stack of sheets. You can even try saving a sheet list for printing an identical set of the same drawings at another time.
CHAPTER 15

Working with Data

*The AutoCAD® 2014 program* has several features that allow you to manipulate data within your drawings. (Please note that AutoCAD® LT doesn’t support these features.) In this chapter, you’ll begin by geolocating project geometry. Then you will define attributes within a block definition in order to store nongraphical data. You’ll proceed to enter values in several block references, and then you’ll create a table to organize and display this data on a drawing layout. The data shown in the table will be a mixture of static text and dynamically linked fields that display textual information in modelspace. After creating this complex data-management system, you’ll change one of the attribute’s values and watch as the fields displaying data in the table automatically update.

- Geolocating projects
- Importing SketchUp models
- Defining attributes and blocks
- Inserting attributed blocks
- Editing table styles and creating tables
- Using fields in table cells
- Editing table data

### Geolocating Projects

In AutoCAD 2014, you can store your project’s geographic location and site orientation with respect to true north within the drawing file. This information can be specified using road maps or aerial imagery all within AutoCAD, without having to use another program to access this information (such as Google Earth).
When geolocated blocks or images are inserted or attached to your drawing files, they are aligned using the geographic data as the common point of reference. When each team member uses geolocated drawings, drawing coordination will be automatically streamlined. In the following steps, you will geolocate a drawing using the AutoCAD built-in mapping service:

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 15, get the file Ch15-A.dwg or Ch15-A-metric.dwg, and open it. The drawing is an elaboration on the diagram you dimensioned in Chapter 11, “Dimensioning” (see Figure 15.1).

2. Select the ribbon’s Insert tab, open the Set Location flyout in the Location panel, and choose From Map. Use the navigation controls located in the upper right of the map in the Geographic Location dialog box to locate a hypothetical site for this structure. When you have zoomed in sufficiently to settle on a site location, right-click and choose Drop Pin Here from the context menu. A red pin icon appears on the map at the location where you right-clicked (see Figure 15.2).
Geolocating Projects

3. Click the Continue button at the bottom of the Geographic Location dialog box. You are prompted on the command line to select a point within the drawing for the location corresponding to the pin on the map. Click the center of the spiral staircase at the center of the floor plan.

4. The command line reads:

   Specify the north direction or [Angle]<Angle>:

   Press Enter to accept the default option of Angle, type 45, and press Enter to end the GEOGRAPHICLOCATION command. A red geomarker icon appears at the location you selected in step 3 (see Figure 15.3).
5. After you have geolocated the drawing, a specialized Geolocation tab appears on the ribbon. To hide the map from the drawing window, go to the Map Tools panel on the Geolocation tab, open the Map Aerial flyout, and select Map Off.

6. To hide the geomarker icon from the drawing window, type `GEOMARKERVISIBILITY`, press Enter, type `0`, and press Enter again.

7. Save your work as Ch15-B.dwg or Ch15-B-metric.dwg.

**Using Design Feed**

Design Feed is a new palette in AutoCAD 2014 that is accessible from the Autodesk® 360 Ribbon tab. Use Design Feed to share text messages and/or images with your colleagues. Posts are created and read using AutoCAD 2014 or the free AutoCAD® WS app for mobile devices. Whenever you tag a colleague in a post, it automatically appears in their Design Feed palette or AutoCAD WS app and they also are notified by email. All posts are stored in Autodesk 360 no matter where they are created so you can stay electronically connected to your colleagues in the office and in the field. You can also optionally geolocate your posts in drawings so that they refer to specific areas in the real world.
Importing SketchUp Models

You can now import SketchUp models into AutoCAD from SKP files and import models from the Trimble 3D Warehouse using one of the free Autodesk Exchange Apps that ships with AutoCAD 2014. The ribbon’s Plug-ins tab has the Import SKP tool, which you will use to import a model from the 3D Warehouse in the following steps:

1. Open your web browser and go to http://sketchup.google.com/3dwarehouse to access Trimble 3D Warehouse. Type Notre Dame in the search bar and click the Search button. Select the Notre Dame de Paris model by Kevin Girard, which is the top result as of the date of this book’s publication (see Figure 15.4). Click the Download Model button, select SketchUp 7 (.skp) from the menu that appears, and save it to your downloads folder.

![Download a model from the 3D Warehouse](image)

**Figure 15.4** Downloading a model from the 3D Warehouse
2. In AutoCAD 2014, create a new blank document and select the 3D modeling workspace. Then select the Plug-ins tab and click the Import SKP tool. In the Select SKP File dialog box that appears, select the file you downloaded in the previous step and click the Open button.

3. Click any point in the drawing window to select an insertion point for the model.

4. Type **Z** for **ZOOM** and press Enter. Type **E** for the Extents option and press Enter.

5. Hold down Shift and drag the mouse wheel or middle button to orbit the model so you can view the model in 3D. Zoom and/or pan the model to create a pleasing bird’s-eye view of the cathedral.

6. From two separate in-canvas menus located in the upper-left corner of the drawing window, select Perspective and Shaded With Edges to better visualize the geometry (see Figure 15.5).

7. Close the drawing without saving. Select the Drafting & Annotation workspace.

---

**Figure 15.5** Viewing the imported Notre Dame cathedral 3D model in AutoCAD

Refer to Chapters 16–18 for more on 3D modeling.
Defining Attributes and Blocks

Blocks can be defined with attributes that contain any manner of textual information relevant to the object in question. Let’s explore this topic in an exercise. First you’ll alter the Annotative text style that will be used by the attributes you create. Then you’ll create attribute definitions to store employees’ names and ID numbers. Finally, you’ll define a simple block composed of two rectangles containing the attribute definitions.

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 15, get the file Ch15-B.dwg or Ch15-B-metric.dwg, and open it.

2. Type **ST** (for Style), and press Enter. Select the Annotative style in the Styles list on the left side of the Text Style dialog box. Select romans.shx in the Font Name drop-down menu. Type 1/8” (or 0.30 cm) in the Paper Text Height box (see Figure 15.6). Click Apply, select Set Current, and then click Close.

3. Click the Rectangle tool in the Draw panel of the ribbon’s Home tab. Click a point at some arbitrary distance from the building as the start point, type @3’,1’ (or @99,25 in metric), and press Enter.

4. Click the Copy tool in the Modify panel, select the rectangle you just drew, and press Enter. Press F3 to toggle on Endpoint object snap if it is not already on, click the upper-left corner of the rectangle, and
then click its lower-left corner to create two vertically stacked rectangles. Press Enter to end the COPY command.

5. Click the Line tool in the Draw panel, and click points A, B, and C in Figure 15.7. Press Enter to end the LINE command.

![Figure 15.7 Drawing simple geometry to form the basis of an attributed block]

6. Select 1/4" = 1'-0" scale (or 1:40 scale in metric) from the Annotation Scale menu on the status bar.

7. Right-click the Object Snap toggle on the status bar, and turn on Midpoint running object snap mode if it is not already on.

8. Expand the Block panel, and click the Define Attributes tool to open the Attribute Definition dialog box. Type NAME as the tag, Employee Name? as the prompt, and Smith as the default. Set Justification to Middle Center and Text Style to Annotative (see Figure 15.8).

### Understanding the Parts of an Attribute

Tag, Prompt, and Value, along with a number of additional settings and optional modes, define every attribute. Tag is the programming name (typically capitalized without any spaces in the tag). Prompt is the question you’ll be asking the person who inserts the attributed block, prompting them to enter the attribute value. The value is entered only when the attributed block is inserted, and not when the attribute is defined (see the next section, “Inserting Attributed Blocks”). The optional Default setting displays a default value when the attributed block is eventually inserted into a drawing.
9. Click OK to close the Attribute Definition dialog box. Click the midpoint at point D in Figure 15.7. Figure 15.9 shows the result.

![Figure 15.8](image1)

**Figure 15.8** Specifying the properties of an attribute definition

![Figure 15.9](image2)

**Figure 15.9** Placing an attribute definition in relation to the block definition geometry

10. Press the spacebar to repeat the ATTDEF command. Type **IDNO** as the tag, **Identification number?** as the prompt, and **1234** as the default (see Figure 15.10). Set Justification to Middle Center and click OK. Click the midpoint of the lower diagonal line at point E in Figure 15.7.
11. Click the Erase tool in the Modify panel, select the two diagonal lines, and press Enter.

12. Click the Create tool in the Block panel, and type Employee Data in the Name text box.

13. Click the Pick Insertion Base Point icon, and then click point C in Figure 15.7.

14. Click the Select Objects icon, click the NAME attribute definition, and then click IDNO. Select both rectangles, and press Enter. Click the Delete radio button in the Objects area of the Block Definition dialog box, and select Inches (or Centimeters) in the Block Unit drop-down menu (see Figure 15.11). Click OK and the attribute definitions and geometry disappear as expected.

15. Save your work as Ch15-C.dwg or Ch15-C-metric.dwg.
Inserting Attributed Blocks

After you have (or your CAD manager has) gone to the trouble of defining blocks with attributes, inserting them and entering values is easy. In the following steps, you'll insert three Employee Name blocks and enter appropriate values in each block reference:

1. If the file is not already open, go to the book’s web page, browse to Chapter 15, get the file Ch15-C.dwg or Ch15-C-metric.dwg, and open it.

2. Set the Symbol layer as current in the Layer drop-down menu in the Layers panel.

3. Click the Insert tool in the Block panel. Open the Name drop-down menu, and select Employee Data. Verify that Specify On-Screen is selected in the Insertion Point area (see Figure 15.12).

4. Click OK in the Insert dialog box, and then click a point in the center of the room on the right. The command prompt reads:

   Employee name? <Smith>:

   Type Bruno, and press Enter. The prompt now reads:

   Identification number? <1234>:

   Type 108, and press Enter. The block reference appears in the room with the values you typed in (see Figure 15.13).
5. Type `ATTDIA`, and press Enter. Type `1`, and press Enter.

6. Type `I` (for Insert), and press Enter twice. Click a point in the center of the room on the left. Type `Andreae` as the employee name, press Tab, and type `864` as the identification number in the Edit Attributes dialog box (see Figure 15.14). Click OK.

7. Press the spacebar to repeat the INSERT command and press Enter. Click a point in the center of the room on the bottom. Type `Dee` as the employee name, press Tab, and type `273` as the identification number in the Edit Attributes dialog box. Click OK. Figure 15.15 shows the result.
8. Save your work as Ch15-D.dwg or Ch15-D-metric.dwg.

Editing Table Styles and Creating Tables

Tables are like having Microsoft Excel or another spreadsheet program within AutoCAD. The overall appearance of tables is controlled by table styles. Cell spacing, borders, and background coloring is controlled by individual table cells. In the following steps, you’ll adjust a table style, create a new table, and begin adding content to its cells:

1. If the file is not already open, go to the book’s web page, browse to Chapter 15, get the file Ch15-D.dwg or Ch15-D-metric.dwg, and open it.

2. Expand the Annotation panel on the Home ribbon tab, and click the Table Style icon. Click the Modify button in the Table Style dialog box that appears.
3. In the Modify Table Style: Standard dialog box that appears, open the Cell Styles drop-down menu and select Title. Select the General tab if it is not already selected. Double-click in the Horizontal text box in the Margins area. Type \(\frac{1}{16}\)" (or 0.20 cm), press Tab, and type \(\frac{1}{16}\)" (or 0.20 cm) to specify an equal vertical margin (see Figure 15.16).

![Modify Table Style: Standard](image)

**FIGURE 15.16** Modifying the margins around the Title cell style

---

4. Select the Text tab within the Modify Table Style: Standard dialog box. Open the Text Style drop-down menu, and select Bold. Double-click the Text Height text box, and type \(\frac{3}{8}\)" (or 0.80 cm) (see Figure 15.17).

![Modify Table Style: Standard](image)

**FIGURE 15.17** Editing the Title cell style text properties

---

Table cell styles have three types: Title, Header, and Data.
5. Open the Cell Styles drop-down menu and select Header. Open the Text Style drop-down menu and select Bold. Double-click the Text Height text box, type 1/4” (or 0.50 cm), press Tab, and observe the preview image update.

6. Open the Cell Styles drop-down menu and select Data. Open the Text Style drop-down menu and select Simple. Double-click the Text Height text box, and type 1/4” (or 0.50 cm). Press Tab to update. The updates to the table style are complete. Click OK, and then click Close to end the TABLESTYLE command.

7. Click the Quick View Layouts tool on the status bar. Select Layout1, and press Esc to exit Quick View Layouts mode.

8. Open the Layer drop-down menu in the Layers panel, and set the Table layer as current.

9. Click the Table tool in the Annotation panel. Set the number of Columns to 4 and Data Rows to 3 in the Insert Table dialog box. Set Column Width to 1” (or 2.5 cm) (see Figure 15.18). The Title, Header, and Data cell styles you customized within the Standard table style will be used by default. Click OK.

**FIGURE 15.18** Specifying the number of columns and rows in the Insert Table dialog box
Linking to Tables in External Spreadsheets

Select the From A Data Link radio button in the Insert Table dialog box, and click the Launch The Data Link Manager icon to link dynamically to a spreadsheet in Microsoft Excel.

10. Click approximately at point A in Figure 15.19 to place the empty table on the layout.

11. The cursor is highlighted within the table’s top cell. Zoom into the table by turning the mouse wheel. Type Room Schedule, and press the Tab key. Type Employee, press Tab, and type ID No. Press Tab again. The Tab key advances to the next cell from left to right, and then from top to bottom at the end of each row.

12. Type Area (ft² in Imperial units) or Area (m² in metric units).
13. Right-click to open the context menu. Select Symbol \( \Rightarrow \) Squared as shown in Figure 15.20. Type \( ) \) and press Tab. Now the column header indicates an area in square feet (or square meters). Click outside the table on the layout to deactivate it.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Room Schedule</td>
<td>Select all</td>
<td>Qt/HA</td>
</tr>
<tr>
<td>2</td>
<td>Employee</td>
<td>ID No.</td>
<td>Area (ft(^2))</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 15.20** Accessing the symbol for squared

14. Click in the table to highlight it, and then select cell D2 to highlight it for editing. Click the Delete Column tool in the Columns panel within the ribbon’s contextual Table Cell tab.

15. Use the arrow keys to move between cells in the table. Press the left arrow key twice to move to cell A2. Each cell has four grips. Click cell A2’s right grip, and move it to the right to stretch column A wider. Click a point a short distance to the right to set the column width approximately as shown in Figure 15.21.

16. Press the right arrow key twice to move to cell B2. Click B2’s right grip, and stretch it to the right so that its entire header fits on one line. Repeat for cell C2. Press Esc to deselect. Figure 15.22 shows the result.

17. Save your work as Ch15-E.dwg or Ch15-E-metric.dwg.
Fields are variables that are inserted into blocks of text that can change what they display over time. For example, you can insert a date field onto a title block that will update to show the current date every time the drawing is plotted. You can also link fields to objects in the drawing so that the field will display any one of the object properties. In the following steps, you'll insert fields into cells within the table you designed in the previous section:

1. If the file is not already open, go to the book’s web page, browse to Chapter 15, get the file Ch15-E.dwg or Ch15-E-metric.dwg, and open it.

2. Select cell A3, which is the first data cell in the Employee column. Double-click within this cell to activate the Text Editor contextual tab on the ribbon. Click the Field tool on the Insert panel.
3. In the Field dialog box that appears, open the Field Category dropdown menu and select Objects. Select Object in the Field Names list. Click the Select Objects button, and select the attribute Bruno in the room on the right.

4. Select Value in the Property list that appeared after selecting the attribute in the previous step (see Figure 15.23). Click OK. The word Bruno appears in table cell A3.

5. Press the down arrow, and move to cell A4. Right-click and choose Insert Field from the context menu. Click the Select Objects button, and select the attribute Andreae in the room on the left. Choose Value from the Property list and click OK.

6. Repeat the previous step, selecting the attribute Dee in the room at the bottom.

7. Continue adding fields in the ID No column, selecting each attribute value as shown in Figure 15.24.

8. Double-click in cell C3 to activate the Text Editor. Press Ctrl+F to open the Field dialog box. Click the Select Objects button, and select the magenta line in the doorway of Bruno’s office. Choose Area from the Property list. The preview shows the area value as 347.014 SQ. FT. or 322388.23 (in units of square centimeters).
9. Click the Additional Format button. Then do the following:

- In Imperial units, remove the SQ. FT. text from the Suffix text box and type \( \frac{1}{144} \) in the Conversion Factor text box to convert from square inches to square feet. (This is converted to its decimal equivalent.) Click OK twice.

- In metric, type \( \frac{1}{10000} \) in the Conversion Factor text box in order to convert square centimeters to square meters manually (see Figure 15.25). Click OK twice.

### Table: Room Schedule

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>Room Schedule</td>
</tr>
<tr>
<td>2</td>
<td>Employee</td>
<td>ID No.</td>
<td>Area (ft(^2))</td>
</tr>
<tr>
<td>3</td>
<td>Bruno</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Andreae</td>
<td>864</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Dee</td>
<td>273</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 15.24** Inserting fields that link to attribute values in modelspace

**Figure 15.25** Converting units in the Additional Format dialog box
10. Press the down arrow to move to cell C4. Repeat the previous two steps, selecting the magenta line in Andreae’s office and displaying its area value in square feet (or square meters).

11. Press the down arrow to move to cell C5. Repeat steps 8 and 9, selecting the magenta line in Dee’s office and displaying its area value in square feet (or square meters). Click outside the table on the layout to deselect the table. Figure 15.26 shows the result.

<table>
<thead>
<tr>
<th>Room Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
</tr>
<tr>
<td>Bruno</td>
</tr>
<tr>
<td>Andreae</td>
</tr>
<tr>
<td>Dee</td>
</tr>
</tbody>
</table>

**Figure 15.26** Adding all the relevant fields to the table

12. Save your work as Ch15-F.dwg or Ch15-F-metric.dwg.

**Editing Table Data**

Beyond filling in a table with all the relevant information, you can also format it to display the data in an aesthetically pleasing fashion. You can change justification, alter border color and/or lineweight, and even change the background color of chosen cells to highlight them. In the following steps, you’ll format cells, add an additional row and a formula, and finally change an attribute and regenerate the drawing to see the table update:

1. If the file is not already open, go to the book’s web page, browse to Chapter 15, get the file Ch15-F.dwg or Ch15-F-metric.dwg, and open it.

2. Click the word Dee (cell A5 in the table) to activate the ribbon’s Table Cell contextual tab. Click the Insert Below button in the Row panel.

3. Press the down arrow, and move to cell A6. Hold down Shift, and click cell B6. Open the Merge Cells menu in the Merge panel, and select Merge By Row. Cells A6 and B6 are merged. Type **Total**, and click outside the table on the layout to deactivate Text Editing mode (see Figure 15.27).
4. Click the cell to the right of the word Total to activate cell C6. Click the Formula button in the Insert panel and select Sum. Click points A and B, as shown in Figure 15.28. Press Enter to accept the formula =Sum(C3:C5).

5. Select the number 163082.582 (or 1052147.80 in metric) that appears in cell C6 (total area in square inches or square centimeters). Hold down Shift, and select cell C3. Open the Data Format menu on the Cell Format panel, and select Custom Table Cell Format from the context menu.

6. Click the Additional Format button in the Table Cell Format dialog box that appears. Type 0.006944 (or 1/10000 in metric) in the Conversion Factor text box, and click OK to close the Additional Format dialog box.
7. Select Decimal in the Format list in the Table Cell Format dialog box. Open the Precision drop-down menu, and select 0.0 (see Figure 15.29). Click OK.

8. Open the text justification menu (currently set at Top Center) in the Cell Styles panel, and select Top Right. Cells C3 through C6 are right-justified.

9. Select cell B3, hold down Shift, and select cell B5. Change the justification to Top Right in the Cell Styles panel. Select cell A3, hold down Shift, and select cell A5. Change its justification to Top Left. Select merged cell AB6. Change its justification to Top Right. Click outside the table to deselect. Figure 15.30 shows the result.

<table>
<thead>
<tr>
<th>Room Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Bruno</td>
</tr>
<tr>
<td>Andreae</td>
</tr>
<tr>
<td>Dee</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

FIGURE 15.30 Table after adding a total row and justifying its data cells
10. Type **TABLESTYLE**, press Enter, and click the Modify button in the Table Style dialog box. In the Modify Table Style: Standard dialog box that appears, select Data from the Cell Styles drop-down menu if it is not already selected. Select the General tab if it is not already selected, double-click the Horizontal text box in the Margins area, type \( \frac{1}{8}'' \) (or 0.15 cm), and press Tab. Type \( \frac{1}{8}'' \) (or 0.15 cm), and click OK and then Close. There is a bit more space around the data cells.

11. Click the words Room Schedule to select merged cell ABC1. Open the Table Cell Background Color menu in the Cell Styles panel, and choose Select Colors. Select the True Color tab in the Select Color dialog box that appears. Type \(36,36,36\) in the Color text box and press Tab (see Figure 15.31). Click OK.

![Figure 15.31 Selecting a very dark table cell background color](image)

12. Double-click in cell ABC1 to activate the Text Editor contextual tab on the ribbon. Drag a selection encompassing the entire phrase Room Schedule. Open the Text Editor Color Gallery in the Formatting panel, and choose Select Colors. Select the True Color tab in the Select Color dialog box that appears. Type \(255,255,255\) in the Color text box, press Tab, and click OK. White text now appears on a black background. Click outside the table to exit Text Editor mode.

13. Toggle on Show/Hide Lineweight on the status bar if it is not already on.
14. Select cell ABC1, hold Shift, and select cell C6 to activate all the table's cells. Click the Edit Borders icon in the Cell Styles panel. Open the Lineweight drop-down menu, and select 0.70 mm. Click the Outside Borders button to apply the properties and click OK (see Figure 15.32). A thicker line appears around the outside borders of the table.

15. Click the border of the table to select the table itself. Click the Uniformly Stretch Table Height grip in the lower-left corner, and move it upward until the table reaches its maximum compactness (see Figure 15.33). Press Esc to deselect the table.
16. Now you'll change an attribute value and observe that this change appears automatically in the table through the fields linked to the attribute values. Click the Maximize Viewport icon in the status bar. Double-click the Employee Data block in Dee's office to open the Enhanced Attribute Editor. Type Newton, press Enter, type 33, and press Enter again (see Figure 15.34). Click OK to end the EATTEDIT command.

![Enhanced Attribute Editor](image)

**Figure 15.34** Editing attribute values in a maximized viewport

17. Click Minimize Viewport in the status bar. The table in Layout1 has automatically been updated, and it lists Newton and his newly entered identification number.

18. Select the Output tab, and click the Preview icon on the Plot panel. The gray background in the fields disappears and you see the table exactly as it would plot (see Figure 15.35). Press Esc to exit preview mode.

19. Your drawing should now resemble Ch15-G.dwg or Ch15-G-metric.dwg, which are available for download at the book's web page.
In this chapter, you learned how to define attributes and embed them in block definitions. You also inserted attributed blocks and adjusted their values in a drawing. In addition, you created a table and adjusted its style to control the table’s appearance, and you wrote text and inserted fields within the table to link to nongraphical information associated with attribute values and object data. In short, you now have the skills to manipulate data within AutoCAD 2014 drawings.

**Additional Exercise**

Use the `ATTEXT` command to extract attribute values from `Ch15-F.dwg` for analysis in an external spreadsheet program such as Microsoft Excel. To extract attribute values, you must first create a template text file containing attribute tags and formatting codes. The `Template.txt` file that has been supplied on this book’s web page (found in the Chapter 15 folder) is designed for this purpose. The letter C in the template indicates character format for words, and N indicates numerical data. The numbers 016000 and 004000 control how many characters/digits are in the output (16 and 4, respectively).
Type ATTEXT, and specify the location of both the template and output files. Click OK to create the CDF file. This standard file format can be imported into a spreadsheet program for analysis (or linking back into AutoCAD). In this simple example, there are only six values; however, in real-world projects, programmatically extracting hundreds of attributes' values can be quite a time-saver.
Navigating 3D Models

The only tools you need to navigate 2D drawings are Pan and Zoom, which are simple to use. However, getting around 3D models can be a bit more challenging. This chapter will delve into how to navigate 3D models in the AutoCAD® 2014 program. (Please note that the AutoCAD LT® software doesn’t support these features.) You’ll learn various methods for visualizing and navigating 3D models, from selecting visual styles to using preset isometric views. You’ll also learn how to orbit into custom views and interactively navigate in perspective.

- Using visual styles
- Working with tiled viewports
- Navigating with the ViewCube
- Orbiting in 3D
- Using cameras
- Navigating with SteeringWheels
- Saving views

Using Visual Styles

Visual styles control the way models appear in each viewport. The default visual style is 2D Wireframe, which is what you have been using in previous chapters. Consider for a moment how 3D models are displayed on a 2D screen—an illusion. Creating the illusion of where objects are situated in space requires some visual indication as to which objects are in front of other occluded objects. A wireframe representation does not give this indication. Rather, occlusion objects need to be either hidden or covered by the shading of other objects according to the visual style that is selected.
Visual styles are never photorealistic like a rendering can be (see Chapter 18, “Presenting and Documenting 3D Design”), but many offer more realistic real-time views of your model compared to wireframe representations. In the following steps, you will sample the visual styles available in AutoCAD 2014.

The model in this chapter is a conceptual model of the O2 Arena in London that you will build in Chapter 17, “Modeling in 3D.” The O2 Arena (designed by architect Richard Rogers) was originally known as the Millennium Dome because it opened on January 1, 2000. This distinctive, mast-supported, dome-shaped cable network structure was one of the venues for the London 2012 Olympics (see Figure 16.1).

Symbolizing the number of days, weeks, and months in a year, the O2 Arena is 365 m in diameter and 52 m high, and is supported by 12 masts. It is also on the Prime Meridian that runs through Greenwich.

**Figure 16.1** You will navigate a 3D conceptual model of the O2 Arena in this chapter.

1. Go to the book’s web page at www.sybex.com/go/autocad2014essentials, browse to Chapter 16, get the file Ch16-A.dwg, and open it. The sample file is displayed in 2D Wireframe visual style by default.

2. Select the 3D Modeling workspace from the Quick Access toolbar.

3. Select the ribbon’s View tab, and open the Visual Styles drop-down menu at the top of the Visual Styles panel (see Figure 16.2).

4. Select the Wireframe icon. The UCS icon displays a colorful axis tripod in this visual style (see Figure 16.3).
5. Select the Visual Styles Manager icon in the Palettes panel to alter visual style settings. Scroll down the list of Available Visual Styles In Drawing, and select Shaded With Edges. Change Color to Tint in the Face Settings group (see Figure 16.4).

You can change the uniform background color using the Colors button on the Display tab of the Options dialog box, invoked with the OPTIONS command.

6. Select the Apply Selected Visual Style To Current Viewport button, as shown in Figure 16.4. Close the Visual Styles Manager. Figure 16.5 shows the result in the drawing canvas.

**Figure 16.2** Selecting a visual style

**Figure 16.3** Wireframe visual style
7. Open the Visual Styles drop-down menu in the Visual Styles panel, and select Save As A New Visual Style. The command prompt reads:

```
Save current visual style as or [?]:
```
Type **Tinted with edges**, and press Enter. These words appear on the Visual Styles drop-down menu, showing that this is now the current visual style.

8. You can also change visual styles using the in-canvas controls located in the upper-left corner of the viewport. Select the Visual Style Controls to open a menu (see Figure 16.6).

9. Choose X-ray from the in-canvas menu that appears. Figure 16.7 shows the result: a transparent, shaded view with edges.

10. Save your work as Ch16-B.dwg.

![In-canvas controls](image1)

**FIGURE 16.6** In-canvas controls

![X-ray visual style](image2)

**FIGURE 16.7** The X-ray visual style lets you see through solid objects.
Working with Tiled Viewports

Tiled viewports allow you to visualize a 3D model from different simultaneous vantage points. By starting a command in one viewport and finishing it in another, you can more easily transform objects in 3D. To help you get a better grasp of how this works, the following steps show you how to divide the single default viewport into three tiled viewports:

1. If the file is not already open, go to the book’s web page, browse to Chapter 16, get the file Ch16-B.dwg, and open it.

2. Type `VPORTS`, and press Enter. In the Viewports dialog box that appears, select Three: Right in the Standard Viewports list. Open the Setup drop-down menu, and select 3D (see Figure 16.8). Click OK.

3. Click anywhere inside the viewport showing the front view to activate it. Open the in-canvas Visual Style Controls menu in this viewport and select Shaded. Click anywhere inside the viewport showing the top view to activate it. Open the in-canvas Visual Style Controls menu in this viewport and select Wireframe. Click OK. Figure 16.9 shows the result.
4. Select the plus (+) symbol in the upper-left viewport displaying the front view to open the in-canvas Viewport menu. Select Maximize Viewport. The front view fills the drawing canvas.

5. Observe that what was formerly a plus (+) symbol in the in-canvas Viewport menu is now a minus (–) symbol. Double-click the minus symbol to minimize this viewport, displaying the front view.

6. Click anywhere inside the right viewport showing the SE Isometric view to activate it. Double-click this viewport’s plus symbol to maximize it. The SE Isometric view once again fills the drawing canvas.

7. Save your work as Ch16-C.dwg.

Navigating with the ViewCube

The ViewCube is a 3D navigation interface that lets you easily rotate through numerous preset orthogonal and isometric views. The ViewCube’s instant visual feedback keeps you from getting lost in 3D space, even when you orbit into a custom view.
The ViewCube helps you visualize the relationship between the current user coordinate system (UCS) and the world coordinate system (WCS).

In the following steps, you will experiment with the ViewCube and learn how to view a 3D model from almost any angle.

1. If the file is not already open, go to the book’s web page, browse to Chapter 16, get the file Ch16-C.dwg, and open it.

2. Open the ViewCube menu (see Figure 16.10), and select Set Current View As Home.

3. Hover your cursor over the ViewCube, and observe that different parts highlight in blue as you pass over them. Click the word Right. The view changes to an orthogonal view of the right side of the model (also known as an architectural elevation).

4. The ViewCube rotates with the view change. Hover the cursor over each of the elements on the right face and observe there are four corners, four edges, plus the right face itself that highlights in blue. In addition, there are four arrows facing the cube and two curved arrows in the upper right. Each of these interface elements rotates the view in a specific direction, as indicated in Figure 16.11.
5. Spend some time navigating with the ViewCube, rotating into multiple different views. Try Bottom, Left, Back, SE Isometric, and NW Isometric.

6. Click the Home icon in the ViewCube interface to return to the initial view.

7. Select the UCS icon at the center of the 3D model to activate it. Drag the tip of the blue z-axis. The command prompt reads:

   ** Z AXIS DIRECTION **
   Specify a point on Z axis:

   Click an arbitrary point in the drawing canvas to rotate the UCS. Observe that the ViewCube rotates relative to the current UCS (see Figure 16.12). This feedback can help you visualize where the XY drawing plane is (parallel to the Top face of the ViewCube).

   ![Figure 16.12: ViewCube aligned to the current UCS](image)

8. Open the ViewCube’s Coordinate System menu, and select WCS to restore the original coordinate system.

9. Save your work as Ch16-D.dwg.
Orbiting in 3D

As you learned in the previous section, the ViewCube is limited to rotating the view in 45° increments. While the ViewCube might get you close to the angle from which you wish to view a 3D model, you will often need to orbit to the optimal viewing angle to see particular geometry best. Orbiting refers to rotating the view at any arbitrary angle. In the following steps, you will learn a few methods of orbiting in 3D:

1. If the file is not already open, go to the book’s web page, browse to Chapter 16, get the file Ch16-D.dwg, and open it.

2. Let’s assume that you want to get a close look at the ventilation towers that appear under a large elliptical hole in the dome membrane. Click the edge between the Top and Front faces, and zoom into the ventilation towers, as shown in Figure 16.13.

3. Position the cursor over the compass ring surrounding the ViewCube, and drag it to the right to get a better view of the ventilation towers so that the hole in the dome membrane appears more circular.

4. Click the Orbit tool in the Navigation bar. Drag down in the drawing canvas to orbit your point-of-view upward until you can see the ventilation towers unobstructed by the dome membrane (see Figure 16.14). Press Esc to end the 3DORBIT command.
Using Cameras

AutoCAD uses virtual cameras to set up views similar to those achieved in the real world with physical cameras. The `CAMERA` command creates a camera object that you can manipulate in an isometric view to position the viewpoint in relation to the camera target. In the following steps, you will create a virtual camera and position it in an isometric view:

1. If the file is not already open, go to the book’s web page, browse to Chapter 16, get the file Ch16-E.dwg, and open it.

2. Open the in-canvas View Controls menu, and select SW Isometric.

3. Zoom out by rolling the mouse wheel backward.

4. Toggle off Object Snap in the status bar.

5. Type `CAMERA`, and press Enter. Click points A and B, as shown in Figure 16.15, and press Enter.
6. Select the camera object. Select the Shaded visual style in the Camera Preview window that appears. Drag the Lens Length/FOV grip to the right, and click approximately at point A to expand the field of view (see Figure 16.16).

![Figure 16.15](image1)

**Figure 16.15** Placing a camera in an isometric view

![Figure 16.16](image2)

**Figure 16.16** Adjusting a camera in an isometric view
7. Drag the Camera & Target Location grip forward until the camera is under the outer edge of the dome. Figure 16.17 shows the Camera Preview window. You will correct the fact that the camera is “on the ground” in the next step.

**Figure 16.17** Camera Preview window showing the new position of the camera “on the ground”

8. Right-click in the drawing window, and choose Set Camera View. Drag the mouse wheel downward to move the camera and its target upward, as shown in Figure 16.18.

**Figure 16.18** Looking through the camera

9. Save your work as Ch16-F.dwg.
Navigating with SteeringWheels

The SteeringWheel is an interactive navigation control that Autodesk uses in many 3D applications, including AutoCAD. In the following steps, you will use the SteeringWheel’s full navigation wheel feature (displaying all eight navigation tools) to compose a view under the dome.

1. If the file is not already open, go to the book’s web page, browse to Chapter 16, get the file Ch16-F.dwg, and open it.

2. Select the SteeringWheel tool in the Navigation bar. The full navigation wheel appears in the drawing canvas in close proximity to the cursor (see Figure 16.19).

Additional SteeringWheels

There are eight commands that appear on variations of SteeringWheels: Zoom, Pan, Orbit, Rewind, Center, Walk, Up/Down, and Look.

There are three basic SteeringWheels: Full Navigation, View Object, and Tour Building. The latter two wheels have four commands—each command is suitable to its purpose of navigating around an object or touring through a building.

Each one of the basic wheels has a corresponding mini-wheel with the same commands as the larger interface. I suggest starting with the basic wheels and then graduating to mini-wheels as you gain experience. Mini-wheels are more efficient because you don’t have to move the mouse as far to select navigation commands.
3. Position the cursor over the Walk tool within the inner ring of the SteeringWheel. Click and hold the mouse button, and observe a walk circle appear in the lower portion of the drawing canvas. Drag the cursor relative to the walk circle to move in that direction (see Figure 16.20). The further from the walk circle you drag, the faster you walk in that direction. Release the mouse button.

![Full navigation SteeringWheel interface](image)

**Figure 16.19** Full navigation SteeringWheel interface

![Walking under the dome](image)

**Figure 16.20** Walking under the dome

4. Position the cursor over the Look tool in the SteeringWheel's inner ring. Click and hold the mouse button, and drag upward to rotate the camera to look up at the hole in the dome above the ventilation towers. Release the mouse button.
5. Position the cursor over the Rewind tool in the SteeringWheel’s outer ring. Drag to the left to go backward in the history of movements made using the steering wheel. Drag back to the point before you looked up (see Figure 16.21). Press Esc to exit the SteeringWheel.

6. Save your work as Ch16-G.dwg.

**Saving Views**

Named views allow you to save where you are in space so that you can recall these positions in the future. In the following steps, you will save the current position in the viewport, change the view, switch out of perspective, and then return to the saved view:

1. If the file is not already open, go to the book’s web page, browse to Chapter 16, get the file Ch16-G.dwg, and open it.

2. Type `V` (for view), and press Enter. Click the New button in the View Manager dialog box that appears.

3. In the New View / Shot Properties dialog box that appears, type `Camera2` as the view name (see Figure 16.22). Click OK twice to close both open dialog boxes.
4. Click the upper-left corner of the left face of the ViewCube to switch to the NW Isometric view. The model is still in perspective even after switching out of the Camera2 view (see Figure 16.23).
5. You can toggle in and out of perspective view at any time. Open the in-canvas View Controls menu, and select Parallel to switch out of perspective.

6. Type V (for view), and press Enter. Select Camera2 in the list of Model Views in the View Manager dialog box (see Figure 16.24). Click Set Current, Apply, and then OK. The initial perspective view is restored.

![View Manager](image)

**Figure 16.24** Restoring a view

7. Save your work as Ch16-H.dwg. Figure 16.25 shows the result.

![X-ray view from Camera 2](image)

**Figure 16.25** The X-ray view from Camera 2
In this chapter, you learned how to view a 3D model in a variety of ways, including changing its visual styles and working with tiled viewports. You also picked up important 3D navigation skills using the ViewCube, SteeringWheel, and 3DORBIT command. In addition, you placed a camera, adjusted its position and field of view in Isometric mode, looked through its virtual lens, and walked around an interior building space. Finally, you learned how to save and restore views so that you can get back to the places the virtual camera has been.

**Additional Exercise**

Did you know AutoCAD can create walkthrough and/or flyby animations? First draw a spline to act as a camera motion path. Edit the spline (see Chapter 5, “Shaping Curves,” if necessary) so that the spline has a smooth 3D shape. Use the ANIPATH command to create a motion path animation, linking the camera’s path to the spline you just drew. Export the animation to your hard drive and watch the video. You can share video files with people who don’t have AutoCAD.
CHAPTER 17

Modeling in 3D

*The AutoCAD® program has* three different 3D modeling toolsets comprising surfaces, solids, and meshes reflecting the historical evolution of computer graphics. Each toolset was initially developed to suit specific industries: surfaces for industrial design, solids for engineering, and meshes for games and movies. Each toolset has its particular strengths and limitations that become evident the more you use it. Yet AutoCAD allows you to pick the best tool for the job no matter what type of work you do, so that you can find the best solutions for your drawings. We will explore these tools throughout this chapter, where you will learn how to create and edit surfaces and solid models, and how to smooth out geometry with mesh tools.

- Creating surface models
- Editing surface models
- Creating solid models
- Editing solid models
- Smoothing meshes

Creating Surface Models

In this chapter, you will create a conceptual model of the O2 Arena in London, the same model used in Chapter 16, “Navigating 3D Models.”

In AutoCAD, *surfaces* are defined as infinitely thin shells that do not contain any mass or volume. Two-dimensional profile shapes have been provided in this chapter’s sample file that you will use to create 3D surfaces. You will begin the following exercise by creating a planar surface and then revolving, sweeping, and extruding 2D profiles into 3D surfaces.
Making Planar Surfaces

Planar surfaces differ from flat bounded areas like circles and closed polylines in that they display surfaces rather than edges only, in shaded visual styles. In the following steps, you will create this simplest of all surfaces from a circle:

1. Go to the book’s web page at www.sybex.com/go/autocad2014 essentials, browse to Chapter 17, get the file Ch17-A.dwg, and open it. The sample file is displayed in the Shaded With Edges visual style so that surfaces will be visible when you create them.

2. Select the 3D Modeling workspace from the Quick Access toolbar.

3. Select the ribbon’s Home tab, and click the Make Object’s Layer Current tool in the Layers panel. Select the circle at the center of the drawing to set the Dome Membrane layer as current.

4. Select the ribbon’s Surface tab, and click the Surface Associativity toggle in the Create panel if it is not already highlighted in blue.

5. Select the Planar tool in the Create panel. The command prompt reads:

   Specify first corner or [Object] <Object>:

   Press Enter to accept the default Object option. Select the blue circle at the center of the drawing and press Enter. A planar surface appears as the PLANESURF command ends.

6. Click the SW corner of the ViewCube to move to a SW isometric viewpoint. The blue planar surface you just created is visible at the top of the dome (see Figure 17.1).

   ![Figure 17.1 Creating a planar surface at the top of the dome](image)
Revolving a 2D Profile to Create a 3D Model

Much as you would turn wood on a lathe, you create 3D surfaces by revolving open profiles like lines, arcs, or polylines around an axis. In the following steps, you will revolve a single arc to generate the exterior surface of the dome:

1. Select the ribbon’s Surface tab, and toggle off the Surface Associativity icon in the Create panel.

2. Select the Revolve tool on the Create panel of the ribbon’s Surface tab. Select the blue arc running from the planar surface at the top of the dome down to the white circle at the periphery and press Enter.

3. The command prompt reads:

   Specify axis start point or define axis by [Object X Y Z] <Object>:

   Type \(0,0\) and press Enter.

4. The command prompt now says:

   Specify axis endpoint:

   Type \(0,0,1\) and press Enter. Press Enter again to accept the default angle of revolution (360 degrees). The REVOLVE command ends, and the dome surface appears (see Figure 17.2).

5. Type E (for Erase), and press Enter. Type P (for Previous), and press Enter. Press Enter again to erase the arc that generated the dome surface.

The dome is centered on the origin point in the sample file.

FIGURE 17.2 Revolving an arc to generate the dome surface
Three-Dimensional Cartesian Coordinates

The Z direction extending above and below the ground plane can be specified within Cartesian coordinates simply by adding a second comma followed by the Z value. For example, the coordinates of a point one unit above the origin point are $0, 0, 1$.

6. Type LA (for Layer), and press Enter to open the Layer Properties Manager. Double-click the icon representing the Arena layer to set it as current.

7. Click the Dome Membrane layer’s lightbulb icon to toggle it off.

8. Click the Auto-hide toggle so that the palette collapses when the cursor isn’t over it (see Figure 17.3).

![Auto-hide toggle](image)

Figure 17.3 Changing layer properties

Sweeping Out 3D Geometry

The SWEEP command gives you the ability to create surfaces by pushing an open profile through space following a path. In these steps, you will model the area within the O2 Arena and its internal roof by sweeping open shapes along closed paths:

1. Select the Sweep tool on the Create panel of the ribbon’s Surface tab. Select the green arena profile shown in Figure 17.4 and press Enter.
2. The command prompt reads:

   Select sweep path or [Alignment Base point Scale Twist]:

   Select the arena sweep path as shown in Figure 17.4. Figure 17.5 shows the resulting 3D arena.
3. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Double-click the Arena Roof layer’s icon to set it as current.

4. Press the spacebar to repeat the **Sweep** command. Select the arena roof profile and press Enter. Select the arena roof sweep path. Figure 17.6 shows the result.

![Sweeping the arena roof](image)

**FIGURE 17.6** Sweeping the arena roof

5. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Double-click the Dome Edge layer’s icon to set it as current. Toggle off the Arena and Arena Roof layers.

---

**Extruding 2D Geometry into 3D**

*Extruding* means pushing forcibly through a die, like hot steel beams being extruded at a foundry. In the following steps, you will extrude the boundary representing the edge of the dome membrane as a curtain-like wall. In the next section, you will use this curtain to trim off the outer portion of the membrane.

1. Select the Extrude tool on the Create panel of the ribbon’s Surface tab. Select the magenta dome edge (see Figure 17.7) and press Enter.

2. The command prompt reads:

   Specify height of extrusion or [Direction Path Taper angle]
Type 50, and press Enter. A 3D curtain-like wall rises up out of the 2D edge.

3. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Toggle on the Dome Membrane layer. Double-click the Dome Membrane layer’s icon to set it as current. Figure 17.8 shows the result.

4. Save your work as Ch17-B.dwg.
Editing Surface Models

Surface models have editing tools that modify existing surface boundaries. In the following sections, you will modify surface boundaries using other surfaces, or by projecting edges onto existing surfaces and using these projections to modify boundaries or cut holes in surfaces. In addition, you will project 2D objects onto 3D surfaces without altering the surfaces at all.

Trimming Surfaces with Other Surfaces

In the following steps, you will trim off the portion of the dome membrane that extends beyond the curtain wall extrusion you generated in the previous section:

1. If the file is not already open, go to the book’s web page, browse to Chapter 17, get the file Ch17-B.dwg, and open it. Switch to the 3D Modeling workspace if it’s not selected already in the Quick Access toolbar.

2. Select the Trim tool on the Edit panel of the ribbon’s Surface tab. The command prompt reads:

   Select surfaces or regions to trim or [Extend PROjection direction]:

   Click point A in Figure 17.8, and press Enter.

3. The command prompt now says:

   Select cutting curves, surfaces, or regions:

   Click point B in Figure 17.8, and press Enter.

4. The prompt says:

   Select area to trim [Undo]:

   Click point C in Figure 17.8, and press Enter. The SURFTRIM command ends.

5. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Click the Sun icon to freeze the Dome Edge layer. Figure 17.9 shows the resulting trimmed dome membrane.
Projecting Edges on Surfaces

In the following steps, you will project a series of 2D objects onto a 3D surface. More specifically, you will project the large hole for the ventilation towers, 12 smaller holes accommodating the structural masts, and numerous cables onto the surface of the dome membrane.

1. You want to see through the dome but cannot in the Shaded With Edges visual style. Using the in-canva controls in the top-left corner of the viewport, click the Visual Style menu and select Wireframe.

2. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Double-click the Dome Voids layer’s icon to set it as current.

3. Zoom into the area where there is a large orange circle with a series of light blue circles and ellipses inside it.

4. Toggle on Auto Trim in the Project Geometry panel.

5. Select the Project To UCS tool in the Project Geometry panel on the ribbon’s Surface tab. The command prompt reads:

   Select curves, points to be projected or [PROJECTion direction]:

   Click the large orange circle, and press Enter.
6. The command prompt now says:

   Select a solid, surface, or region for the target of the projection:

   Select the blue dome membrane. A new orange spline appears on the surface of the trimmed dome (see Figure 17.10) and the PROJECTGEOMETRY command ends.

![Projected spline and auto-trimmed surface](image)

**Figure 17.10** Projecting the ventilation tower cutout upward onto the dome membrane's surface

7. Type **E** (for Erase), and press Enter. Click points A and B in Figure 17.10 to create a crossing window that selects both the dome and the projected spline.

8. Type **R** (for Remove), and press Enter.

9. Type **L** (for Last), and press Enter twice to erase the projected spline but not the dome.

10. Pan over to the small orange circle with a white line running through it.

11. Toggle off Auto Trim in the Project Geometry panel.

12. Select the Project To UCS tool in the Project Geometry panel, select the small orange circle, and press Enter. Select the blue dome, and press Enter. A new projected spline appears on the dome surface (see Figure 17.11).

You will array this projected spline around the dome in the next section.
13. Type E (for Erase), and press Enter. Select the original small orange circle on the ground, and press Enter.

14. Select the ribbon’s Home tab, and click the Isolate tool in the Layers panel. Select the blue dome membrane, and press Enter.

15. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Click the Cables layer’s snowflake and darkened lightbulb icons both to thaw and toggle the layer on. Double-click the Cables layer’s icon to set it as current (see Figure 17.12).
16. Click the Top of the ViewCube. Click the Rotate Clockwise icon in the ViewCube interface if necessary so North is up.

17. Select the ribbon’s Surface tab, and click the Project To View tool in the Project Geometry panel. Select all the objects in the drawing canvas with a crossing selection and press Enter. The command prompt reads:
   
   Select a solid, surface, or region for the target of the projection:
   
   Select the blue dome, and press Enter. Although the PROJECTGEOMETRY command ends, you can’t see the projected objects in the top view.

18. Click the Front arrow below the ViewCube. Type E (for Erase), and click points A, B, and C in Figure 17.13 to select all the lines on the ground and one in the center. Press Enter to erase the selection.

19. Click the upper-left corner of the ViewCube to switch into a SW Isometric viewpoint. Type LAYUN (for Layer Unisolate), and press Enter.

Trimming Surfaces with Edges

You already trimmed one surface when you projected the large orange circle onto the dome using Auto Trim mode in the previous section. You won’t use Auto Trim in the next exercise, because you need to retain the projected object. In the following steps, you will first array this projected spline around the dome and then manually trim all 12 voids through which the structural masts will ultimately pass:

1. Type AR (for Array), press Enter, select the small orange spline that you projected on the dome in the previous section, and press Enter. Type PO (for Polar), and press Enter. The command prompt reads:
   
   Specify center point of array or [Base point Axis of rotation]:
   
   If you cannot see linetype onscreen, change the LTSCALE system variable.
Type \(0,0\) and press Enter.

2. The command prompt now says:

   Select grip to edit array or [Associative Base point Items Angle between Fill angle ROWs Levels ROTate items eXit]<eXit>:

Type \(I\) (for Items), and press Enter. Type \(12\), and press Enter. Type \(AS\) (for Associative), type \(N\) (for No), and press Enter. Press Enter twice more to end the ARRAY command. Twelve splines appear arrayed around the dome (see Figure 17.14).

![Figure 17.14 Arraying projected splines around the dome](image)

3. Open the in-canvas Visual Style Controls menu, and select Shaded With Edges.

4. Select the Trim tool on the Edit panel of the ribbon’s Surface tab. Select the dome, press Enter, select one of the orange splines, and press Enter. Click inside the spline, and press Enter. A hole in the shape of the spline is cut in the dome.

5. Repeat the previous step 11 more times, one for each remaining orange spline.

6. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Double-click the Cylindrical Towers layer’s icon to set it as current. Toggle off the Dome Voids layer. Figure 17.15 shows the result.

You cannot trim a surface with an array object. By making a nonassociative array, you end up with individual objects that can be used.
FIGURE 17.15  Trimming holes in the dome to accommodate the masts

7. Save your work as Ch17-C.dwg.

Creating Solid Models

If surfaces cover 2D floor spaces, then solid models enclose 3D volumes. Only with solid objects can you use the MASSPROP command to calculate engineering properties such as volume, centroid, moments of inertia, and so on. Many of the solid modeling tools are the same as the surface modeling tools. If you start these commands with a closed path such as a circle, ellipse, or closed polyline, you will end up with a solid object while open paths generate surfaces. In the following sections, you’ll extrude and loft solid objects.

Extruding Solid Objects

The difference between a surface extrusion and a solid extrusion is what’s in the middle: nothing in the case of the surface model, and “mass” in the case of the solid. In the next section, you’ll see how to affect the solid “mass” with Boolean tools. In the following steps, you’ll extrude a circle into a solid and array it around the dome:

1. If the file is not already open, go to the book’s web page, browse to Chapter 17, get the file Ch17-C.dwg, and open it. Switch to the 3D Modeling workspace if it’s not selected already in the Quick Access toolbar.
2. Select the ribbon's Solid tab, and click the Extrude tool in the Solid panel. Select the cyan circle at the edge of the dome, and press Enter. The command prompt reads:

Specify height of extrusion or [Direction Path Taper angle] <50.000>:

Type **30**, and press Enter. The 2D circle becomes a 3D solid cylinder.

3. The O2 Arena features cylindrical towers in pairs. Type **M** (for Mirror), and press Enter. Type **L** (for Last), and press Enter twice. The command prompt reads:

Specify first point of mirror line:

Type **0,0** and press Enter.

4. The command prompt now says:

Specify second point of mirror line:

Type **0,1** to specify a mirror line running vertically along the y-axis, and press Enter. Press Enter once more to accept the default (not to erase the source objects). Figure 17.16 shows the resulting pair of cylinders.

---

**Figure 17.16** Extruding and mirroring one pair of solid cylindrical towers

When you are specifying the mirror line, only its direction matters—the distance and units do not.
5. You need to place six pairs of cylinders around the dome. Type AR (for Array), and press Enter. Select both cylindrical towers, and press Enter. Type PO (for Polar), and press Enter. The command prompt reads:

Specify center point of array or [Base point Axis of rotation]:

Type 0,0 and press Enter. Type I (for Items), and press Enter. Type 6 (for the number of items), and press Enter. Press Enter to accept the default and end the ARRAY command. Figure 17.17 shows the result.

![Arraying pairs of cylindrical towers around the dome](image)

**Figure 17.17** Arraying pairs of cylindrical towers around the dome

6. Switch to Wireframe using the in-canvas Visual Style Controls menu so that you can see through the dome. Zoom into the yellow vertical line with a hexagon around its midpoint; this represents a structural mast.

7. Hover the cursor over the Layer Properties Manager's title bar to open the palette. Double-click the Masts layer to set it as current.

8. Click the Extrude tool in the Solid panel. Select the hexagon at the midpoint of the vertical line, and press Enter. The command prompt reads:

Specify height of extrusion or [Direction Path Taper angle] <30.000>:

Type T (for Taper), and press Enter.
9. The command prompt now says:

   Specify angle of taper for extrusion <15.00>:

   Type 1, and press Enter. Verify that Endpoint object snap is running, and click the top endpoint of the vertical line to specify the height of the extrusion. Figure 17.18 shows the result.

10. Select the Extract Edges tool on the Solid Editing panel, select the mast, and press Enter. The Extract Edges tool creates wireframe geometry for solid objects. Hover the cursor over the edges of the mast to see that, with this kind of angular geometry, the wireframe edges are coincident with the original edges of the solid object.

11. Zoom in on the hexagonal bottom of the mast. Type J (for Join), and press Enter. Click points A and B shown in Figure 17.19 to create a crossing window that selects the lines, making a hexagon, and press Enter.

12. Select the Extrude tool in the Solid panel, type L (for Last), and press Enter twice.

13. Type T (for Taper), press Enter, and then press Enter again to select the default one-degree taper angle. Zoom out, and click the lower endpoint of the vertical yellow line to extrude the lower half of the mast down to the ground.
Lofting Solid Objects

*Lofting* is a modeling technique that lets you create a 3D model from a series of 2D cross sections. In the following steps, you will loft two ventilation towers from a series of circles and ellipses.

1. Hover the cursor over the Layer Properties Manager’s title bar to open the palette. Double-click the Ventilation Towers layer to set it as current. Toggle off the Dome Membrane layer.

2. Switch to Shaded With Edges using the in-canvas Visual Style Controls menu.

3. Zoom in on the collection of blue circles and ellipses. Select the Loft tool from the drop-down menu under Sweep on the Solid panel, and press Enter. Select profiles A, B, C, and D shown in Figure 17.20, and press Enter. Open the grip menu that appears, choose Normal To Start And End Sections, and press Enter to end the **LOFT** command.

4. Press the spacebar to repeat the **LOFT** command. Select profiles E, F, G, and H, shown in Figure 17.20, and press Enter. Open the grip menu that appears, choose Normal To Start And End Sections, and press Enter. Figure 17.21 shows the result.

5. Save your work as Ch17-D.dwg.

---

**Figure 17.19** Joining six edges to form a hexagonal polyline

---

The ventilation towers serve a pair of road tunnels passing under the Thames in London. These towers were *in situ* prior to the construction of the O2 Arena.

*Normal* means perpendicular to the surface in question.
FIGURE 17.20 Lofting one of the two ventilation towers

FIGURE 17.21 Lofted ventilation towers
Editing Solid Models

Solid editing tools provide an alternative set of modeling possibilities as compared with surface tools. Boolean tools (named after mathematician George Boole) allow you to union, subtract, and intersect solids (set theory terms) to create new forms. You will explore these tools in the following section and learn about a variety of specialized solid editing tools.

Performing Boolean Operations

In the following steps, you will unify the top and bottom parts of the mast with the UNION command. You will then rotate and array 12 masts around the dome.

1. If the file is not already open, go to the book’s web page, browse to Chapter 17, get the file Ch17-3.dwg, and open it. Switch to the 3D Modeling workspace if it’s not selected already in the Quick Access toolbar.

2. Switch to Wireframe using the in-canvas Visual Style Controls menu.

3. Select the Union tool in the Boolean panel, click the left and right ventilation towers, and press Enter. A curve representing the precise intersection of these two forms’ surfaces appears in the wireframe representation (see Figure 17.22).

Figure 17.22 Wireframe representations of two separate lofted ventilation towers (left) and a single object (right) created with Boolean union.
4. Pan over to the mast objects you extruded in the previous section. Hover the cursor over the Layer Properties Manager’s title bar to open the palette. Double-click the Masts layer to set it as current.

5. Select the Union tool in the Boolean panel. Drag a crossing window through both mast solids to select them, and press Enter. Although nothing has changed visually, the two solids have been unified as a single object. Zoom into the base of the mast.

6. Select the ribbon’s Home tab, and click the 3D Rotate tool in the Modify panel. Select the mast, and press Enter. Click the lower endpoint of the vertical line, which is at the center of the mast, to act as the base point. A 3D rotate gizmo appears (see Figure 17.23).

7. Click the red ring to select the x-axis. The command prompt reads:

   Specify angle start point or type an angle:

   Type -14, and press Enter.

8. Press the spacebar to repeat 3DROTATE; then select the mast and press Enter. Click the same base point shown in Figure 17.23, and click the green axis ring to select the y-axis. Type 4, and press Enter.
9. Zoom out, and select the Erase tool in the Modify panel. Select the edges you extracted from the mast in the previous section and the vertical mast line (see Figure 17.24), and press Enter.

![Figure 17.24](image)

**Figure 17.24** Erasing the edges extracted earlier

10. Type `AR` (for Array), and press Enter. Select the solid mast, and press Enter. Type `PO` (for Polar), and press Enter. Type `0,0` (as the center point of the array), and press Enter.

11. Type `I` (for Items), and press Enter. The command prompt reads:

   Enter number of items or [Angle between Expression] <4>:

   Type 12, and press Enter three more times to complete the command.

12. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Toggle on the Dome Membrane layer. Switch to Shaded With Edges using the in-canvas Visual Style Controls menu. Zoom out to view the entire model. Figure 17.25 shows the result.
Editing Solids

Rather than having to edit a whole solid object, it is possible to select parts of the object (called *subobjects*) for editing. In the following steps, you will offset a subobject, create an interior shell, and then use AutoCAD’s Presspull tool on two faces to perform an automatic Boolean subtraction:

1. Select the Isolate tool in the Layers panel, select the ventilation towers, and press Enter. Zoom into the ventilation towers.

2. Select the ribbon’s Solid tab, and then select the Offset Edge tool in the Solid Editing panel. Click the top face of the left tower. The command prompt reads:

   Specify through point or [Distance Corner]:

   Type D (for Distance), and press Enter. Type 1, and press Enter.

3. The command prompt now says:

   Specify point on side to offset:

   Click the center of the top-left face to offset the edge internally. Click the top face of the right tower. Type D (for Distance), and press Enter. Type 1, and press Enter. Click the center of the top-right face, and press Enter to end the OFFSETEDGE command. Figure 17.26 shows the result.
4. Switch to Wireframe using the in-canvas Visual Style Controls menu.

5. Select the Shell tool on the right side of the Solid Editing panel. Select the side of the ventilation towers (not the offset top faces), and press Enter. Type 1 (the same distance you offset in the previous step), and press Enter twice to end the SOLEDIT command. A hollow interior shell is generated within each ventilation tower. However, the tops are still solid as the shell is inset 1 unit from all sides (including the top).

6. Select the Presspull tool on the Solid panel. Click point A in Figure 17.27, type -1, and press Enter. Click point B, type -1, and press Enter twice more.

7. Switch to Shaded With Edges using the in-canvas Visual Style Controls menu. Now you can see the voids you cut in the tops of the ventilation towers in the previous step.

8. Type LAYUN (for Layer Unisolate), and press Enter.

9. Select the Thicken tool on the Solid Editing panel. Select the dome membrane, and press Enter. The command prompt reads:

   Specify thickness <1.000>

   Type -0.5, and press Enter. The dome surface thickens into a solid shell (see Figure 17.28).

10. Save your work as Ch17-E.dwg.
FIGURE 17.27 Using Presspull to remove the tops of the ventilation towers

FIGURE 17.28 Thickening the dome membrane into a solid shell
Smoothing Meshes

Mesh objects are represented by discrete polygonal surfaces that can be *smoothed*, meaning their geometrical forms can be rounded out. Mesh objects are ideal for representing organic or sculptural forms. In the following steps, you will convert the ventilation towers into a mesh by smoothing the geometry twice and thereby softening its edges:

1. If the file is not already open, go to the book’s web page, browse to Chapter 17, get the file Ch17-E.dwg, and open it. Switch to the 3D Modeling workspace if it’s not selected already in the Quick Access toolbar.

2. Type LAYISO (for Layer Isolate), press Enter, select the ventilation towers, and press Enter again. Zoom into the area.

3. Select the ribbon’s Mesh tab, and select the Smooth Object tool on the Mesh panel. Select the ventilation tower solid, and press Enter. Click Create Mesh in the warning dialog box that appears (see Figure 17.29). The towers gain a blocky appearance as the curvilinear solid is converted into a polygonal mesh.

4. Select the Smooth More tool on the Mesh panel, select the ventilation tower mesh, and press Enter. The mesh is subdivided and the result looks smoother (see Figure 17.30).

5. Type LAYUN (for Layer Unisolate), and press Enter.

6. Hover the cursor over the Layer Properties Manager’s title bar to reveal the palette. Thaw the Cables layer, toggle on the Arena and Arena Roof layers, and toggle off the Layout layer. Figure 17.31 shows the completed project.

A common way of using mesh objects is to start with a *primitive* like a box, cone, cylinder, and so on and then smooth it.

**FIGURE 17.29** Mesh warning dialog box

**FIGURE 17.30** Mesh warning dialog box

**FIGURE 17.31** Completed project
7. Save your work as Ch17-F.dwg. Your work should now resemble the file of the same name that is provided on the book’s web page.
In this chapter, you learned how to use a variety of 3D modeling toolsets, including surfaces, solids, and meshes. You learned how to create planar surfaces and how to revolve, sweep, and extrude surfaces from open profiles. You trimmed a surface with another surface and with edges that you projected onto the surface in question. You also extruded and lofted solid objects, performed Boolean operations, created a shell, and thickened a surface. Finally, you converted a solid into a mesh and smoothed the mesh to soften its edges and give it a sculptural appearance. In short, you now have the skills to model a tremendous variety of 3D objects in AutoCAD.

Additional Exercise

Try using different tools in the NURBS toolset to reshape surfaces. For example, convert the planar surface at the top of the dome model you made in this chapter into a NURBS object. Then rebuild the surface, giving it five CVs in both U and V directions. Show CVs, and pull up the central CV to deform the surface, making it convex.
Presenting and Documenting 3D Design

*Wireframe, hidden line, and* shaded views are helpful means of visualizing models during the design process. However, visual styles leave something to be desired when you are communicating designs to your clients. The general public has come to expect designers to be able to produce the kind of realistic computer-generated imagery regularly seen in movies. This chapter will help you learn to do that by teaching you how to create realistic presentation images using the advanced rendering system in the AutoCAD® program. After you gain client approval, you still need to document your 3D design with relevant 2D plans, elevations, sections, and detail drawings so that your design can be communicated to the building or manufacturing trades. You will learn how to generate these drawings directly from models using AutoCAD 2014’s model documentation features.

- Assigning materials
- Placing and adjusting lights
- Creating renderings
- Documenting models with drawings

**Assigning Materials**

Materials describe the way objects interact with light. AutoCAD comes with an extensive library of real-world materials, including numerous types of concrete, metal, glass, brick, paint, leather, carpet, plastic, and so on. In
the following steps, you will transfer materials from the Autodesk library to a sample model and then assign them to objects layer by layer:

1. Go to the book’s web page at www.sybex.com/go/autocad2014 essentials, browse to Chapter 18, get the file Ch18-A.dwg, and open it. This is a model of the author’s house (see Figure 18.1).

2. Select the 3D Modeling workspace from the drop-down menu on the Quick Access toolbar.

3. Select the ribbon’s Render tab, and click the Materials Browser toggle in the Materials panel. In the Materials Browser palette that appears, select the Fabric category in the Autodesk library, scroll down the list of materials in the right pane, and click Velvet – Black to load it into the document (see Figure 18.2).

4. Continue loading materials by single-clicking the materials listed by category in Table 18.1.

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flooring</td>
<td>Stone</td>
<td>Flagstone</td>
</tr>
<tr>
<td>Flooring</td>
<td>Stone</td>
<td>Flagstone Light Pink</td>
</tr>
<tr>
<td>Category</td>
<td>Subcategory</td>
<td>Material</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Flooring</td>
<td>Wood</td>
<td>Natural Maple – Antique</td>
</tr>
<tr>
<td>Glass</td>
<td>Glazing</td>
<td>Clear</td>
</tr>
<tr>
<td>Masonry</td>
<td>Brick</td>
<td>Uniform Running – Burgundy</td>
</tr>
<tr>
<td>Metal</td>
<td>(none)</td>
<td>Chrome Satin 1</td>
</tr>
<tr>
<td>Metal</td>
<td>Steel</td>
<td>Stainless – Brushed</td>
</tr>
<tr>
<td>Paint</td>
<td>(none)</td>
<td>Black</td>
</tr>
<tr>
<td>Plastic</td>
<td>(none)</td>
<td>Laminate Light Brown</td>
</tr>
<tr>
<td>Wall Paint</td>
<td>Matte</td>
<td>Cool White</td>
</tr>
<tr>
<td>Wall Paint</td>
<td>Matte</td>
<td>Flat – Antique White</td>
</tr>
<tr>
<td>Wood</td>
<td>(none)</td>
<td>Beech</td>
</tr>
<tr>
<td>Wood</td>
<td>(none)</td>
<td>Birch – Solid Stained Dark No Gloss</td>
</tr>
</tbody>
</table>

5. Figure 18.3 shows all the materials loaded into the current drawing. Close the Materials Browser.

**FIGURE 18.2** Loading a material from the Autodesk library into the document
Chapter 18 • Presenting and Documenting 3D Design

Figure 18.3 Materials loaded into the current drawing

6. Expand the Materials panel, and select the Attach By Layer tool. Click the Layer header to sort the list of layers in reverse alphabetical order. Click the Layer header again to sort in alphabetical order. Drag materials from the left side, and drop them on the right side according to Table 18.2. Figure 18.4 shows the dialog box with all the necessary materials selected. Click OK to close the Material Attachment Options dialog box.

Figure 18.4 Assigning materials to layers by dragging from the left pane to the right pane in the Material Attachment Options dialog box
<table>
<thead>
<tr>
<th>Layer</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Global</td>
</tr>
<tr>
<td>Brick</td>
<td>Uniform Running – Burgundy</td>
</tr>
<tr>
<td>Cabinets</td>
<td>Beech</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Cool White</td>
</tr>
<tr>
<td>Ceiling2</td>
<td>Cool White</td>
</tr>
<tr>
<td>Counter</td>
<td>Laminate Light Brown</td>
</tr>
<tr>
<td>Defpoints</td>
<td>Global</td>
</tr>
<tr>
<td>Door</td>
<td>Birch – Solid Stained Dark No Gloss</td>
</tr>
<tr>
<td>Downlight</td>
<td>Cool White</td>
</tr>
<tr>
<td>Equip</td>
<td>Stainless – Brushed</td>
</tr>
<tr>
<td>Floor1</td>
<td>Natural Maple – Antique</td>
</tr>
<tr>
<td>Floor2</td>
<td>Flagstone</td>
</tr>
<tr>
<td>Floor3</td>
<td>Flagstone Light Pink</td>
</tr>
<tr>
<td>Seat-Cushion</td>
<td>Velvet – Black</td>
</tr>
<tr>
<td>Seat-Frame</td>
<td>Chrome Satin 1</td>
</tr>
<tr>
<td>Sink</td>
<td>Stainless – Brushed</td>
</tr>
<tr>
<td>Stairs</td>
<td>Birch – Solid Stained Dark No Gloss</td>
</tr>
<tr>
<td>Stool</td>
<td>Beech</td>
</tr>
<tr>
<td>Stove</td>
<td>Black</td>
</tr>
<tr>
<td>Table-Glass</td>
<td>Clear</td>
</tr>
<tr>
<td>Table-Legs</td>
<td>Chrome Satin 1</td>
</tr>
</tbody>
</table>

(Continues)
Texture maps are images used within materials to represent realistic surfaces.

You can also display texture maps in the viewport by clicking Materials/Textures On in the Materials panel.

7. Texture maps do not normally appear in the viewport in the Shaded With Edges visual style. Select Realistic using the in-canvas Visual Style Controls menu. Figure 18.5 shows the texture maps in the viewport.

8. Save your work as Ch18-B.dwg.

![Figure 18.5](image)

**Figure 18.5** Using the realistic visual style to display materials’ texture maps
Placing and Adjusting Lights

Without light, nothing would be visible. AutoCAD uses what is called default lighting to illuminate objects in the viewport while you are building 3D models. The default lights are positioned behind the viewer and emit even illumination so that you can always see what is in the viewport. However, default lighting is not realistic and must be turned off as soon as you create artificial or natural light. You will add artificial lights (a series of spotlights mounted in the ceiling) and natural lights simulating the sun and sky light diffused throughout the atmosphere.

Adding Artificial Lights

In the real world, artificial lights are electrical lighting fixtures that are one of the hallmarks of the modern world. In AutoCAD, artificial lights include point, spot, and direct sources. Point sources illuminate in all directions, spot sources illuminate in a cone, and direct lights simulate light coming evenly from a particular direction, illuminating everything like the sun.

AutoCAD has two different lighting methods: standard and photometric. Standard lights were used before AutoCAD 2008, and they are still available so that lights in older DWG files will still be compatible in the current version.

However, I strongly urge you to use photometric lights, which are much more realistic. Photometric lights use real-world lighting intensity values (in American or International lighting units), and light coming from photometric light decays with the inverse square of distance, just as light does in the real world.

In the following steps, you will first change lighting units to turn on the photometric lighting system, and then add a series of artificial lights to illuminate an architectural interior:

1. If the file is not already open, go to the book’s web page, browse to Chapter 18, get the file Ch18-B.dwg, and open it. Switch to the 3D Modeling workspace if it’s not selected already in the Quick Access toolbar.

2. Select the ribbon’s Render tab, and expand the Lights panel. Open the menu that says Generic Lighting Units (used only for the standard lighting method), and select American Lighting Units (or International Lighting Units in metric). Figure 18.6 shows this menu.

3. Click the word Top in the ViewCube to switch to a floor plan view. Choose Zoom Extents in the Navigation bar, and switch to the Wireframe visual style using the in-canvas control.
4. Select the ribbon’s Home tab, and expand the Layers panel. Select the Turn All Layers On tool. Light fixtures (down lights) are visible in the viewport (see Figure 18.7).

5. Zoom in on the upper-left light by turning the mouse wheel forward. Do the following:

   ▶ If you’re a Windows user, select the ribbon’s Render tab and, on the Lights panel, open the Create Light menu and select Spot.

   ▶ If you’re a Mac user, type `LIGHT`, press Enter, type `S` (for Spot), and press Enter.

6. Select Turn Off The Default Lighting when the Lighting – Viewport Lighting Mode dialog box appears (see Figure 18.8).

7. The command prompt reads:

   Specify source location <0,0,0>:

   Type `.xy`, and press Enter. Click a point visually centered on the light fixture (but do not use center object snap).
8. The command prompt now says (need Z). Type 96 (the ceiling height), and press Enter. The command prompt now reads:

   Specify target location <0,0,-10>:

   Type .xy, press Enter, and click the same center point as you did in the previous step. The command prompt now says (need Z).
9. Type θ (the floor height), and press Enter. Press Enter again to end the SPOTLIGHT command.

10. Press the F8 key if Ortho is not already on. Type CO (for Copy), and press Enter. Type L (for Last), and press Enter twice. Click a point near the light fixture, zoom out by turning the mouse wheel backward, move the cursor down to the light fixture in the bottom row, and click in the drawing canvas to create the second spotlight. Press Enter to end the COPY command.

11. Press the spacebar to repeat the last command, type P (for Previous), and press Enter. Type L (for Last) so that you have a selection of two lights, and press Enter twice to end Select Objects mode. Click the start point under the last spotlight and zoom out. The command prompt reads:

    Specify second point or [Array]
    <use first point as displacement>:

    Type A (for Array), and press Enter. Type 6 (for the number of items), and press Enter.

12. Type F (for Fit), and press Enter. Move the cursor under the rightmost light fixture (see Figure 18.9), and click to specify the second point of the array. Press Enter to exit the ARRAY command.

---

**FIGURE 18.9** Copying spotlights in a rectangular array

---

Placing lights within block definitions can help keep the source and fixture together.
13. Type \texttt{V} (for View), and press Enter. Double-click Camera 1 in the View Manager (see Figure 18.10). Click Apply and OK.

\textbf{FIGURE 18.10} Selecting a predefined camera view

14. Click the Lights panel menu (a small icon in the lower-right corner of the Lights panel) to open the Lights In Model palette (see Figure 18.11). Select the first spotlight in the list, hold Shift, and select the last spotlight in the list to select them all.

\textbf{FIGURE 18.11} Selecting lights in the Lights In Model palette
15. Right-click the selected lights in the Light Lister and choose Properties. Select the Lamp Color property, and click the icon to the right of the drop-down menu to open the Lamp Color dialog box. Select the Kelvin Colors radio button, type 5000, and press Tab. The resulting color changes (see Figure 18.12). Click OK.

![Lamp Color dialog box](image)

**Figure 18.12** Specifying lamp color by temperature

16. In the Properties palette, change Lamp Intensity to 15000, Hotspot Angle to 30, and Falloff Angle to 60. Figure 18.13 shows the resulting light glyphs in the drawing canvas. The outer orange cones represent the spotlight’s falloff angle and the inner yellow cones represent the area of full light intensity. Close the Properties and Lights In Model palettes. Press Esc to deselect all.

![Selected spotlights reveal light coverage](image)

**Figure 18.13** Selected spotlights reveal light coverage as seen in the camera view.

17. Save your work as Ch18-C.dwg.
Simulating Natural Light

AutoCAD can simulate the light of the sun and/or the light scattered in the sky by the atmosphere for any location on earth and for any time of year and time of day. In the following steps, you will configure the model to use a simulated sun and sky with specific time and space coordinates:

1. If the file is not already open, go to the book’s web page, browse to Chapter 18, get the file Ch18-C.dwg, and open it. Switch to the 3D Modeling workspace if it’s not selected already in the Quick Access toolbar.

2. Select the ribbon’s Render tab if it is not already selected. Click the Sun Status toggle in the Sun & Location panel. The sun is on when the toggle is highlighted in blue.

3. Select the Set Location tool in the Sun & Location panel. Select the From Map option. In the Geographic Location dialog box that appears, zoom into a hypothetical site anywhere in the world you would like. Right click the map and choose Drop Marker Here. A red pin appears on the map at that location (see Figure 18.14).

4. Select Inches from the Drawing Unit drop-down menu and click Continue.
5. Click in the drawing canvas to select a reference point for the geo-
location data. Type `A` and press Enter for the Angle option, and then
type `90` and press Enter to specify the North direction as up. By speci-
fying North on the plan you are establishing the building orientation
on the map.

6. Open the Sky Off menu in the Sun & Location panel, and select Sky
Background And Illumination. AutoCAD automatically manages the
color of the sky and degree of sky illumination based on your chosen
time and space coordinates.

7. Save your work as `Ch18-D.dwg`.

Creating Renderings

Rendering is the process of converting the geometry, materials, and lighting
settings into pixels. Rendering can be a time-consuming process because it typi-
cally requires a lot of computation to perform. There are no rendering options
in AutoCAD for Mac (just the `RENDER` command), and the resulting rendering
quality isn’t as realistic as that available in AutoCAD for Windows, where you
have many advanced options. In the following steps, you will use AutoCAD
2014’s advanced render settings for Windows to progressively create more realis-
tic renderings:

1. If the file is not already open, go to the book’s web page, browse to
Chapter 18, get the file `Ch18-D.dwg`, and open it. Switch to the 3D
Modeling workspace if it’s not selected already in the Quick Access
toolbar.

2. Select the ribbon’s Render tab, and expand its Render panel. Select
the Adjust Exposure tool. After a few moments, AutoCAD creates
a preview that gives you a rough sense of the level of illumina-
tion in a rendered thumbnail image. As it appears dark, change
the Brightness from `65` to `100` and press Tab. The preview bright-
eness significantly (see Figure 18.15). Click OK to close the Adjust
Rendered Exposure dialog box.

3. Open the Render Presets drop-down menu in the Render panel and
select Low. Click the teapot icon to initiate the rendering process.
Figure 18.16 shows the resulting low-quality rendering that appears
after a few moments in the Render dialog box.
4. If you're a Windows user, click the small icon at the right edge of the Render panel (or type `RPREF` and press Enter) to open the Advanced Render Settings palette. Scroll down in the palette, and toggle on Global Illumination by clicking the lightbulb icon shown in Figure 18.17. Mac users cannot adjust any advanced render settings.
5. Click the Render icon in the Render panel to create another test render. Figure 18.18 shows the result. The global illumination algorithm bounces photons off the floor, and this helps illuminate the ceiling. However, there aren’t enough photons for a quality result.

6. In the Advanced Render Settings palette, change the number of Photons/light to 10000. More photons will illuminate the dark recess of the architectural interior better. Click the Render icon in the Render panel to create another test render. It is much improved, but photon circles are still visible on various surfaces.

7. Open the Shadow menu in the Lights panel, and select Full Shadows.

8. Open the drop-down menu at the top of the Advanced Render Settings palette and select High. Toggle on Global Illumination by clicking the lightbulb icon as you did in step 4. In the High preset, the scene will use **final gather**, which cleans up photon circles. Do the following:

   - If you are a Windows user, click the Render button in the top-right corner of the Advanced Render Settings palette to initiate a render.
   - If you are a Mac user, type `RENDER`, and press Enter.

Figure 18.19 shows the final rendering.

---

**FIGURE 18.17** Toggling on global illumination

You will be prompted to install the Medium Images Library (700 MB) if it’s not already installed when you initiate a render. For the purposes of this book, you do not need to install it.

Final gather can be used with or without global illumination. The final gather algorithm takes a lot of calculation (and thus time), but it produces the highest quality results.
**FIGURE 18.18** Global illumination bounces photons off the floor and onto the ceiling.

**FIGURE 18.19** High-quality rendering using global illumination and final gather.
9. Right-click the most recent output file name in the Render dialog box, and select Save in the context menu. In the Render Output File dialog box that appears, open the Files Of Type drop-down menu and select TIF (*.tif). Type **Camera 1** in the File Name text box and click Save. Select the 24 Bits radio button in the TIF Image Options dialog box that appears and click OK.

10. Save your model as **Ch18-E.dwg**. Your work should now resemble the file of the same name, which is provided on the book’s web page.

**Documenting Models with Drawings**

AutoCAD has a set of model documentation features that allow you to generate 2D plans, elevations, sections, and/or details directly from solid and surface models. In the following steps, you will open a 3D model of a gear and project multiple 2D drawings from it:

1. Open **Ch18-F.dwg**. This is a 3D solid model of a gear (see Figure 18.20).

![Gear 3D model](image)

**Figure 18.20** Gear 3D model

2. Select the 3D Modeling workspace from the drop-down menu on the Quick Access toolbar. Select the ribbon’s Layout tab.
3. Select the Base tool in the Create View panel, and choose From Model Space in the drop-down menu. The command line reads:

```
Select objects or [Entire model] <Entire model>:
```

Select the gear object, and press Enter.

4. The command line says:

```
Enter new or existing layout name to make current or [?] <24x36>:
```

In this case, there is already a layout called 24 × 36, so press Enter to accept this default layout. AutoCAD switches to the 24 × 36 layout, and you are prompted to specify a location for the base drawing. Click an arbitrary point in the lower-left corner of the layout (see Figure 18.21).

5. The drawing is too small, so you will adjust its scale. The command line reads as follows:

```
Select option [select Orientation Hidden lines Scale Visibility Move exit] <exit>:
```

Type **S** (for Scale), and press Enter. Type **1**, and press Enter again. It just so happens that several views of the gear fit on the page with the gear at actual size.
6. Type **1:1** (or **1.0**), and press Enter. Press Enter to accept the default Exit option, and you will see that the **VIEWBASE** command continues.

7. Click a point above the base plan drawing to locate a second projected view of the top of the gear.

8. Click a third point at a 45-degree angle with respect to the base plan to locate an isometric projection, and press Enter to end the command. The drawings display in wireframe view showing hidden lines with a dashed linetype (see Figure 18.22).

![Figure 18.22 Locating projected views of the base drawing on the layout](image)

9. The isometric view is a bit large. Select it and you will see a red border appear around the view object. Click the Edit View tool on the Layout tab. On the temporary Drawing View Editor tab that appears, change the scale to 1:2. Open the Hidden Lines dropdown, and select Shaded With Visible Lines (see Figure 18.23). Click OK in the Edit panel.

10. Click the Section tool in the Create View panel. The command line says:

    Select parent view:
11. Click the original plan view you created in the lower left of the layout and press Enter. Click points A and B shown in Figure 18.24 to draw a section cut line and press Enter. Click point C to locate the section view, and press Enter twice to end the `VIEWSECTION` command.

![Figure 18.23](image1.png) Changing a view’s display properties

![Figure 18.24](image2.png) Creating a section of the base view
12. Open the Detail drop-down on the Create View panel and select Rectangular. Toggle off object snap in the status bar. Select the original drawing of the gear as the parent view. Click points A and B shown in Figure 18.25 to draw the detail area and press Enter. Click point C to locate the detail view, and press Enter to end the VIEWDETAIL command.

![Image](image.png)

**Figure 18.25** Creating a detail of the base view

13. Toggle on object snap in the status bar. Switch to the Annotate tab on the ribbon, and select the Linear tool in the Dimensions panel. Dimension the features shown in Figure 18.26. These dimensions are associated with the section and detail views, which in turn are associated with the base view, which is in turn associated with the model. If you were to change the gear geometry in modelspace, views and dimensions would automatically update on the layout.

14. Save your work as Ch18-G.dwg.
In this chapter, you learned how to assign materials, create a photometric lighting simulation, place artificial lights, and assign space and time coordinates to sun and sky. In addition, you learned to create ever more realistic test renderings using global illumination and final gather algorithms to produce the highest-quality renderings. Finally, you created multiple views from a single 3D model for the purpose of documentation.

(Continues)
Additional Exercise

Render the Camera 2 view on your own. Change any of the materials or lights as you see fit to show off the space. Congratulations on completing all the exercises in this book!
Autodesk AutoCAD 2014 Certification

Autodesk® certifications are industry-recognized credentials that can help you succeed in your design career, providing benefits to both you and your employer. Getting certified is a reliable validation of skills and knowledge, and it can lead to accelerated professional development, improved productivity, and enhanced credibility.

This Autodesk Official Training Guide can be an effective component of your exam preparation. Autodesk highly recommends (and we agree!) that you schedule regular time to prepare, review the most current exam preparation roadmap available at www.autodesk.com/certification, use Autodesk Official Training Guides, take a class at an Authorized Training Center (find ATCs near you here: www.autodesk.com/atc), and use a variety of resources to prepare for your certification—including plenty of actual hands-on experience.

To help you focus your studies on the skills you’ll need for these exams, the following tables show objectives that could potentially appear on an exam, and in what chapter you can find information on that topic—and when you go to that chapter, you’ll find certification icons like the one in the margin here.

Table A.1 is for the Autodesk Certified Associate Exam and lists the section, exam objectives, and chapter where the information is found. Table A.2 is for the Autodesk Certified Professional Exam. The sections and exam objectives listed in the table are from the Autodesk Certification Exam Guide.

These Autodesk exam objectives were accurate at press time. Please refer to www.autodesk.com/certification for the most current exam roadmap and objectives.

Good luck preparing for your certification!
### TABLE A.1: Certified Associate Exam sections and objectives

<table>
<thead>
<tr>
<th>Topic</th>
<th>Learning Objective</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface: UI Navigation/Interaction</td>
<td>Access various tools on the Application menu to create, open, and publish a file.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Identify and state the purpose of the main interface elements: ribbon &gt; panels &gt; tabs, context (right-click) menus, menus.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Demonstrate the use of the tools on the Quick Access toolbar.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Define and set the workspace.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Describe the functions of InfoCenter.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Use the application menu or Quick Access toolbar to open an existing file.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Describe the two primary spaces in AutoCAD.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Use the Zoom and Pan commands to view different areas of the drawing.</td>
<td>2</td>
</tr>
<tr>
<td>Creating Drawings: Coordinate Entry</td>
<td>Describe the two coordinate systems.</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Use dynamic input, direct distance, and shortcut menus.</td>
<td>2</td>
</tr>
<tr>
<td>Creating Drawings: Draw Tools and Settings</td>
<td>Use the Line, Circle, Arc, Erase, Rectangle, and Polygon commands to create and erase geometry in the drawing.</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Use object snaps to accurately place and create objects in the drawing.</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Activate and use the Polar Tracking and PolarSnap modes to more accurately create geometry at different angles in the drawing.</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Explain, enable, and use object snap tracking to position geometry in the drawing.</td>
<td>3</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Describe the process of setting Length and Angle units.</strong></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td><strong>Describe the Snap and Grid, Polar Tracking, and Object Snap settings.</strong></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td><strong>Manipulating Objects: Grips</strong></td>
<td>Use Grip modes to stretch, move, scale, rotate, or mirror an object.</td>
<td>4</td>
</tr>
<tr>
<td><strong>Manipulating Objects: Object Selection</strong></td>
<td>Use single clicks to add and remove objects from a selection set.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Use a window to select only objects that are entirely enclosed by the rectangular area.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Use a window to select objects that the rectangular window encloses or crosses.</td>
<td>4</td>
</tr>
<tr>
<td><strong>Move Objects</strong></td>
<td>Use coordinates, grid snap, object snaps, and other tools to move objects with precision.</td>
<td>3</td>
</tr>
<tr>
<td><strong>Drawing Organization and Inquiry Commands: Layers</strong></td>
<td>Use layers and the Layer Properties Manager to organize objects in your drawing.</td>
<td>6</td>
</tr>
<tr>
<td><strong>Drawing Organization and Inquiry Commands: Object Properties</strong></td>
<td>Use the Quick Properties palette to display and change the most commonly used properties.</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Use the Properties palette to display and change the properties of the selected object or set of objects.</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Use the Match Properties command to apply the properties from a source object to destination objects.</td>
<td>6</td>
</tr>
<tr>
<td><strong>Drawing Organization and Inquiry Commands: Linetypes</strong></td>
<td>Use linetypes to distinguish objects in the drawing.</td>
<td>6</td>
</tr>
</tbody>
</table>

(Continues)
<table>
<thead>
<tr>
<th>Topic</th>
<th>Learning Objective</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Organization and</td>
<td>Use the Inquiry commands (Distance, Radius, Angle, Area, List, and ID) to obtain geometric information.</td>
<td>11</td>
</tr>
<tr>
<td>Inquiry Commands: Inquiry</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Altering Objects: Modify</td>
<td>Change the length of objects using the Trim and Extend commands.</td>
<td>4</td>
</tr>
<tr>
<td>Tools</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create parallel and offset geometry in your drawing by using the Offset command.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Use the Join command to combine multiple objects into a single object.</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Break objects into two or more independent objects.</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Apply a radius corner to two objects in the drawing.</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Apply an angled corner to two objects in the drawing.</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Use the Stretch command to alter the shape of objects in the drawing.</td>
<td>7</td>
</tr>
<tr>
<td>Working with Layouts:</td>
<td>Identify the environments in which you can plot data and create a new layout.</td>
<td>13</td>
</tr>
<tr>
<td>Layouts and Viewports</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create and manipulate viewports.</td>
<td>13</td>
</tr>
<tr>
<td>Annotating the Drawing</td>
<td>Use the Mtext command to create multiline text.</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Create single line text.</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Use different methods to edit text.</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Create text styles to manage text.</td>
<td>10</td>
</tr>
<tr>
<td>Dimensioning</td>
<td>Create dimensions using different options: Linear, Angular, Aligned, Radius, Diameter, and Center Mark.</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Use dimension styles to manage dimensions.</td>
<td>11</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Create and edit multileader styles and multileaders.</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Use different commands and methods to edit dimensions.</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Hatching Objects</td>
<td>Add a hatch pattern to a defined boundary.</td>
<td>8</td>
</tr>
<tr>
<td>Hatching Objects: Fills and Gradients</td>
<td>Add a fill pattern or gradient to a defined boundary.</td>
<td>8</td>
</tr>
<tr>
<td>Hatching Objects: Edit Hatch Patterns and Fills</td>
<td>Modify an existing hatch or fill.</td>
<td>8</td>
</tr>
<tr>
<td>Working with Reusable Content: Blocks</td>
<td>Define and name a block.</td>
<td>7</td>
</tr>
<tr>
<td>Specify the name and position of a block or drawing to insert in a drawing.</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>Working with Reusable Content: DesignCenter</td>
<td>Use DesignCenter to reuse the data in a drawing.</td>
<td>9</td>
</tr>
<tr>
<td>Working with Reusable Content: Tool Palettes</td>
<td>Access tool palettes and use their tools.</td>
<td>9</td>
</tr>
<tr>
<td>Creating Additional Drawing Objects: Shapes</td>
<td>Create and edit polylines with the Polyline command.</td>
<td>5</td>
</tr>
<tr>
<td>Create smooth curves with the Spline command.</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Create ellipses and elliptical arcs with the Ellipse command.</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Plotting Your Drawing: Output</td>
<td>Create and activate page setups.</td>
<td>13</td>
</tr>
<tr>
<td>Plot design geometry from modelspace or from a layout.</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Altering Objects</td>
<td>Stretch objects</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Offset objects</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Create a radius between objects</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Trim and extend objects</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Break and join objects</td>
<td>5</td>
</tr>
<tr>
<td>Annotations</td>
<td>Work with Text: text styles, text justification, and multi-line text</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Set the Annotative property for objects</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Create and use multileaders</td>
<td>11</td>
</tr>
<tr>
<td>Create Template Content</td>
<td>Hide and isolate objects</td>
<td>6</td>
</tr>
<tr>
<td>Creating Additional Drawing Objects</td>
<td>Create polylines</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Edit polylines</td>
<td>5</td>
</tr>
<tr>
<td>Creating Basic Drawings</td>
<td>Use Draw commands to create geometry</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Use object snap tracking</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Use polar snap tracking</td>
<td>3</td>
</tr>
<tr>
<td>Dimensioning</td>
<td>Create dimensions</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Edit Dimensions</td>
<td>11</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Drawing Organization and Inquiry Commands</td>
<td>Work with dimension styles</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Calculate the area of objects</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Change object properties</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Use layers</td>
<td>6</td>
</tr>
<tr>
<td>Hatching Objects</td>
<td>Use hatching</td>
<td>8</td>
</tr>
<tr>
<td>Insert and Manage External References</td>
<td>Apply external references</td>
<td>9</td>
</tr>
<tr>
<td>Isolate or Hide Displayed Objects</td>
<td>Isolate and hide objects</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Use grips</td>
<td>4</td>
</tr>
<tr>
<td>Manipulating Objects</td>
<td>Copy, Move, Mirror, and Rotate objects</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Use selection set methods</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Describe and use arrays</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Use rotation reference angles</td>
<td>4</td>
</tr>
<tr>
<td>Layouts and Visibility</td>
<td>Create and use viewports</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Create and use layouts</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Create and manage layers</td>
<td>6</td>
</tr>
<tr>
<td>Printing and Plotting</td>
<td>Use page setup for plotting</td>
<td>13</td>
</tr>
<tr>
<td>Reusable Content</td>
<td>Create, insert, and edit blocks</td>
<td>7</td>
</tr>
</tbody>
</table>
Note to the Reader: Throughout this index boldfaced page numbers indicate primary discussions of a topic. *Italicized* page numbers indicate illustrations.

**SYMBOLS**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>(comma)</td>
</tr>
<tr>
<td>.</td>
<td>(decimal separator)</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>(angled brackets), executing options</td>
</tr>
<tr>
<td>'</td>
<td>(apostrophe), transparent commands</td>
</tr>
<tr>
<td>@</td>
<td>(at symbol), coordinates</td>
</tr>
<tr>
<td>-</td>
<td>(dash), separator between whole and fractional numbers</td>
</tr>
<tr>
<td>&lt;</td>
<td>(less than), angular measures</td>
</tr>
<tr>
<td>-</td>
<td>(minus sign), viewports</td>
</tr>
<tr>
<td>+</td>
<td>(plus symbol), viewports</td>
</tr>
<tr>
<td>'</td>
<td>(single quote), transparent commands</td>
</tr>
<tr>
<td>[]</td>
<td>(square brackets), executing options</td>
</tr>
</tbody>
</table>

**A**

absolute coordinates, 25–26
Active, 38
ADC, 191
Add Fit Point, 99
Add Style button, 270
Add-A-Plotter Wizard, 264, 265, 265, 267
Additional Format button, 310
Additional Format dialog box, 307–308, 308
Advanced Render Settings palette, 379, 380, 381
angles, 28, 30
angular measures, 28
animations, 335
Annotate panel, 242, 246
Annotate tab, 224, 238, 386
annotation
dimensions, 245–247, 246, 247
modelspace, 243
objects, 241–246
scale, 245, 245, 254
styles, 241–246
names, 246
text, 242–244, 243, 245
Annotation panel, 193, 208, 220, 221, 301
 Linear dimension tool, 216
 Table tool, 303
 Text tool, 196, 200
 Annotation Scale, 244, 246
 Annotative style, 208, 295, 295
 Application menu, 2, 3
 Apps store, 11
 ARC, 90
Arc pull-down menu, 134
Arc tool, 90
architectural drawing units, 11–12
arcs, 35, 35–36, 89, 90
 BLEND, 132, 132
 blend curves, 101
eliptical, 93
polylines, 85–91, 130, 131, 131
AREA, 213
ARRAY, 76, 349
Array Creation tab, 72
arrays
COPY, 67, 68
entities, 72–76
polar, 73–75, 75
rectangular, 72–73, 73
Arrowheads section, 210
Associative, 72, 74
Attach External Reference dialog box, 188
ATTDEF, 297
ATTDIA, 300
ATTTEXT, 315–316
Attribute Definition Dialog box, 297, 297
attributes
blocks, 299, 299–300, 300, 301
data, 295, 295–298, 296, 297
FIND, 206
Authoring palettes tool, 143
Auto Constrain tool, 228
Auto Trim, 345, 346
AutoComplete, 10, 11
Auto-hide, 4
Automatically Add Scales to Annotative Objects button, 252
Automatically Add Scales To Annotative Objects When The Annotation Scale Changes, 255

**B**

background color, 15, 58, 319
 Table Cell Background Color menu, 312
base points, 132
Base tool, 383
baseline dimensions, 226
BCONSTRUCTION, 152
BEDIT, 143
BLEND, 101, 102, 132, 132
blend curves, 101–102, 102
Block – Redefine Block dialog box, 148
Block Definition dialog box, 132, 133, 134, 135, 147, 148
block definitions, 181
editing, 139–140
global blocks, 171–174, 172, 173, 174
lights, 375
objects, 129–134
redefining, 146–149
Block Editor, 143, 144
Block panel
Create tool, 132, 298
Define Attributes tool, 296
Insert tool, 136, 175, 178, 299
block references, 140, 181
local, 134
Block Unit drop-down, 133
blocks, 138, 171–191
attributes, 299, 299–300, 300, 301
chairs, 130–133, 136
Content Explorer, 179–183, 180, 181, 182, 183
Dynamic Input, 136
elliptical arcs, 93, 93
EXPLODE, 144–146
exploding, 145–147, 147
FIND, 206
floating properties, 140–143
global, 134–135, 171–179, 176
block definitions, 171–174, 172, 173, 174
local blocks, 177–179, 178, 179
grips, 135
layer 0, 143
local

global blocks, 177–179, 178, 179
inserting drawing, 175, 175–177, 176, 177
nesting, 143–144, 144
objects
defining, 129–134
editing, 139–146
inserting, 134–139, 138
tables, 133
title, 258
tool palettes, 183–185, 184, 185, 186
XPLODE, 144–146
Xrefs, 186–190, 187, 188, 189, 190
Boolean operations, 356–358, 357, 358
Boolean panel, 356–357
boundaries, hatching, 153–162
objects, 158–159
points, 153–157, 154
BOUNDARY, 157
break tool, 224
Business Development, 108
ByBlock, 141, 142, 145
ByLayer, 123–124, 127, 127, 141

C
callout symbols, 197
CAMERA, 327
cameras, 327–329, 328, 329
Cartesian coordinates, 25, 27, 45, 340
Cell Styles panel, 312
Center, 92, 330
center points, constraint points, 231
certification, 389–395
Certified Associate Exam, 390–393
Certified Professional Exam, 394–395
Chamfer, 37–40
CHAMFER, 38
circles, 31–35, 32, 33, 34, 36, 234
hatching, 158, 158–161, 159, 161
SCALE, 70–71, 71
City of Revelation (Michell), 239
Clipboard panel, 113
Close Array, 72
Close Block Editor button, 144
Close button, 180
Close panel, 144
Color drop-down, 142
Color-Dependent Plot Style Tables (CTB), 268
colors, 106, 126, 126

color background, 15, 58, 319
Table Cell Background Color menu, 312
ByBlock, 145
hatching, 155, 155–157
Colors button, 15, 319
columns, 125
tables, 303, 303, 305
text, 204, 204–205, 205
Columns panel, 305
Command:, 10
Command window, 22
CON, 102
Concentric constraint tool, 235
Configure Console dialog box, 180
constraint bar, 230, 230
constraint points, 231
constraints, 227–240, 236
dimensions, 231, 231–236, 222, 223, 234, 235, 236, 237
geometric, 227–230, 228, 229, 230
with dimensions, 234–237, 235, 236, 237
hiding, 230
names, 234
objects, 228, 237–239, 238, 239
Content Explorer, 179–183, 180, 181, 182, 183
continuity, 101–102, 102
control frames, 94, 96, 101
control vertices (CVs)
BLEND, 101
NURBS, 94–97, 364
splines, 94–97, 95, 96, 98
Conversion Factor text box • Drawing Recovery Manager

Conversion Factor text box, 308
Convert To Block, 134, 148
CONVERTCTB, 275
CONVERTPSTYLES, 275
coordinate systems, 25–31, 30, 66
absolute coordinates, 25–26
Cartesian coordinates, 25, 27, 45, 340
polar coordinates, 27, 27–31, 46
relative coordinates, 26–27
UCS, 28–29, 30, 66, 67, 72, 324
WCS, 31, 324
COPY, 149, 198
arrays, 68
entities, 64–67
Copy Objects To New Layer tool, 117
Copy To Layer dialog box, 118, 118
Copy tool, 66, 137, 138, 149, 150, 198, 295
CPolygon, 61
Create New Dimension Style dialog box, 246
Create panel, 340, 342
Create tool, 132, 298
Create View panel, 383, 384
crossing polygons, 78
crossing windows, 59, 60, 77, 78
CTB. See Color-Dependent Plot Style Tables
<Current>, 29
current layer, 109–111, 118, 118
curves. See shaping curves
CVREBUILD, 97
CVs. See control vertices

D
data, 289–316
attributes, 295, 295–298, 296, 297
Fit Data, 99, 100
geolocation, 289–292, 290, 291
objects, 295, 295–298, 296, 297
Sketch Up, 293, 293–294, 294
tables, 301–305, 302, 303, 304, 305, 306
editing, 309–314, 310, 311, 312, 313, 314, 315
Data, table cell style, 302
DCLINEAR, 232
DDEDIT, 203
decimal drawing units, 12
Decimal Separator drop-down menu, 209
Decimal Units, 246
Define Attributes tool, 296
defpoints, 109
Delete Column tool, 305
Delete radio button, 133
Design Feed, 292
design web format (DWF), 285
destination layer list, 118, 118
Detach Image, 97
DIMANGULAR, 220
DIMBASELINE, 226, 226
dimensions, 183, 207–226
adding, 213–222
annotation, 245–247, 246, 247
editing, 222–225, 223, 224, 225
FIND, 206
generic constraints with, 234–237, 235, 236, 237
grips, 246, 247
inquiry commands, 213, 214, 214–216, 215, 216
multileaders, 213, 220–221, 221, 222
objects, 216–220, 217, 218, 219, 220, 222, 223
papercspace, 258, 259, 259
styles, 207–213, 208, 209, 210, 211, 212, 213
Dimensions panel, 224
DIMLINEAR, 218
direct distance entry, 28
Direction, 74
<Displacement>, 65
Displacement mode, 65–66
Display Plot Styles, 250
Display tab, 15, 58, 189, 319
DIST, 213
documentation drawings, 3D design, 382, 382–386, 383, 384, 385, 386, 387
drafting & annotation workspace, 17
dragging, 64–65, 65
draw panel, 86, 90, 98, 134
drawing aids, 41–55
Grid, 42, 43, 44
grip and Snap, 41–44
object snap, 52–54, 53, 54
orth mode, 44–46
Polar Tracking, 44–46
PolarSnap, 46–48
running object snaps, 48–51
Snap, 42, 43, 44
from snap, 51–52, 52
drawing recovery manager, 23
drawing skills, 15–40, 31, 34
  absolute coordinates, 25–26
  arcs, 35, 35–36
  canceling, 23–24
  Chamfer, 37–40
  circles, 31–35, 32, 33, 34
  coordinate systems, 25–31
  erasing, 23–24
  Fillet, 37–40
  layers, 31, 32
  lines, 19–21
  polar coordinates, 27–31
  polygons, 36–37
  rectangles, 22–23
  relative coordinates, 26–27
  2D drawings, 15–19, 16, 17, 18, 19
  undoing, 23–24
  drawing spaces, 6
  drawing units, 11–13, J2
  Drawing Units dialog box, 135, 135, 215
  Drawing View Editor tab, 384
  DRAWORDER, 169
  DWF. See Design Web Format
  DWFx, 285–286, 286
  Dynamic Input, 38, 46, 50, 136, 214
  Fit Data, 99
  Radius, 39
  Dynamic Object, 61

E

  Edit Attributes dialog box, 300
  Edit Block Definition dialog box, 143, J44
  Edit Block In-Place, 140, 142
  Edit button, 9
  Edit panel, 189, 344, 349
  Edit Plotter Configuration button, 267
  Edit Reference panel, 140, 142
  Edit View tool, 384
electronic format, printing and plotting, 285–286, 286
  ellipse menu, 92
  ellipses, 91–93, 92
elliptical arcs, 93, 93
  Endpoint, 134, 222
  endpoints, 70, 231
  engineering drawing units, 12
  Enhanced Attribute Editor, 314
  entities, 57–84
  arrays, 72–76
  COPY, 64–67
  EXTEND, 76–77, 77
  grips, 82–83
  LENGTHEN, 77–78
  MIRROR, 79–81
  MOVE, 64–67
  OFFSET, 79–81
  polar arrays, 73–75, 75
  ROTATE, 68–72, 69
  SCALE, 68–72
  selection sets, 57–64

F

  Fit Data, 99, 100
  Fit Options, 223, 223
  fit points, 99
  adding, 99, 100
  kinks, 100, 100, 101
  splines, 98–100
  Fit tab, 223
  Fit To Paper, 279
  floating modelspace, 283–284, 284
  floating properties, 140–143
  floating viewports, 251–256, 252, 253, 255, 256, 307
  Font Name drop-down, 194
  Form View tab, 270
  fractional drawing units, 12
  Freeze column header, 126
  Freeze tool, 120
  From A Data Link radio button, 304
  From snap, 51–52, 52
  Full Navigation, 330
  full ribbon interface, 8
  STRETCH, 77–78
  TRIM, 76–77, 77
  ERASE, 62
  Erase tool, 27, 59, 62, 161, 172, 298, 358
  Euclidean space, 27
  EXPLODE, 144–146
  Explode tool, 130, 131
  exploding blocks, 145–147, J47
  exploding hatch patterns, 165
  Explore tool, 180
  EXTEND, 76–77
  Extend tool, 76
  Extensible Markup Language (XML), 285
  external references (Xrefs)
    blocks, 186–190, 187, 188, 189, 190
  FIND, 206
  External References palette, 97, 188, 189
  External References tab, 189
  Extract Edges tool, 353
  EXTRUDE, 350
  Extrude tool, 342, 351, 352, 353
  extruding
    solid models, 350–353, 351, 352, 353, 354
    3D space, 342–343, 343
G

Gap Tolerance, 163
GCPARALLEL, 229
GCTANGENT, 236
General Plot Options, 279, 279
Geographic Location dialog box, 290–291
GEOGRAPHICLOCATION, 291
geolocation, 289–292, 290, 291
Geolocation tab, 292
geometric constraints, 227–230
with dimensions, 234–237, 235, 236, 237
Geometric panel, 228, 230, 237
Concentric constraint tool, 235
Parallel constraint tool, 229
Tangent constraint tool, 236
geometric properties, 105
local blocks, 135
columns, 204, 204
dimensions, 246, 247
editing, 82–83
entities, 82–83
Grip Editing mode, 139
grips, 62, 89, 99, 135, 222, 223, 283
blocks, 135
columns, 204, 204
dimensions, 246, 247
editing, 82–83
entities, 82–83
Grip Editing mode, 139
polar arrays, 75
Stretch Vertex, 228
text, 204, 204, 205
Group Edit tool, 151
Group Selection On/Off, 150, 151
Group tool, 149
groups, 149–152, 151
Groups panel, 149, 150, 151
GUI. See graphical user interface

H

HATCH, 156, 157
Hatch Creation, 155, 155
Hatch Layer Override, 155, 156, 164, 167
Hatch tool, 154, 157, 159, 167
HATCHEDIT, 162
hatching, 153–170
areas, 153–159
separating, 164–166, 165, 166
boundaries, 153–166
objects, 158–159
points, 153–157, 154
circles, 158, 158–161, 159, 161
colors, 155, 155–157
edit dialog box, 162
gradients, 166–169, 167, 168, 169
patterns, 162–166, 165, 166
plot style tables, 276, 277
properties, 163, 163–164, 164
tool palettes, 183
Header, 302
HELIX, 103
Help button, 11
Hatch Creation, 155, 156, 164, 167
Hidden Lines drop-down, 384
Hide All button, 230, 234, 235, 237
Hide Layout And Model Tabs, 248
Hide System Printers, 279, 279
Home tab
Annotate panel, 242
Annotation panel, 193, 301
Block panel, 132, 136
Clipboard panel, 113
Draw panel, 154
Edit Reference panel, 140
Groups panel, 149
Layer drop-down, 235, 238
Layers panel, 36, 107, 372
Modify panel, 27, 59
ribbon, 59, 107, 132, 136, 140, 149, 154, 193, 208, 231, 235, 238, 242, 301
3D Rotate tool, 357
images
gvealocation, 290
tool palettes, 183
Imperial units, 250, 282, 308
implied windows, 59, 59, 60, 62, 78
Import Text button, 201
Infer Constraints, 227
InfoCenter, 10, 11
In-Place Editor, 201, 201
inquiry commands, 213, 214, 214–216, 215, 216
INSERT, 137, 179, 300
Insert dialog box, 136, 136, 137, 175, 176
Insert panel, 307
Insert tab, 290
Insert Table dialog box, 304
Insert tool, 136, 175, 178, 299
Insertion Point, 136, 175, 188
insertion points, 231
Insertion Scale, 13, 135, 272
Internet Explorer, 285–286, 286
Island Detection, 155
Isolate tool, 117, 156, 359
isolating layers, 117, 117–119
Items text box, 74
JOIN, 90, 91
Join tool, 130
justification, text, 197, 203, 204, 224, 225, 311, 311

K
keytips, 9, 9
kinks, 100, 100, 101, 101

L
Lamp Intensity, 376
LAN. See local area network
LAYDEL, 107
layer 0, 109, 110, 112, 142, 143, 145, 147
Layer drop-down, 115, 116, 142, 147, 151, 152, 235, 238
Symbol layer, 299
Unsaved Layer State, 119
Layer Filter Tree, 125
Layer Properties Manager, 114, 125, 125–127, 126, 247, 258, 276
Layer Properties tool, 125
Layer State drop-down, 120
LAYFRZ, 120
LAYMCH, 112
LAYMRG, 108
LAYOFF, 115
Layout tab, Edit View tool, 384
layouts
Content Explorer, 181
creating, 247–251
dimensions, 258
documentation drawings, 385
drawing on, 258–260, 259, 260
Imperial units, 282
metric units, 282
paperspace, 281–285, 282, 283, 284, 285
tables, 304, 304
tabs, 248
viewports, 247–251, 248
layer properties, 256–257
LAYUN, 348, 362
Leader tool, 221
Length Precision, 13
LENGTHEN, entities, 77–78
lights, 3D design, 371–378
Lights In Model palette, 375, 375
Lights panel, Render tab, 371
LINE, 23, 30, 111, 173, 296
Line tool, 24, 30, 111, 173, 296
Linear constraint tool, 231, 232, 236
Linear dimension tool, 216, 246
lines, 19–21. See also polylines
deleting, 24
Fence, 61
hidden, 120
joining crossed, 39–40
joining nonparallel, 38–39
Object Snap, 49, 49
Ortho mode, 44–46, 46
orthogonal, 44
PolarSnap, 46–48, 47
polylines, 131
running object snaps, 50, 50
From snap, 51–52, 52
text, 195–199, 196, 197, 198, 199
linetype, 106, 120–123, 127, 127
Linetype drop-down, 121, 122, 124
Linetype Manager dialog box, 121, 121
Linetype Scale, 122–123, 123
lineweight, 43, 106
LIST, 109
List tool, 108
Load button, 121
local area network (LAN), 179
local block references, 134
local blocks
global blocks, 177–179, 178, 179
inserting drawing, 175, 175–177, 176, 177
Location panel, 290
Lock tool, 116
locked layers, 116, 116
LOFT, 350
lofting, 354, 355
Look, SteeringWheel, 330
LTSCALE, 122, 123, 348

M
major axis, ellipsis, 91, 92
Make Object's Layer Current tool, 111, 112, 175
Manage panel, 143, 233, 238
Manage Text Styles, 193, 194
Map Tools panel, 292
Match Properties tool, 113
Match tool, 112
MATCHPROP, 114
Material Attachment Options dialog box, 368, 368
materials, 3D design, 365–370, 366, 367, 368, 369, 370
Materials Browser, 366, 368
Materials panel, 368
Maximize All Columns, 125
Maximize Viewport, 259, 314
maximized viewports, 260
MEASURE, 76
Measure menu, 215
MEASUREGEOM, 213, 216
Medium Images Library, 380
Merge Cells menu, 309, 310
Merge panel, 309, 310
Merge Selected Layers, 114
Merge tool, 107
Mesh panel, 362
meshes, 3D models, 362, 363
metric units, 250, 282, 308
Michell, John, 239
Midpoint, 65, 132, 136
midpoints, 231
mid-string search, 37
Minimize Ribbon button, 8
Minimize Viewport, 314
minor axis, ellipses, 91, 92
MIRROR, 79–81, 80, 81, 82, 147, 198, 198
Mirror tool, 79, 147, 148, 148, 150, 198
MIRRTTEXT, 199
MODEL icon, 251, 254
model tabs, 248
modelspace, 6, 241
annotation, 243
fields, 307, 308
floating, 283–284, 284
PAPER icon, 251
plotting, 279, 278–288, 279
3D space, 248
TILEMODE, 261
2D space, 248

Modify button
Multileader Style Manager dialog box, 221
Page Setup dialog box, 282, 282
Table Style dialog box, 301, 312
Modify Dimension Style: Standard, 209, 223
Modify Dimension Style dialog box, 246
Modify panel
Copy tool, 66, 137, 138, 149, 150, 198, 295
Erase tool, 27, 59, 62, 161, 172, 298, 358
Explode tool, 130, 131
Extend tool, 76
Fillet tool, 130, 131
Join tool, 130
Mirror tool, 79, 147, 148, 148, 150, 198
Move tool, 64, 137, 196, 197, 243
Offset tool, 79, 132, 174, 195
Rectangle tool, 130
Rectangular Array tool, 72
Rotate tool, 140, 150
Scale icon, 70
Scale tool, 160
Set To ByLayer tool, 146
Stretch tool, 132, 151
Trim tool, 88, 140
Modify Table Style: Standard dialog box, 302
MOVE, 82, 198
dragging, 64–65, 65
entities, 64–67
Move tool, 64, 137, 196, 197, 243
MTEDIT, 202
MTTEXT, text, 200–205, 201, 202
editing, 203, 203–205, 204, 205
Multileader Style button, 221
Multileader Style Manager dialog box, 221
multileaders, 213, 220–222, 221, 222
Multiline Text, 200, 244
Multiple Text tool, 242

N
Name drop-down, 136, 144
Name field, Select Objects button, 134
Named Plot Styles (STB), 268
natural light, 3D design, 377, 377–378
Navigate panel, 17
Navigate 2D panel, 17
Navigation bar
Orbit tool, 326
Pan, 16
Zoom Extents, 15, 115, 116, 238, 371
Zoom Previous, 51
Zoom Realtime, 242
Nearest, Object Snap, 51
nesting blocks, 143–144, 144
New Layer button, 125, 247, 258
New Layer State, 119
Node, Object Snap, 87, 98
node snap, 33
nonuniform rational B-spline (NURBS), 85, 94–97, 364
Object Snap, 31, 33, 52–54, 53, 54, 65, 175, 195, 214, 216, 246, 259
context menu, 34
current layer, 110
CVs, 94
ellipses, 93
Endpoint, 222
fit points, 98, 99
lines, 49, 49
Midpoint, 65
Nearest, 51
Node, 87, 98
polar arrays, 74
running object snaps, 50
Object Snap Tracking, 160
objects, 295, 295–298, 296, 297
annotation, 241–246
block definitions, 129–134
blocks
editing, 139–146
inserting, 134–139, 138
constraints, 228, 237–239, 238, 239
dimensions, 216–220, 217, 218, 219, 220, 222, 223
documentation drawings, 385
Field dialog box, 307
groups, 149–152, 151
hatching boundaries, 158–159
Materials Browser, 368
mesh, 362, 363
occluded, 317
organizing, 129–152
plot style tables, 275–276, 276, 277
properties, 107
layers, 123–124
visibility, 105–109
occluded objects, 317
Off tool, 115
OFFSET, 79–81, 80, 119, 132
Offset tool, 79, 132, 174, 195
OFFSETEDGE, 359
On-Screen, 137
Open tool, 177
Open With No Template, 12
OPTIONS, 15, 58, 116, 189, 319
Options dialog box, 38, 189, 272, 319
Options panel, 155, 163, 164, 165
Orbit, 326, 330
orbiting, 3D models, 326, 326–327, 327
Ortho mode, 44–46, 46, 62, 78, 131, 137, 196
CVs, 94
hatching, 160
polylines, 86
orthogonal lines, 44
Output tab, 249, 285
Page Setup dialog box, 282, 282
Page Setup Manager tool, 249, 250, 250
palettes, 2, 4, 5. See also specific palettes
tool, 183–185, 184, 185, 186
Palettes panel, 319, 320
Pan, 16, 330
PAPER icon, 251, 252
paperspace, 6, 241, 249, 251, 307
dimensions, 258, 259, 259
plotting layouts, 281–285, 282, 283, 284, 285
2D space, 248
paragraphs, 200–205, 201, 202, 203, 204, 205
Parallel constraint tool, 229
parameters, constrained objects, 237–239, 238, 239
Parameters Manager button, 233, 238
Parametric tab, 228, 235, 236, 238
PDF. See Portable Document Format
PEDIT, 91
Pick Insertion Base Point icon, 298
Pick Internal Point, 159
Pick Point button, 134, 147
PLAN, 29
planar surfaces, 338, 338
PLANESURF, 338
Plot dialog box, 279, 280
Plot panel, 249, 250, 250, 314
Plot Stamp, 279, 280
Plot Style Table drop-down, 250
Plot Style Table Editor, 270
Plot Style Table Settings button, 272
plot style tables, 269, 269
hatching, 276, 277
layers, 275–276, 276, 277
name, 269, 270
objects, 275–276, 276, 277
printing and plotting
creating, 268–271
using, 271–277, 272, 273, 274
Windows Explorer, 268, 269, 271, 271
Plotter Configuration Editor dialog box, 267
plotting. See printing and plotting
Plug-Ins tab, 180
point filters, 372
Point Style, 31, 32
points. See also specific types
arcs, 90
hatching boundaries, 153–157, 154
shaping curves, 87
polar arrays, 73–75, 75
polar coordinates, 27, 27–31, 46
Polar Tracking, 44–46, 47, 72, 78, 81, 94
running object snaps, 48–49, 50
PolarSnap, 46–48, 47
POLYGON, 36
polygons, 36–37
Polyline tool, 86
polylines, 89
  arcs, 85–91, 130, 131, 133
  Fillet, 39
  PEDIT, 91
  shaping curves, 85–91, 86, 87, 88, 91
Portable Document Format (PDF), 285
Presspull tool, 360, 361
Preview icon, 314
Primary Units tab, 209, 246
printing and plotting, 263–287
  electronic format, 285–286, 286
  layouts, paperspace, 281–285, 282, 283, 284, 285
  modelspace, 278, 278–280, 279
  name, 266, 266
  output devices, 263–267, 265, 266, 267, 268
plot style tables
  creating, 268–271
  using, 271–277, 272, 273, 274
  raster images, 265
  screening, 270
  system printers, 264, 266, 278
  Windows Explorer, 267, 268
Project Geometry panel, 345, 346
Project To UCS tool, 345
PROJECTGEOMETRY, 346
projecting edges, surface models, 345–348, 346, 347, 348
properties
  attributes, 297, 297
  colors, 106
  floating, 140–143
  geometric, 105
  hatching, 163, 163–164, 164
  layers, 106
    layout viewports, 256–257, 257
    visibility, 125–127
  linetypes, 106
  linewidth, 106
  objects
    layers, 123–124
    Properties panel, 124
    Quick Properties mode, 106, 107, 124
    visibility, 105–109
  table cells, 312–313, 313
  views, 333
Properties button, 276
Properties menu, 184
Properties palette, 376
Properties panel, 72, 97, 108, 112, 155
  Color drop-down, 142
  editing values, 109
  layer 0, 145
  Linetype drop-down, 121, 122, 124
  Linetype Scale, 122–123, 123
  object properties, 124
Properties tool, 108
Property Settings dialog box, 113, 113
PUBLISH, 287
PURGE, 145

Q
Quick Access toolbar, 4, 6, 12, 12
  Open tool, 177
  Save As tool, 178
  3D Modeling workspace, 318
  Undo arrow, 24, 90
Quick Properties, 111, 111, 112, 141, 142, 144, 203
  Layers panel, 110
  object properties, 106, 107, 124
Quick View, 4, 5
Quick View Layouts, 249, 250, 284, 303

R
Radius, 39, 48, 235
Radius Dimensions, 211
Radius tool, 215, 220
raster images, 265
raycasting algorithm, 158
Rebuild Curve dialog box, 97
RECTANG, 228
RECTANGLE, 22, 27
Rectangle tool, 22, 109, 111, 130, 134, 227, 258, 295
rectangles, 22–23
  arrays, 72–73, 73
  Fillet option, 23, 23
  geometric constraints, 228–230
Rectangular Array tool, 72
Redefine Block, 148
Redo button, 24
Reference Edit dialog box, 142
Reference options, 70, 71
REGEN, 92, 98, 100
relative coordinates, 26–27
Reload, 189
Remove objects:, 59, 61
RENDER, 378, 380
Render panel, 378
Render Presets drop-down, 378
Render tab, 366, 371
rendering, 3D design, 378–382, 379, 380, 381
REVOLVE, 339, 350
Rewind, 330
ribbon, 7–11
Annotate tab, 224, 238, 386
AutoCAD Classic, 8
Block Editor, 143, 144
Close Array, 72
Dimension Style Manager, 209
Edit button, 9
Hatch Creation, 155, 155
Home tab, 59, 107, 132, 136, 140, 149, 154, 193, 208, 231, 235, 238, 242, 301
Insert tab, 290
Items text box, 74
keytips, 9, 9
Output tab, 249, 285
S

Save As dialog box, 273, 274
Save As tool, 178
Save Changes, 140, 142
saving layer states, 119, 119–120, 120
Scale, 70, 144, 160
scale
annotation, 245, 245
viewports, 254
SCALE, 82, 161
circles, 70–71, 71
entities, 68–72
text, 198
Scale Uniformly and Allow Exploding, 133
scientific drawing units, 12
screening, 270
search path, 179
SELECT, 62
Select Annotation Scale, 242
Select Color dialog box, 126
Select Objects, 134, 159
Select objects:, 58, 58–61, 59, 60, 62
Select Reference dialog box, 188
Select Template dialog box, 12
Selection Cycling, 62
selection sets
crossing windows, 59, 60
before deciding command, 61–64
entities, 57–64
implied windows, 59, 59, 60, 62
Select objects:, 58, 58–61, 59, 60, 62
Selection tab, 38, 116
Selection tool, 384
SELECTSIMILAR, 64, 64
Separate Hatches, 164, 165
Set Location, 290, 377
Set To ByLayer tool, 146
Set Units To Scale inserted Content, 272
SETBYLAYER, 146
Setting Insertion drop-down, 135, 135
Shade button, 167
shaping curves, 85–103
blend curves, 101–102
ellipses, 91–93
points, 87
polylines, 85–91, 86, 87, 88, 91
splines, 94–102
Sheet Set Manager palette, 2, 4, 4, 5
Sheet Sets, 181
sheet sets, 2
Sheet Views tab, 4
shell, Xrefs, 186, 187, 189, 189
Show All button, 230
Show/Hide Lineweight, 43
Show/Hide Transparency, 157
SKETCH, 97
SketchUp, 293, 299–293, 294, 294
Sky Off menu, 378
Smooth More tool, 362
Snap, 41–44, 42, 43, 44, 46
Solid Editing panel, 353
solid models
Boolean operations, 356–358, 357, 358, 359
editing, 356–360
extruding, 350–353, 351, 352, 353, 354
lofting, 354, 355
subobjects, 359–360, 361, 362
3D models, 350–361
Solid panel, 351, 352, 353, 360, 361
Specify On-Screen, 136, 137, 144, 175, 188
spirals, 103
SPLINE, 85, 94, 97
Spline Fit tool, 98
SPLINEPLOT, 95, 99, 100
splines
CVs, 94–97, 95, 96, 98
fit points, 98–100
NURBS, 85, 94–97, 364
shaping curves, 94–102
SPOTLIGHT, 374
spreadsheets, tables, 304
squared the circle, 234
Start From Scratch, 269, 269
status bar
annotation, 242
Annotation Scale, 244, 246
Automatically Add Scales to Annotative Objects button, 252
Automatically Add Scales To Annotative Objects When The
Annotation Scale Changes, 255
Dynamic Input, 99, 214
Dynamic Object, 61
floating viewport, 252
Infer Constraints, 227
Maximize Viewport, 259, 314
Minimize Viewport, 314
MODEL icon, 251, 254
Object Snap, 65, 175, 195, 214, 216, 222, 246, 259
Ortho mode, 62, 131, 137, 196
PAPER icon, 251, 252
Polar Tracking, 72
Quick Properties mode, 106, 112, 141, 203
STB • Time-Sensitive Right-Click

Tangent constraint tool, 236
templates, 273, 274
test plots, 278
text, 193–206
  annotation, 242–244, 243, 245
columns, 204, 204–205, 205
editing, MTEXT, 203, 203–205, 204, 205
grips, 204, 204, 205
justification, 197, 203, 204
  DINTEDIT, 224, 225
table cells, 311, 311
lines, 195–199, 196, 197, 198, 199
MTEXT, 200–205, 201, 202, 203, 204, 205
multileaders, 220
paragraphs, 200–205, 201, 202, 203, 204, 205
styles, 193–195, 194
  transforming and creating, 198, 198–199, 199
TEXT, 195, 196
  Text Editor context tab, 201, 201
  Text radio button, 223, 223
  Text Style dialog box, 194, 295, 295
  Text tab, 302
  Text tool, 196, 200, 244
  Text window, 10
texture maps, 370, 370
Thaw All Layers tool, 119
thickness properties, 106
3D design, 365–388, 372, 373, 374, 375, 376
  documentation drawings, 382, 382–386, 383, 384, 385, 386, 387
  lights, 371–378
materials, 365–370, 366, 367, 368, 369, 370
natural light, 377, 377–378
rendering, 378–382, 379, 380, 381
3D Modeling workspace, Quick Access toolbar, 318
3D models, 317–335
  background color, 319
cameras, 327–329, 328, 329
meshes, 362, 363
orbiting, 326, 326–327, 327
solid models, 350–361
SteeringWheel, 330, 330–332, 331, 332
surface models, 337–350
SWEEP, 340–342, 341, 342, 350
Sweep tool, 340
Symbol layer, 299
Symbols And Arrows tab, 210
system printer, 264, 265, 265, 266, 278
  Hide System Printers, 279, 279

T

Table Cell Format dialog box, 310
Table Style dialog box, 301, 312
Table tool, 303
tables. See also plot style tables
  blocks, 133
cells
    properties, 312–313, 313
text justification, 311, 311
  columns, 303, 303, 305
  creating, 301–305, 302, 303, 304, 305, 306
data, 301–305, 302, 303, 304, 305, 306,
editing, 309–314, 310, 311, 312, 313, 314, 315
FIND, 206
layouts, 304, 304
  spreadsheets, 304
  styles, editing, 301–305, 302, 303, 304, 305, 306
tool palettes, 183
TABLESTYLE, 303
Tag, 296

Quick View Layouts, 249, 0259, 284, 303
Selection Cycling, 62
Show/Hide Transparency, 157
Viewport Scale menu, 251, 252, 253, 255, 282
STB. See Named Plot Styles
SteeringWheel, 324, 330, 330–332, 331, 332
STRETCH, 77–78, 78, 82
Stretch Radius, 75
Stretch tool, 132, 151
Stretch Vertex, 228
styles. See also plot style tables
  annotation, 241–246
  names, 246
  Content Explorer, 181
dimensions, 207–213, 208, 209, 210, 211, 212, 213
  multiple drawings, 209
  multileaders, 220–222
  tables, editing, 301–305, 302, 303, 304, 305, 306
text, 193–195, 194
  visual, 317–321, 318, 319, 320, 321
  subobjects, 359–360, 361, 362
Sun & Location panel, 377, 378
surface models, 348–349, 349, 350
  editing, 343–349
  planar surfaces, 338, 338
  projecting edges, 345–348, 346, 347, 348
  3D models, 337–350
  trimming surfaces, 344, 345
Surface tab, 338, 339, 340
SWEEP, 340–342, 341, 342, 350
Sweep tool, 340
Symbol layer, 299
Symbols And Arrows tab, 210
system printer, 264, 265, 265, 266, 278
  Hide System Printers, 279, 279
Title, table cell style, 302, 302
Title blocks, 258
Title layer, 276
tool palettes, 183–185, 184, 185, 186
Tool Palettes panel, 184
Tools panel, 201
Tour Building, 330
Trailing, Zero Suppression, 209
transparency, hatching, 155, 157
transparency properties, 106
transparent commands, 44
TRIM, 76–77, 77, 88, 140
Trim tool, 88, 140, 344, 349
Trimming surfaces, 344, 345
trueType, 194
Turn All Layers On tool, 114, 119
2D drawings, 15–19, 16, 17
2D profile, 3D models, 339, 339–340, 340
2D space, 248
UCS. See user coordinate system
UNCICON, 28, 28–29
Undo arrow, 24, 90
undooing, 23–24
UNGROUP, 185
Union tool, 356–357
Unisolate tool, 118, 162
UNITS, 13, 22, 215, 371
Unsaved Layer State, 119
Up/Down, 330
user coordinate system (UCS), 28–29, 30, 66, 67, 72, 324
user interface, 1–5, 2, 10
Utilities panel, 118, 118, 214, 215
Value, 296
View Controls menu, 324
View Object, 330
View tab, 17, 184, 276
   External References Palette button, 188
   Properties button, 276
   Properties tool, 108
   Visual Styles drop-down, 318
VIEWBASE, 384
ViewCube, 29, 31, 323–325, 324, 325, 348
VIEWDETAIL, 386
viewports, 241, 283
   annotation scale, 254
   floating, 251–256, 252, 253, 255, 256
   layouts, 247–251, 248, 256–257, 257
   lights, 376
   maximized, 260
   tiled, 322, 322–323, 323
   Z-Viewport, 247, 248
VIEWRES, 36
views
   documentation drawings, 385
   3D models, 332–334, 333, 334
VIEWSECTION, 385
visibility, 105–128
   altering layer assignments of objects, 112–114
   assigning properties by object or by layer, 123–124
   current layer, 109–111, 115
   layers, 114–120, 115, 116
   properties, 125–127
   linetype, 120–123
   object properties, 105–109
Visual Style Controls menu, 322, 352, 356, 360
visual styles, 3D models, 317–321, 318, 319, 320, 321
Visual Styles drop-down, 318
Visual Styles Manager icon, 319, 320
VPORTS, 261
Walk, SteeringWheel, 330
Watched Folders, 180
WCS. See world coordinate system
When A Command Is Active in the Selection Preview, 116
Windows Explorer, 264, 265, 267, 268, 269, 271, 271
Windows Standard Behavior, 20, 21
WIPEOUT, 170
Wireframe, 317–319, 319, 356, 360
workspaces, 6, 6–7
world coordinate system (WCS), 31, 324
WPolygon, 61, 61
XML. See Extensible Markup Language
Xplode, 144–146
Xref. See external references
Zero Suppression, 209
Zoom, 330
Zoom Extents, 15, 18, 115, 116, 238, 371
Zoom Previous, 18, 49, 51
Zoom Realtime, 17, 242
Zoom Window, 17
Z-Viewport, 247, 248